ORA User’s Guide 2009

Kathleen M. Carley, Jeff Reminga, Jon Storrick, and Matt De Reno

May 2009
CMU-ISR-09-115

Institute for Software Research
School of Computer Science
Carnegie Mellon University
Pittsburgh, PA 15213

Center for the Computational Analysis of Social and Organizational Systems
CASOS Technical Report

This report/document supersedes CMU-ISR-08-125

---

1 This work was supported by the ONR N00014-06-1-0104, the AFOSR for “Computational Modeling of Cultural Dimensions in Adversary Organization (MURI)”, the ARL for Assessing C2 structures, the DOD, and the NSF IGERT 9972762 in CASOS. Additional support was provided by CASOS and ISRI at Carnegie Mellon University. The views and conclusions contained in this document are those of the authors and should not be interpreted as representing the official policies, either expressed or implied, of the National Science Foundation, the Department of Defense, and the Office of Naval Research, the Army Research Labs, the Air Force Office of Sponsored Research or the U.S. government.
Key Words: DNA, ORA, Dynamic Network Analysis, MetaNetwork, Social Network Analysis
Abstract

ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design structure. The design structure of an organization is the relationship among its personnel, knowledge, resources, and tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are also organized by input requirements and by output. ORA generates formatted reports viewable on screen or in log files, and reads and writes networks in multiple data formats to be interoperable with existing network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ computational backend. The current version ORA1.2 software is available on the CASOS website: http://www.casos.ece.cmu.edu/projects/ORA/index.html.
Table of Contents

1 ORA User’s Guide 2009 ........................................................................................................... 1
2 Questions, Bugs, and Comments ......................................................................................... 1
3 Dynamic Network Analysis ................................................................................................. 1
   3.1 Where to learn to more: ............................................................................................... 2
4 File Formats ......................................................................................................................... 2
5 Getting Started .................................................................................................................... 6
6 Network Drives ................................................................................................................... 6
   6.1 Mapping a Network Drive ............................................................................................ 6
7 ORA and DNA ..................................................................................................................... 9
   7.1 Where to learn more about CASOS tools and this tool chain: .................................... 9
8 Questions, Bugs, and Comments ......................................................................................... 9
9 Overview: The Organizational Risk Analyzer .................................................................... 10
   9.1 What kinds of networks? .............................................................................................. 10
   9.2 What if there are many networks? ................................................................................ 10
   9.3 What if the networks change? ...................................................................................... 11
   9.4 What if information is incomplete? .............................................................................. 11
   9.5 Illustrative applications ............................................................................................... 11
   9.6 Tool Evolution .............................................................................................................. 11
   9.7 Where to find out more on SNA ................................................................................. 12
10 Stargate - Summit - Synopsis ............................................................................................ 13
   10.1 Story Background ....................................................................................................... 13
   10.2 The Datasets .............................................................................................................. 13
   10.3 The Short of it ............................................................................................................. 13
   10.4 The Story .................................................................................................................... 13
11 System Requirements ........................................................................................................ 16
12 What Is ORA? .................................................................................................................... 18
   12.1 An Overview .............................................................................................................. 18
   12.2 The ORA Visualizer .................................................................................................. 18
   12.3 Reports ....................................................................................................................... 18
   12.4 Charts ......................................................................................................................... 18
13 Where To Begin .................................................................................................................. 19
14 ORA's Main Interface ........................................................................................................ 20
   14.1 Panel 1 ....................................................................................................................... 20
   14.2 Panel 2 ....................................................................................................................... 21
   14.3 With Meta-Network selected...................................................................................... 21
176 Centrality, Out Degree ................................................................. 392
177 Centrality, Total Degree ............................................................... 393
178 Clustering Coefficient, Watts-Strogatz ........................................ 394
179 Cognitive Demand ........................................................................ 395
180 Cognitive Distinctiveness ............................................................. 397
180.1 AKA: Cognitive Distinctiveness, Relative or Distinctiveness Correlation ................................. 397
181 Cognitive Expertise ........................................................................ 398
181.1 AKA: Cognitive Expertise, Relative or Expertise Correlation .......... 398
182 Cognitive Resemblance ................................................................. 399
182.1 AKA: Cognitive Resemblance, Relative or Resemblance Correlation ...... 399
183 Cognitive Similarity ....................................................................... 400
183.1 Cognitive Similarity, Relative or Similarity Correlation ................. 400
184 Communication ............................................................................ 401
185 Component Measures ................................................................. 401
186 Component Count, Strong ............................................................... 402
187 Component Count, Weak ................................................................. 402
188 Component Members, Weak ............................................................ 403
189 Congruence Measures ................................................................. 403
190 Congruence, Agent Knowledge Needs / Congruence, Agent Resource Needs .......... 404
191 Congruence, Agent Knowledge Waste / Congruence, Agent Resource Waste .... 405
192 Congruence, Communication ......................................................... 406
193 Congruence, Organization Agent Knowledge Needs / Organization Agent Resource Needs 407
194 Congruence, Organization Agent Knowledge Waste / Organization Agent Resource Waste 408
195 Congruence, Organization Task Knowledge Needs / Organization Task Resource Needs 409
196 Congruence Organization Task Knowledge Waste / Organization Task Resource Waste 410
197 Congruence, Social Technical ......................................................... 411
198 Congruence, Strict Knowledge/Strict Resource ................................. 412
199 Congruence, Task Knowledge Needs / Congruence, Task Resource Needs .......... 413
200 Congruence, Task Knowledge Waste / Congruence, Task Resource Waste .... 414
201 Connectedness, Krackhardt ............................................................ 415
202 Constraint, Burt ........................................................................... 415
203 Density ......................................................................................... 416
204 Diameter ...................................................................................... 416
205 Diversity, Knowledge/Resource ...................................................... 417
206 Edge Count, Lateral ...................................................................... 418
207 Edge Count, Pooled ........................................................................ 418
208 Edge Count, Reciprocal ................................................................. 419
267.7 Most Knowledge (row degree centrality) ................................................................. 493
267.8 Most Resources (row degree centrality) ................................................................. 494
267.9 Leader of Strong Clique (eigenvector centrality) ..................................................... 494
267.10 Potentially Influential (betweenness centrality) ...................................................... 495
267.11 Connects Groups (high betweenness and low degree) .......................................... 495
267.12 Unique Task Assignment (task exclusivity) ......................................................... 496
267.13 Special Expertise (knowledge exclusivity) ............................................................. 496
267.14 Special Capability (resource exclusivity) .............................................................. 497
267.15 Workload (actual based on knowledge and resource) ........................................... 497
267.16 Key Knowledge .................................................................................................... 498
267.17 Key Resources ...................................................................................................... 498
267.18 Key Locations ....................................................................................................... 498
267.19 III. What do we know about an actor of interest? ................................................. 501
267.20 1. Visualize information about a selected actor .................................................... 501
267.21 2. Visualize an actor's sphere of influence ............................................................ 502
267.22 3. Run a Sphere of Influence Report .................................................................... 503
267.23 SPHERE-OF-INFLUENCE REPORT ................................................................. 504
267.24 Sphere of Influence Analysis for agent ahmed_ghailani ...................................... 504
267.25 Size Statistics ........................................................................................................ 504
267.26 Attributes ........................................................................................................... 505
267.27 Exclusive Connections ........................................................................................ 505
267.28 Most Similar Node ............................................................................................. 505
267.29 Top Measures ..................................................................................................... 505
267.30 Measure Value Range .......................................................................................... 506
267.31 Resource Analysis Section .................................................................................... 507
267.32 IV. What are the connections between two actors of interest? ......................... 508
267.33 V. What is the immediate impact of a particular agent on the network? .......... 509
267.34 VI. What happens to the network when certain entities are removed? .......... 510
268  Create a New Meta-Network ..................................................................................... 518
268.1 Delete an existing node .......................................................................................... 519
268.2 Merge two nodes .................................................................................................. 520
269  Performing a View Network Over-Time Analysis ...................................................... 520
270  Performing a Measures Over Time Analysis ............................................................. 520
270.1 See Also ................................................................................................................ 521
270.2 Performing the Over-Time Analysis ...................................................................... 525
270.3 Example Slider Position 1 ..................................................................................... 526
270.4 Example Slider Position 2 ..................................................................................... 527
270.5 Example Slider Position 3 ..................................................................................... 527
270.6 WTC Event Node: Detail 1 - 1996 ......................................................................... 528
270.7 WTC Event Node: Detail 2 - 1997 ......................................................................... 529
270.8 Summary of Lesson ............................................................................................... 530
3 Dynamic Network Analysis

Dynamic Network Analysis (DNA) is an emergent scientific field that brings together traditional social network analysis (SNA), link analysis (LA) and multi-agent systems (MAS). There are two aspects of this field. The first is the statistical analysis of DNA data. The second is the utilization of simulation to address issues of network dynamics. DNA networks vary from traditional social networks in that are larger dynamic multi-mode, multi-plex networks, and may contain varying levels of uncertainty.

DNA statistical tools are generally optimized for large-scale networks and admit the analysis of multiple networks simultaneously in which, there are multiple types of nodes (multi-nodes) and multiple types of links (multi-plex). In contrast, SNA statistical tools focus on single or at most two mode data and facilitate the analysis of only one type of link at a time.

DNA statistical tools tend to provide more measures to the user, because they have measures that use data drawn from multiple networks simultaneously. From a computer simulation perspective, nodes in DNA are like atoms in quantum theory, nodes can be, though need not be, treated as probabilistic.
Whereas nodes in a traditional SNA model are static, nodes in a DNA model have the ability to learn. Properties change over time; entities can adapt: A company's employees can learn new skills and increase their value to the network; Or, kill one terrorist and three more are forced to improvise. Change propagates from one entity to the next and so on. DNA adds the critical element of a network's evolution and considers the circumstances under which change is likely to occur.

3.1 Where to learn to more:


4 File Formats

ORA can read in a multitude of file formats. Below is a list, with examples of the code, of those formats.


Dynetml (the native ORA xml format): DynetML is an xml based interchange language for relational data including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal data interchange format to enable exchange of rich social network data and improve compatibility of analysis and visualization tools.

```xml
<node id="col_jack_o'neill">
    <properties>
        <property name="ally" type="string" value="yes"/>
        <property name="gender" type="string" value="male"/>
    </properties>
</node>

<graph sourceType="Agent" source="Agent" targetType="Agent" target="Agent" id="agent x agent" isDirected="true">
    <edge source="A01" target="A11" type="double" value="1"/>
    <edge source="A02" target="A01" type="double" value="1"/>
</graph>
```
.dl: DL (for "data language") is a very powerful and (fairly) simple language that allows the creation of quite complex and large UCINET data sets with minimal data entry. DL language files are plain ASCII text files that can be created with any editor (be sure to store the results as plain text).

```
dl n=9, format=edgelist
labels:
  A,B,C,D,E,F,G,H,I

data:
  1 1 1  
  1 2 1  
  1 6 1  
    .    
    .    
  8 7 1  
  9 9 1
```

.##h and ##d (UCINet): UCINET datasets are stored in a special (Pascal) format, but can be created and manipulated using both UCINET's and other software tools (text editors and spreadsheets). Each UCINET dataset consists of two separate files that contain header information (e.g. myfile.##h) and the data lines (e.g. myfile.##d). Because of this somewhat unusual way of storing data, it is best to create data sets with the internal spreadsheet editor or DL language tools, or to import text or spreadsheet files and save the results as UCINET files.

.CSV (comma separated values): The CSV ("Comma Separated Value") file format is often used to exchange data between disparate applications. The file format, as it is used in Microsoft Excel, has become a pseudo standard throughout the industry, even among non-Microsoft platforms. File most commonly created from an Excel spreadsheet using the Save As… option

- Each record is one line… but — A record separator may consist of a line feed (ASCII/LF=0x0A), or a carriage return and line feed pair (ASCII/CRLF=0x0D 0x0A)… but — fields may contain embedded line-breaks (see below) so a record may span more than one line.
- Fields are separated with commas.
- Leading and trailing space-characters adjacent to comma field separators are ignored.
- Fields with embedded commas must be delimited with double-quote characters.
- Fields that contain double quote characters must be surrounded by double-quotes, and the embedded double-quotes must each be represented by a pair of consecutive double quotes.
- A field that contains embedded line-breaks must be surrounded by double-quotes.
- Fields with leading or trailing spaces must be delimited with double-quote characters.
- Fields may always be delimited with double quotes.
- The first record in a CSV file may be a header record containing column (field) names.

```
A01,A02,A03,A04
A01,0,0,0,0
A02,1,0,0,0
A03,1,0,0,0
A04,1,0,0,0
```

.txt (text files): Otherwise referred to ASCII files which contain no extemporaneous formatting.

.raw: net (Pajek): The file format accepted by Pajek provides information on the vertices, arcs (directed edges), and undirected edges. A short example showing the file format is given below:

```
*Vertices 3
1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown
2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown
3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown
*Arcs
1 2 3 c Green
2 3 5 c Black
*Edges
1 3 4 c Green
```

.graphml: GraphML is a comprehensive and easy-to-use file format for graphs. It consists of a language core to describe the structural properties of a graph and a flexible extension mechanism to add application-specific data. Unlike many other file formats for graphs, GraphML does not use a custom syntax. Instead, it is based on XML and hence ideally suited as a common denominator for all kinds of services generating, archiving, or processing graphs.

```
<xs:annotation>
  <xs:documentation
source="http://graphml.graphdrawing.org/"
xml:lang="en">
Simple type definitions for the new graph attributes.
```
.stl (GMU model): This file format is native to the stereolithography CAD software created by 3D Systems. STL files describe only the surface geometry of a three dimensional object without any representation of color, texture or other common CAD model attributes and can use both ASCII and binary representations.

An ASCII STL file begins with the line:

```
solid {name}
```

where name is an optional string. The file continues with any number of triangles, each represented as follows:

```
facet normal n1 n2 n3
  outer loop
    vertex v11 v12 v13
    vertex v21 v22 v23
    vertex v31 v32 v33
  endloop
endfacet
```

where n1-n3 and v11-v33 are floating point numbers in sign-mantissa'e'-sign-exponent format and concludes with:

```
endsolid {name}
```

.lo (pathfinder):
5 Getting Started

Welcome to ORA's Help File system!
The ORA help set is organized into the following top-level folders:
To begin with, if you're not familiar with Social Network Analysis, then you should read through this manual. It's broken up into six parts.

1. Getting Started: provides an overview of Social Networks and how they pertain to ORA.
2. The Main Interface: The Main Interface is the area for working with the data within the Networks. This includes loading, saving & merging, performing various math functions on the Networks, generating a variety of networks, and running reports.
3. The Visualizer: This is the graphical tool for visualizing the Networks. It contains tools for displaying (or hiding) nodes and links, creating different groupings, and displaying information about the Network.
4. ORA Measures: This section contains explanations of the various measures used in ORA. They contain a short explanation and (for the most part) the math used in the measure. It also describes the type, input, and output.
5. Lessons: Lessons designed to teach specific materials.

6 Network Drives

If you are running on a network drive then the help system needs a drive letter in order to work correctly. There are 2 possible solutions to this:

1. Copy the ORA folder to each local machine.
2. If at all possible Map a Network Drive. Right click on the shared folder and select Map Network drive.

6.1 Mapping a Network Drive

In an Explorer window select My Network Places. Find the name of the network which contains ORA.

Go back to My Document.
From the menu select Tools => Map Network Drive. This brings up the dialog box below.

Select the [Browse] button in order to select the network drive.

Select the correct network drive and press [OK].
Select [Finish].

Your computer now has the Network drive with ORA mapped on the desktop.
7 ORA and DNA

In general, you may want to use ORA in conjunction with other computational tools to advance DNA theory. The CMU CASOS tools that work with ORA to form tool chains are AutoMap (extracts networks from texts) and various DNA simulators including both Construct and DyNet. These tools are often used in a number of real world applications, including the following areas:

- Designing adaptive teams for Command and Control Networks
- Estimating the impact of organizational downsizing
- Estimating the effectiveness of new structures
- Evaluating risk in organizational designs
- Examine impact of IT effectiveness
- Impact analysis of actions in asymmetric warfare simulation
- Impact analysis of weaponized biological attacks on cities

ORA is interoperable with a number of other SNA and link-analysis tools: UCINET, KeyPlayer, and Analyst Notebook. Additional information is listed under data import and export.

7.1 Where to learn more about CASOS tools and this tool chain:


CASOS: Center for Computational Analysis of Social and Organizational Systems (http://www.casos.cs.cmu.edu/index.html)

8 Questions, Bugs, and Comments

Please contact us:

Dr. Kathleen M. Carley (kathleen.carley@cmu.edu)
9 Overview: The Organizational Risk Analyzer

ORA is an analysis tool designed to help the user evaluate one or more networks. It can be used to assess the nature of, features of, change in, and determinants of complex networks. A large variety of networks can be assessed including, but not limited to, social networks, activity networks, task networks, knowledge networks, supply chains, and communication networks. Using ORA questions such as the following can be addressed: what is critical, are there groups of interest, are there patterns of interest, how might interventions impact the network, who is critical, are there emerging groups, how is the network changing.

What is a network? In any data there are relations among things such as two people are cousins, or a set of people are all members of the same club. These networks might be psychological or cultural as when two people share the same belief. They might be physical as in two resources being in the same location or two computers being connected by a line, or they might be social as in people being related. There are many reasons why networks exist. Networks are ubiquitous. Everyone and everything is constrained and enabled by the networks in which they are embedded. Everyone and everything is embedded in multiple networks; e.g. you are connected to some people due to work, others due to school, others due to your kids, and so on. ORA lets you visualize, assess, and reason about these networks.

9.1 What kinds of networks?

ORA can assess any type of network. Anything that can be represented as a set of nodes and relations can be assessed. Typical networks are: social networks (who interacts with whom), financial networks (who lends money to whom); task charts (what task needs to be done before what), supply chains (what resources are needed to build what other resources), semantic networks (what ideas are linked to what ideas), proximity networks (what states border on what states), and so on. ORA can assess any data that can be represented as nodes and relations regardless of what the nodes are or what the relations are.

9.2 What if there are many networks?

ORA can be used to assess the interlocks among networks. For examples, imagine that the following networks exist: who works with whom; who has what skills, what skills are needed for what tasks, who is doing what tasks then ORA can assess whether in fact the right people have been assigned to those tasks or where there are problems because there is insufficient skills available for the task. ORA can assess "multi-mode multi-link" data.
9.3 What if the networks change?

ORA can be used to assess change in networks over time. Over time, the shape or topology of a network might change; e.g., startup companies move from a collaborative to a hierarchical structure, terrorists change what weapons they use to attack sites, scholars cite different papers, and so on. Consequently, over time, who or what is critical in a network might change. ORA can assess change in networks, and forecast possible ways in which the network might change in the future.

9.4 What if information is incomplete?

ORA can assess networks even when information is incomplete. ORA has been built to gracefully degrade so that it calculates all and only those metrics for which there is information.

9.5 Illustrative applications

ORA has been applied in numerous settings. Examples include the following. Assessment of team-x leadership structure at NASA. Comparison of terror networks. Identification of vulnerabilities in insurgency and terror networks. Assessing change in political elite structures in Korea and early identification of emergent leaders. Designing teams for wargames. Assessing the impact of turnover and retirement on public health organizations in Duchess County, NY. Identifying way ports with AIS data. Organizations where ORA has been used include: AFIT, SOCOM, USMA, CIA, many universities.

9.6 Tool Evolution

There are still many challenges in the area of dynamic network analysis. Key challenges include handling streaming data, locating confidence intervals for metrics, uncertainty assessment, and so on. As these challenges are met, new algorithms are implemented, tested and added to ORA thus further meeting the user's needs.
Social Network Analysis (SNA)

Social Network Analysis* is a scientific area focused on the study of relations, often defined as social networks.

In its basic form, a social network is a network where the people entities and the relations links are a form of connection such as friendship. Social Network Analysis takes graph theoretic ideas and applies them to the social world.

The term social network was first coined in 1954 by J. A. Barnes (see: Class and Committees in a Norwegian Island Parish). Social network analysis is also called network analysis, structural analysis, and the study of human relations. SNA is often referred to as the science of connecting the dots.

Today, the term Social Network Analysis (or SNA) is used to refer to the analysis of any network such that all the entities are of one type (e.g., all people, or all roles, or all organizations), or at most two types (e.g., people and the groups they belong to). The metrics and tools in this area, since they are based on the mathematics of graph theory, are applicable regardless of the type of nodes in the network or the reason for the connections.

For most researchers, the entities are actors. As such, a network can be a cell of terrorists, employees of global company or simply a group of friends. However, entities are not limited to actors. A series of computers that interact with each other or a group of interconnected libraries can comprise a network also.

9.7 Where to find out more on SNA

- Scott, John, 2000, Social Networks, Sage (2nd edition)
- Wasserman, S. & K. Faust, 1994, Social Network Analysis: Methods and Applications
10 Stargate - Summit - Synopsis

10.1 Story Background

The data for this scenario is based on the Sci-Fi TV show, Stargate SG-1 and specifically the episodes Summit / Last Stand. Following is a synopsis of the episodes if you have any questions regarding the dataset.

10.2 The Datasets

The Agents – Colonel Jack O'Neill, Major Samantha Carter, Doctor Daniel Jackson, Teal'c, Jacob Carter/Selmak, Lt Elliot, Ren'al, Aldwin, Janet Frazier, Major Mansfield, General Hammond, Lantash, Narim, Travell, Osiris, Yu

10.3 The Short of it

The Tok'ra are planning an attack which would kill all of the head Gou'ald in one fell swoop by infiltrating a summit and poisoning them all simultaneously. With the help of Stargate Command and the U.S. Military they are able to infiltrate the summit. The plan is going fine until new information is disclosed which changes everything.

10.4 The Story

The Tok'ra have information regarding a secret Gou'ald summit of all the System Lords. They devise a plan to destroy the organization once and for all by poisoning their symbiotes, but they have need of one thing. A human (tauri) who speaks fluent Gou'ald. Ren'al (the head of the Tok'ra council) travels to Earth to meet with Stargate Command in order to recruit Dr. Daniel Jackson. Dr. Jackson is a human who is fluent in Gou'ald. The System Lords have declared a truce for the summit and each System Lord can bring one human servant.

SG-1 journeys to the Tok'ra home world, Revanna. Jacob Carter, previously of the U.S. military but now a Tok'ra, presents the plan to Colonel O'Neill and SG-1. He's established himself as a minor Goa'uld in the service of Yu. He can help get Daniel inside Yu's home base by using the Reole memory-altering chemical to convince Yu that he is his closest human slave, Jarren.

Elsewhere, the Goa'uld Zipacna, a servant of the new and very powerful Goa'uld, welcomes a guest, Osiris. Zipacna offers her a position in service of the Goa'uld, Anubis.
Osiris prepares to depart Zipacna’s ship for the summit, as Anubis’ official representative. Zipacna, meanwhile, has learned the location of the new Tok’ra home world, Revenna, from a captured spy and plans to launch a full-scale invasion.

Jacob and Daniel successfully dispose of Jerran, and, using the reole drug, trick Yu into believing Daniel is his faithful servant. Yu and Daniel depart to the summit.

Six of the galaxy’s most powerful System Lords are waiting: Ba’al, Olokun, Morrigan, Bastet, Kali the Destroyer, and Svarog. They are waiting, though, for another guest, the powerful Goa’uld who has been dealing them all heavy defeats in battle, but who refuses to make his identity known.

As the attack begins on Revenna SG-1 and SG-17 try to help the Tok’ra, but little can be done. The Goa’uld have dialed into Revenna’s Stargate, thusly preventing their escape. Zipacna continues bombing the surface of Revenna, in an attempt to flush out the resistance. As the tunnels collapse many Tok’ra are killed along with Major Mansfield. Ren’al encrypts the symbiote poison formula onto a data crystal but is killed by falling debris shortly after. Major Samantha Carter takes the data crystal for safe keeping. A large holding tank, where the symbiote Lantash is being kept alive, is destroyed and Lantash takes refuge in the dying Lieutenant Elliot as a host.

Colonel O’Neill, Teal’c and the Aldwin do a scouting run on the surface of the planet only to find Zipacna has amassed an army of Jaffa troops on the surface. Aldwin is killed on their way back to the tunnels. SG-1 regroups but more tunnel collapses prevent their escape to the ring room. Their path to the surface is blocked.

Back at the summit Osiris, the final guest, arrives. Daniel is caught by surprise. Osiris had taken possession of his friend Sarah Gardner a year ago. Osiris recognizes Daniel, but does not reveal this to the System Lords.

In private Daniel communicates her arrival to Jacob. Her arrival presents a large problem. Osiris confronts Daniel Jackson and demands to know what he’s is planning. Daniel manages to prick her with his ring containing the reole memory drug and convinces her that he is but Yu’s human servant. The drug takes effect and she leaves, somewhat confused. Col. O’Neill and Teal’c find a set of Tok’ra tunneling crystals which they use to grow new tunnels. Major Carter tries to help Lt. Elliot stay alive.

Oiris tells the System Lords she represents the Anubis, who had been believed to be dead for 1,000 years. Anubis has dealt blows to each and every System Lord. Anubis wants entrance back into the System Lords. The Goa’uld vote to allow Anubis to rejoin them, and for Osiris to represent him.

Daniel reports this to Jacob Carter. They both agree that the plan to poison the System Lords must be aborted. If they wipe out the seven most powerful System Lords now, Anubis will be free to conquer the galaxy.

SG-1 and Lt. Elliot make it to the surface but must still must avoid the Jaffa army. They begin the 25-mile walk to the Tok’ra beacon to send a signal to Daniel and Jacob. At the beacon Maj. Carter sends a signal to Jacob and Daniel.
Jacob tells Daniel to get off the space station. But Daniel decides to attempt to kidnap Osiris (still hoping to free her from the Gou'ald). When she arrives, he locks her in the hold and readies to steal the ship. But Yu intervenes saying that his servant Jarren has betrayed him. He releases Osiris. But believing that Yu plotted to kidnap her she stabs Yu. As she prepares to kill Daniel he reveals who he really is. This cause her to hesitate. That, and the attack by Yu gives him the opportunity to escape.

On their return to Revenna Jacob and Daniel are shot down by the Jaffa army and crash. SG-1 finds them shaken but unhurt. Lt Elliot/Lantash, knowing he's dying anyway, volunteers to sacrifice himself by taking the symbiote poison and wait to be captured. He'll then release the poison clearing the way for SG-1 to escape through the Stargate. Colonel O'Neill hates to leave his man behind, but sees that there is no other choice. The team goes into hiding. Elliot places the poison in his pocket, and listens as the footfalls of the approaching Jaffa army loom ever closer.
11 System Requirements

ORA performs best on machines that meet or exceed the following specifications:

<table>
<thead>
<tr>
<th>Spec</th>
<th>Windows</th>
<th>Mac (running XP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>XP</td>
<td>OSX 10.4.x</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB</td>
<td>1GB</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium 4</td>
<td>Intel Core 2 Duo</td>
</tr>
<tr>
<td>Speed</td>
<td>1.0 GHz</td>
<td>2.0 GHz</td>
</tr>
<tr>
<td>Java</td>
<td>6.0</td>
<td>6.0</td>
</tr>
<tr>
<td>Extra</td>
<td></td>
<td>Parallels for Dual Booting</td>
</tr>
</tbody>
</table>

NOTE: When working with extremely large data sets, increasing processing speed and RAM is highly recommended.

TERMINOLOGY CLARIFICATION

So that the help file mirrors the actual tool in use, some terms have been deliberately left in the help documentation that have since been refined in use as they specifically apply to the ORA interface. To avoid confusion, the ORA Help will refer to terms as they are still used in the ORA interface, though the term may need to be updated. However, what follows is a clarification of all key terms one will encounter in the both the interface and the help. For other terms, please see Basic Terms in the ORA help documentation.

ENTITY

Can be who, what, where, how, why, a thing that is being studied. For example, entities can be people, agents, organizations, beliefs, expertise areas, resources, tasks, events, locations.

NODE

The representation of a single entity (a who, what, where, how why item). This pertains to actually looking at a network model. In the visual model, entities are called nodes.

META-NODE

The representation of a group of nodes as one node. For example, if Bob, Carol, Ted, and Alice are all accountants, they could all belong to the Meta-Node Accountants which would contain all their individual nodes.

LINK

The representation of the tie, connection, relation, edge between two nodes.

META-LINK

The representation of a Group of links.

NETWORK
The representation of a set of nodes, including meta-nodes, of one type and the links, including meta-links, of one type between them.

**META-NETWORK**

The representation of a Group of networks.

**LABEL**

Each entity, node, link or network has a type — what kind it is, is called a label. This can be the common name, an id — unique identifying number or some other kind of label.

**ENTITY CLASS**

A set of entities of one type.

**NODE CLASS**

A set of nodes of one type. Note: a set of nodes of one type can be represented as a meta-node.

**LINK CLASS**

A set of links of one type. Note: a set of links of one type can be represented as a meta-link.

**NETWORK CLASS**

A set of networks of one type. Note: a set of networks of one type can be represented as a meta-network.

**GROUP**

A collection of things, such as entities, nodes, ties, and networks. A group might at times be represented as a meta-node.

Nodes may be classified in groups based on a shared attribute, type, id-range, label, user selection, etc. For example: if you have a set of people and know their gender, then there might be two groups - men and women.

In addition, the nodes representing those people could be displayed as a meta-node for men and a meta-node for women.

Nodes may be classified into groups based on a grouping algorithm. For example, if you have a network showing connections among members of an organization and you run a grouping algorithm it will return clusters of nodes that fit together on some mathematical criteria. This cluster is a group and can be represented as a meta-node.

**TRAIL**

A set of nodes and links that form a single unbroken chain, such that no node or link is repeated.

**PATH**

A set of nodes and links that form a single unbroken chain, such that no nodes and links can be repeated.
12 What Is ORA?

12.1 An Overview

The Organizational Risk Analyzer (ORA) is a statistical analysis package for analyzing complex systems as Dynamic Social Networks. Many complex systems such as organizations, intra-state alliances, food webs, etc. can be represented as an ecology of interlinked networks. Within ORA any complex system is represented as a Network. What follows is a general description of ORA's primary capabilities. Specific instruction is provided under the correlating folders in this help system.

See Basic Terms for additional definitions relating to Social Networks.

12.2 The ORA Visualizer

The ORA Visualizer renders conceptual images of social networks. Nodes such as Agents, Task, Knowledge and Organizations represent real-world Entities like the president of a company, driving to the airport, or how to wash your clothes. Nodes which share the same attributes can be further grouped together creating Meta-Node. Links connect nodes that share a direct relationship. Such relationships are derived from the Network. ORA's single unit of data input, and are referred to as graphs. The ORA Visualizer is interactive. You can zoom, rotate, isolate, add and remove Meta-Nodes, and much more.

12.3 Reports

ORA can run many reports: Risk, Intelligence, and Sphere of Influence to name a few. Multiple organizations can be compared against each other, network structure can be optimized, subgroups within a network can be identified, and scenarios involving the removal of nodes or links can be examined. Reporting capabilities are constantly being refined and updated.

12.4 Charts

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and Heat Map. Each one in turn presents a different statistical profile of a selected Node Set. Examples of these reports and how to access them can be found under Basic Usages.
13 Where To Begin

To begin you need data to run in ORA. And not data in just any format. ORA uses particular data formats: DyNetML*, .csv*, GraphML*, and a couple others. The examples in the ORA help file use a dataset based on the popular Sci-Fi TV show, Stargate. You can download a copy of this dataset to practice using ORA at the following URL:
http://www.casos.cs.cmu.edu/computational_tools/datasets/internal/stargate/index2.html
Another method is to create a MetaNetwork from an Excel spreadsheet and save it as a .csv* file.
Let's now assume you've created a MetaNetwork after reading through the documentation.
*From the Main Menu select: File => Open MetaNetwork. Then navigate to the directory which contains the MetaNetwork you want.*
If this is the first MetaNetwork you're opening it will appear in panel 1. If there are already Matrices open you'll get the following dialog box.

![Load Organizations from embassy.xml](image)

Do you want the Organizations in "embassy.xml" to replace only the currently selected Organization, to be appended as additional Organization(s), or to replace all currently loaded Organization(s)?

Choose *Replace Selected Org* to remove the previous MetaNetwork and replace it with the current one;
Choose *Append As Additional Org* to add it to any MetaNetworks already loaded in the ORA session;
Choose *Replace all Orgs* to remove any MetaNetworks loaded into ORA and start over with the current MetaNetwork only.
14 ORA's Main Interface

The ORA interface is organized into three resizable window panes. These panes are dockable. That is you can click on the docking panel tabs and de-couple the panes from the GUI and move the panes to suit the user's liking.

Panel 1 contains a tree directory of the current Meta-Network(s) loaded into ORA. This contains the Meta-Networks currently active plus all their Meta-Nodes and Networks. Panel 2 contains the basic information about the highlighted Meta-Network such as how many nodes are represented. This panel also allows quick access to ORA's Visualizer, Reports and Chart tools. By selecting the Visualize button, the currently loaded Network will render in the ORA Visualizer, which will load in a separate window. Panel 3 is empty when ORA is first started up. It will contain any reports that you run.

All three Panels can be resized to your preference.

14.1 Panel 1

Panel 1 contains all the Meta-Networks you currently have active. Clicking on the plus icon will expand the Meta-Network showing all the Meta-Nodes and Networks and clicking on the minus icon condenses the Meta-Network.
And if you hover the pointer over a graph it will display information about that Network.

14.2 Panel 2  
14.3 With Meta-Network selected

Panel 2 displays the information selected regarding the Meta-Network itself.

1. Name of the active Meta-Network: You can also use this textbox to change the name of the Meta-Network.  
2. Currently selected Meta-Network showing it's pathway.  
3. Node Class Count: How many Meta-Nodes are contained with the Meta-Network.  
4. Node Count: Total number of nodes within the Meta-Network.  
5. Link Count: Total number of links within the Meta-Network.  
6. Network Count: Total number of graphs within the Meta-Network  
7. Total Density

14.4 Editor Tab with NodeSet selected

When a NodeSet is selected changes can be made.
The Nodes buttons allow you to search for particular nodes using the Find: box and And/Or criteria - Add, Delete or Merge Nodes - Add, Delete, or Change Attributes. Further information can be read regarding the Tabs in Panel 2.

### 14.5 Editor Tab with Network selected

Further information can be read regarding the Tabs in Panel 2
14.6 Panel 3

Panel 3, which at the start is blank, will contain any reports that are run on the Meta-Network. See Generate Reports for more information.

Analysis

Generate Reports – Brings up a dialog box that enables you to run any report on any currently active Meta-Network then select the format you want the results.

Report Selection Wizard – Assists you in selecting the best reports for the selected Meta-Network.

Measures Manager – The option allows you to choose which measures are to be used in generating reports for the selected Meta-Networks. The dropdown menu allows you to chose measures lists which divide them up into categories such as: Slow Measures, Critical Risk Employees, and Resource Allocation Risk.

Attribute Partition Tool – Creates new Meta-Networks using an existing Meta-Networks and uses attribute values to affect the result.

Near-Term Analysis – Tool used to detect the results when a Meta-Node is removed from an existing circumstance. See Near-Term Impact lesson.

Latent Semantic Analysis – Latent semantic analysis (LSA) is a technique in natural language processing, in particular in vectorial semantics, of analyzing relationships between a set of documents and the terms they contain by producing a set of concepts related to the documents and terms.

Geary-C & Moran-I Analysis – This function performs Moran's I test using phylogenetic and spatial link matrix (binary or general). It uses neighboring weights so Moran's I and Geary's c randomization tests are equivalent.
15 Attribute Partition Tool

To create new Meta-Networks which are a subset of nodes use the Attribute Partition. Select an Node-Class(es), select the Attribute set, then select the individual attribute(s) to form a new Meta-Network.

There are four sections to the dialog box:
Select a Meta-Network: The dropdown menu lists all the currently open Meta-Networks. Here I selected "stargate_summit".
Select Node Class(es): Place a checkmark in the box(es) of the NodeSets you want included. I selected all the NodeSets.
Select an attribute: This dropdown menu shows all the attribute(s) contained within the selected NodeSet(s). If you change the NodeSet(s) the choice of attribute(s) will be reflected in this dropdown. For an attribute set I selected ally.
Attribute Value: Place a checkmark in the box(es) of the attributes you want included in the new Meta-Networks. 

*Finally I chose two values "yes" and "no".*

Next select the [Compute] button. The following dialog box will appear showing the number of new Meta-Networks created.

Close the dialog box. In the main interface you'll see your new Meta-Networks listed in Panel 1. The two new Meta-Networks contain, in their names, the source such as ally=yes and ally=no.

I returned to the original Meta-Network and opened the agent x location network. Then I selected the new Meta-Network for ally=yes and opened that agent x location network.
This is the visualization of the **NEW stargate_summit — agent x location network** with the attribute partition active.

This is the visualization of the **original stargate_summit — agent x location network** with no attribute partition. Note: The nodes and links not in the attribute display have be lightened for this display only.

With the partition attribute network only the nodes associated with ally=yes are shown in the new network.
17 Meta-Network Manager

The Meta-Network Manager panel in ORA's main GUI is where you will find a tree root system doting the Meta-Networks which you loaded into ORA's Main Interface.

There are a number for powerful things you can do by working in the Meta-Network Manager panel only. It should also be noted that some of the features in development are only available through direct interaction with the Meta-Network Manager via sub-menus (accessed by "right clicking" on the various icons).

By selecting the "plus" icons in the tree root, you can expand the Meta-Network and view the individual graphs and node classes that comprise that particular Meta-Network.

In the example below, we clicked on the first "plus" icon and expanded the Meta-Network Manager Tree. The below screen shot displays the result:
17.1 Right clicking to access Meta-Network Manager sub-menus

There are a number of submenu's you can access by "right-clicking" on the icons. Note: each icon provides access to an separate sub-menu. Therefore, if you right click on the node class icon, you will access the node-class submenu. Likewise, if you access the graph (individual network) icons, you will access the graph level sub-menu.

The next screen shot displays the sub-menu indicated by right-clicking on the node class (orange) icon.
The next screen shot displays the sub-menu indicated by right-clicking on the node class (orange) icon.

See also...

Creating a Dynamic Meta-Network
Measures Manager

Before you run any measures on a Meta-Network you can use the Measures Manager to set exactly which measures you wish to run.

Form the main interface menu select Analysis => Measures Manager.

The dialog box has multiple sections:

18.1 Filter Commands:

This section comprises two radio buttons (Match at least one filter | Match all filters) which allow for complex filtering, a [Reset Filters] button, and a Search textbox used for inputting your search. Whatever searches you input in this section are reflected in the Tabbed Window below. It will display only the nodes which match the search(es).

18.2 item(s) Selected | Visible | Total

When first called up the All Measures tab defaults to showing every measures available. When started there were 137 item(s) selected, 137 visible, 137 total.
Selecting the Slow Measures tab this changes to 16 item(s) selected, 16 visible, 16 total. Typing Cognitive into the search textbox reduces this to 16 item(s) selected, 8 visible, 16 total showing that only 8 out of the 16 Slow Measures contain the word Cognitive.
Furthermore you can deselect measures by removing the checkmark next to the measure’s name. With each measure deselected the number of selected items will reduce by one. With these tools you can select only the measures you want to run reports on.

18.3 Buttons

- Reorder
- Select All : Selects (puts a checkmark in the box) all visible measures
- Clear All : De-Selects (removes checkmarks) from all visible measures.

18.4 Tabbed Window

This section contains tabs which sort the measures into various categories. Each of the nine tabs sorts out the measures in different categories. This is very useful for large MetaNetworks when you'd prefer not run, say the Slow Measures* cause it would put too much a drain on your machine. By removing the checkboxes for the Slow Measures they are taken out of the mix and the reports will effectively ignore them. You can turn them back on when you're finished by placing a checkmark back in the box.
In the Tabbed Window there are four columns:

1. Last Name : Deals the general type of measure (Congruence, Exclusivity, Cognitive...). Most entries in this column will display one row as they are singular in what they need to show. Others will display two rows as it's nearly the same measure run on both knowledge and resources. Then a few (like Centrality) will display quite a few rows the types of measures written for that type of measures are somewhat varied.
2. First Name : Deals with the category of the measure (Betweenness, Closeness, Centrality...). This is a secondary factoring.
3. Graph Level : Graph Level* produces a single number as output.
4. Entity Level : Entity Level* produces one number per entity.

18.5 Drop-Down Menu

Gives the user the ability to select which currently active Meta-Network to run the measures on, as well as, which individual networks.
19 Near Term Impact Menu

Save the current simulation setting: Brings up a save box where you can navigate to a directory and save all the current simulation settings.

Load a simulation setting from a file: Navigate to a directory to load a previously saved simulation setting.

**NOTE**: This will remove any settings that are currently active.

Close: Closes the Near Term Analysis window.

---

Executive simulation cases: Begins running the simulation. Same function as the [Execute] button at the bottom of the window.
Show the add simulation wizard: Brings up the creation window. same as the [Add new simulation cases] button.
Add ORA-Intel report based simulation cases: Same as [Add ORA-Intel report based simulation cases] button.
Edit the highlighted case: Brings up the dialog box to edit parameters for selected event.
Remove the selected cases: Removes selected event from simulations.
Remove all of the cases: Same as the [Remove all the simulations] button.

<table>
<thead>
<tr>
<th>Output: Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate evolved Interaction Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Agent Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Knowledge Matrix</td>
</tr>
<tr>
<td>Generate evolved Agent-to-Task Matrix</td>
</tr>
</tbody>
</table>

These menu items will display in the Near Term Results menu:
Generate evolved Interaction Matrix:
Generate evolved Agent-to-Agent Matrix: Displays how agents interact with one another.
Generate evolved Agent-to-Knowledge Matrix: Displays how knowledge is diffused within the agent network
Generate evolved Agent-to-Task Matrix: Display how tasks are used within a network.
20 Near Term Impact Analysis

The Near Term Analysis (NTA) is a tool that allows for the removal of nodes from a given organizational structure to evaluate how the organization will likely perform as a result. The Near Term Analysis tool uses a multi-agent model as input, Dynet ML*. The goal is to provide an answer to the question on how an organization will behave and change after considering a sequence of strategic interventions or personnel loss by way of agent removal. In other words, we want to know what happens when we remove nodes from an organization, be they people, places, resources, knowledge sets or other common Node Classes*.

This example will use the Stargate dataset (SG-1). This dataset is included with the version of ORA downloaded and can be found online at the following url: http://www.casos.cs.cmu.edu/projects/ora/sample.php.

From the menu bar select File => Open Meta-Network then select SG1.xml.

In this example, we will remove two agents: daniel_jackson and maj_samantha_carter

1. Open the SG1 MetaNetwork into ORA.
2. Highlight the SG1 Meta-Network before starting NTA in the ORA Meta-Network Manager panel.
3. From the main menu select Analysis => Near-Term Analysis.

NOTE : If your dataset contains an Organization Node Set ORA will display the NTA main window. If not, it will ask for you to chose a substitute Organization Node Set.
When a Meta-Network is first loaded into ORA's the Near Term Analysis, a pop-up may appear asking for a location node. Select Cancel and proceed with the Near Term Analysis.

The NTA main window consisted of four sub panels: Input Data, Settings, Simulation timeline and Cases to simulate. Below is a brief description of each panel:

20.1 1. Input Data

In this section is the file name of the Meta-Network loaded.

20.2 2. Settings (Global Parameters)

In the Setting area are two text boxes. The first, The Number of replications informs ORA how many times to run the simulation. The second, The number of simulated time-points defines the range in the section Simulation time line.

In the settings area, there are two critical factors: 1) the number of replications and 2) the number of simulated time points.

Why is this important?
The number of replications if set at a higher versus lower value, will result in more experiments being conducted on the scenario the tool is presented. Therefore, the more replications the more likely the results will mirror those in a real world example. The number of time points determines the length of the Near Term Analysis iterations. If this number is also set to a relatively high value, the simulation will take longer.

*NOTE: Be mindful of any memory considerations when running high value replications or time points.*

### 20.3 3. Simulation time line

This area of the Near Term Analysis tool shows a visual representation of the time points selected in Settings area above.

### 20.4 4. Cases to simulate

After the settings (global parameters) are set, the virtual experiment cells need set. Initially, there is a pre-defined simulation cell, the Baseline. The Baseline is the cell without any entities removed as is the control situation when the organization does not experience any interventions. Besides Baseline, any other cells need set up. Start by selected Add new simulation instances, the leftmost of the four buttons.

### 20.5 Add new simulation cases

To run a Near Term Analysis, we will begin by selected the Add new simulations cases button from the main Near Term Analysis Tool (see area highlighted in red ellipse below).
After selecting Add new simulation instances button, a dialog box titled Near Term Analysis– Simulation scenario create wizard will appear. This wizard supports the creation of virtual experiment cells in three different ways. The First allows for the most freedom of choice. The second and the third options will ask for a set of criteria for selecting important agents in the network and make experiment cells according to the selection. Therefore, the first option gives full flexibility to users, and the second and the third option provides a systematic analysis setup method. To proceed this demonstration, select the first option and select [Next].
20.6 There are four options:

The next section explores all four of the Near Term Analysis Options:
Run the Step-by-Step Wizard – This process will help walk through setting up a near term analysis experiment on the Meta-Network loaded into the Near Term Analysis tool.

Create one simulation case – In this simulation experiment, events and user-specified time can be applied to agents.

Create a set of cases by isolating agents – This scenario isolates one agent and performs an experiment. Then the experiment can be performed again with the agent removed.
Create a set of cases by isolating a set of agents relating to a specific measure. – Based on measures contained in the ORA intel report, a set of agents can be isolated and a simulation case can be created.
Near Term Impact Option 1

21.1 Step-by-Step wizard

Selecting the first option brings up the step-by-step creation dialog box.

Under Options select whether to isolate an agent, knowledge, or resource. We'll leave it at agent. Then select the [Next] button.

Under Options select the agent to isolate. Here we select daniel_jackson. The select the [Next] button.
Under Options select the time-step to isolate the agent. For this simulation we select 5. The select the [Next] button.

At this point you are asked if you want to add more events to the simulation or not. You can add as many events as you wish. But for this example we'll only use only one event. Select [No] to continue.

Total 4 runs = 2 simulation cases X 2 replications for each case
Now repeat the steps above and add a second simulation. But this time let’s remove daniel_jackson at time-step 25.

Now proceed to Analysis Results.

22 Near Term Impact Option 2
22.1 Apply events to specified agents

The second option for creating simulation files is to create one simulation case and apply events to specified agents, knowledge, or resource nodes.

Select the [Add new simulation cases] button to bring up the wizard.
1. Type in search criteria to highlight only the agents to work with (i.e. typing in "dan" brought up only daniel_jackson.
2. Place a checkmark on the line. Notice that when you placed a checkmark in the box the Event automatically changed to Isolation.
3. Double-click in the Timing cell to select it and type in a number from 0 to the highest number you selected for your simulation. In this case we'll repeat with the timing of "5".
4. Select the [Add events] button. This places the event in the Simulation event edit list section.
5. If there were more events to add you could continue with the same procedure. When you are done, select the [Add a simulation] button at the bottom.

The two buttons beneath the Simulation event edit list section to remove events from the list. The [Remove all the events] button obviously removes everything in the Simulation event edit list but the Remove the selected events from the event list only removes the events with a checkmark beside them.

The [Reset selection] button removes all checkmarks placed in the bottom table and sets the Event to No Event.

The [Previous] button returns to the main Wizard screen.

When you have finished you will have created the same two simulations as in Option 1.

<table>
<thead>
<tr>
<th>Cases to simulate</th>
<th>Total 6 runs = 3 simulation cases X 2 replications for each case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isolation...</td>
<td>Isolation Information</td>
</tr>
<tr>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>baseline</td>
<td>baseline</td>
</tr>
<tr>
<td>A03_25</td>
<td>Isolation daniel_jackson at time 25</td>
</tr>
<tr>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>A03_5</td>
<td>Isolation daniel_jackson at time 5</td>
</tr>
<tr>
<td>Delete</td>
<td>Edit</td>
</tr>
</tbody>
</table>

Now proceed to Analysis Results.
23 Near Term Impact Option 3
23.1 Create set of cases using Measures

Option 3 allows for selecting agents/knowledge/resources based on their ranking when certain measures are run on them.

Here are three examples run with the same Isolation Time and Cut-offs. Only the measures were changed.

23.2 Centrality, Total Degree

<table>
<thead>
<tr>
<th>Isolation Case</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>daniel_jackson_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>jacob_carter_selmak_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>ren'al_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
</tbody>
</table>

23.3 Cognitive Demand

<table>
<thead>
<tr>
<th>Isolation Case</th>
<th>Isolation Information</th>
<th>Delete</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>baseline</td>
<td>baseline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ren'al_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>jacob_carter_selmak_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
<tr>
<td>daniel_jackson_20</td>
<td>Isolation null at time 20</td>
<td>Delete</td>
<td>Edit</td>
</tr>
</tbody>
</table>

23.4 Clique Count
When you have run the measures proceed to Analysis Results.

24 Near Term Impact Option 4
24.1 A set of agents by a set of cases by measure(s).

Option 4 allows the addition of adding Time gaps between the isolations and whether to isolate them in descending, Ascending, or Random order.

Now proceed to Analysis Results.
25 Near Term Impact Results

Now we're ready to Execute the simulations. But before that you must select the type of Output Options you want. From the Near Term Analysis menu select Output Options => (any or all of the four options).

Now select the [Execute] button in the bottom-right corner. This will bring up two dialog boxes asking you to confirm you're selected output options and then an alert telling you that, this may take a while with a large Meta-Network and a lot of simulation runs.

An alert box will display advising you that the near term calculation may take a long time depending on settings of your experiment.

After selected [Execute] the Processing Near Term analysis dialog will show you the progress.
Next will be displayed the Near Term Analysis results window.

The results of the experiment will compare against the baseline data established prior to the removal of any isolated agents. In the example above, we can see how the network was impacted in the time line when we isolated daniel_jackson and removed this node from the data set.

25.1 Further information can be obtained from the following references:


25.2 For binary task accuracy

## 26 Near Term Impact Results Menu

<table>
<thead>
<tr>
<th>File</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save the Construct launch scripts</td>
</tr>
<tr>
<td></td>
<td>Show text report on the ORA main window</td>
</tr>
<tr>
<td></td>
<td>Save the completely evolved MetaNetworks</td>
</tr>
<tr>
<td></td>
<td>Save the html report</td>
</tr>
<tr>
<td></td>
<td>Save the text report</td>
</tr>
<tr>
<td></td>
<td>Save the Knowledge Diffusion line chart</td>
</tr>
<tr>
<td></td>
<td>Save the Task Accuracy line chart</td>
</tr>
<tr>
<td></td>
<td>Save the Energy Task line chart</td>
</tr>
<tr>
<td></td>
<td>Save the Knowledge Diffusion result CSV file</td>
</tr>
<tr>
<td></td>
<td>Save the Task Accuracy result CSV file</td>
</tr>
<tr>
<td></td>
<td>Save the Energy Task result CSV file</td>
</tr>
<tr>
<td></td>
<td>Close</td>
</tr>
</tbody>
</table>

Save the Construct launch scripts: Information on Construct can be obtained at the following URL: http://www.casos.cs.cmu.edu/project/construct/index.html.

Show text report on the ORA main window: Displays the report in Panel 3 of the ORA Main Interface.

Save the completely evolved MetaNetworks: Will save as an ORA Meta-Network any of the simulation cases with a checkmark in the Select column.

Save the html report: Navigate to a directory to save an html file that can be displayed in a browser.

Save the text report: Navigate to a directory to save an text file.

Save the Knowledge Diffusion line chart: Saves the chart as a .png file that can be used in other documents.

Save the Task Accuracy line chart: Saves the chart as a .png file that can be used in other documents.

Save the Energy Task line chart: Saves the chart as a .png file that can be used in other documents.

Save the Knowledge Diffusion result CSV file: Saves the results as a .csv file that can be used in other programs.
Save the Task Accuracy result CSV file: Saves the results as a .csv file that can be used in other programs.

Save the Energy Task result CSV file: Saves the results as a .csv file that can be used in other programs.

Close:

Copy the chart in the clipboard: Copies the window to the clipboard that can be pasted into other programs.

Standard Deviation ranges: Standard Deviations* displays the range of values for a particular instance.
Grid lines in the chart: Displays the grid lines for values.
Legends in the chart: Displays the legend underneath the chart.
Event annotations in the chart: Displays the event annotations within the chart.
Deviation from the baseline: Using the baseline numbers the chart shows the offset for the simulation.
Show actual values: Uses the actual calculated values in the chart.

Background color: choose the background color of the chart of either white or gray.
27 ORA Reports

Reports are one of ORA's core functions. You can access ORA reports from the main interface drop-down menu bar or from the Reports button, which should appear in the right panel of the main interface after you have loaded a Network.

From the Main Menu select Analysis => Generate Reports; or
Select the [Reports] button

ORA Reports provide a computational tool to analyze data that comprise a network as represented by a Network(s). They are driven by a variety of key measures* proven useful to researchers in the analysis of networks.

27.1 Reports

Reports are one of ORA's core functions, which also include the Visualizer and Chart tools. You can access ORA reports from the main interface drop-down menu bar or from the Reports button, which should appear in the right panel of the main interface after you have loaded a MetaNetwork.

27.1.1 From the Main Menu select Analysis => Generate Reports; or
27.1.2 Select the [Reports] button

The red ellipses on the screen shot below highlight how to access ORA Reports from the main interface.
ORA Reports provide a computational tool to analyze data that comprise a network as represented by a MetaNetwork or MetaNetworks. They are driven by a variety of key measures proven useful to researchers in the analysis of networks.

27.2 Reports Explained

All Measures - Runs a collection of measures and categorizes the output according to risk categories. Each category analyzes a particular aspect of the Meta-Matrix structure.
Belief - The Belief report contains the most common beliefs shared by most people, the beliefs with the highest GINI coefficient, the most strongly held beliefs, the most likely to change beliefs, the most neutral individuals, and the most opinionated individuals.
Capability - This report is used to assess an individuals' and organizations' capability to perform tasks.
CPOF - Analyses the creation and modification of events and tasks and agent collaboration over time.
Change in Key entities - Analyzes the changes over time of the agents that score the highest in measure values.
Communicative Power - Analyzes one or more mental map models, classifying concepts according to their values for selected measures.
Communicators - Analyzes the communication network (agent by agent) and gives high level statistics on its structure.
Complete - Computes all network analysis measures.
Context - Compares measured values against various stylized forms of networks in an effort to characterize the networks topology.
Core Network - Computes the core network and reports general statistics.
Drill Down - Computes the drill down from a selected organization and then to a selected agent.
Event Analysis - Computes the central events with respect to other network entities.
Group Talk - Analyzes the relationships between agent and knowledge.
Immediate Impact - Computes the key actors of a network, and then isolates them individually to determine the effect on measure values.
Influence Net - Displays the influence network and gives high level statistics on its structure.
Intelligence - Identifies key entities and groups who by virtue of their position in the network are critical to its operation.
Located Subgroups - Identifies the subgroups present in the network using various grouping algorithms.
Location Analysis - Computes the central locations with respect to other network entities.
Management - Identifies over and underperforming individuals and assesses the state of the network as a functioning organization.
Merchant Marine - Analyzes the relationships between crew members, owners, vessels and locations of the Merchant Marine Vessel data.
MRQAP - For multivariate cases, if your dependent variable is continuous or count data (like in a negative binomial case), you should use MRQAP. If your dependent variable is binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent to using a linear probability model). You do need to interpret your results accordingly.

Potential Errors - Detects potential errors in agent to agent interactions based on the expected interactions from cognitive similarity and expertise.

QAP Analysis - Computes QAP Correlation and Regression (Dekker and Y-Permutation methods) on input matrices. QAP is designed as a bivariate test (only two variables). Generally, QAP is perfectly fine for almost any bivariate network problem.

Semantic Network - Analyzes one or more mental map models, computing the central graphs and key concepts and statements.

Shortest Path - Computes the shortest path between two entities and general statistics on the paths. The Sphere of Influence on each entity is also computed.

Simmelian Ties Analysis - Calculates the number of Asymmetric, Sole-Symmetric, and Simmelian ties in all Agent by Agent and Organization by Organization graphs and computes the standard measures on them.

Sphere of Influence - For each individual, identifies the set of actors, groups, knowledge, resources, etc. that influence and are influenced by that actor.

Standard Network Analysis - Calculates the standard network analysis measures (degree centrality, betweenness, centrality, etc.)

Trails - Analyzes the trails that an entity class makes through another entity class; for example, how vessels pass through ports.

Version Test - Recomputes the measures contained within the DyNetML file and compares them with the existing measures. This is a diagnostic tool.

28 Report Overview

All Measures - Runs a collection of measures and categorizes the output according to risk categories. Each category analyzes a particular aspect of the Network structure.

Belief Propagation - The Belief Propagation Report contains the most common beliefs shared by most people, the beliefs with the highest GINI coefficient*, the most strongly held beliefs, the most likely to change beliefs, the most neutral individuals, and the most opinionated individuals.

Capabilities - The Capability Report is used to assess an individuals' and organizations' capability to perform tasks.

CPOF - Analyzes the creation and modification of events and tasks and agent collaboration over time.

Change in Key entities - Analyzes the changes over time of the agents that score the highest in measure values.
Communicative Power - Analyzes one or more mental map models, classifying concepts according to their values for selected measures.

Communicators - Analyzes the communication network (agent by agent) and gives high level statistics on its structure.

Content Analysis - Used in conjunction with AutoMap. Creates a new Network (Semantic Network Union) and will reveal the most frequent concepts and the least frequent concepts.

Context - Compares measured values against various stylized forms of networks in an effort to characterize the networks topology*.

Core Network - Computes the core network and reports general statistics.
Custom - Lets the user define a custom set of measures and output formats, name the report, and then add it to the list of custom reports callable from the main interface.

Drill Down - Computes the drill down from a selected organization and then to a selected agent

Group Talk - Analyzes the relationships between agent and knowledge.
Immediate Impact - Immediate Impact computes the key actors of a network, and then isolates them individually to determine the effect on measure values.
Influence Net - Displays the influence network and gives high level statistics on its structure.

Key Entity - Runs a report on the Network for Overall Complexity, Social Density, Social Fragmentation, Communication Congruence, Knowledge Congruence, Performance as Accuracy, and Avg Communication Speed. (Replaces the Event Analysis, Intelligence, and Location Analysis Reports).

Located Subgroups - Identifies the subgroups present in the network using various grouping algorithms.

Management - Identifies over and underperforming individuals and assesses the state of the network as a functioning organization.

Merchant Marine - Analyzes the relationships between crew members, owners, vessels and locations of the Merchant Marine Vessel data.

Potential Errors - Detects potential errors in agent to agent interactions based on the expected interactions from cognitive similarity and expertise.
Public Health - Runs measures on the network and the sub-networks created by grouping people with the same value for the chosen attribute.

QAP/MRQAP Analysis - Computes QAP Correlation* and Regression (Dekker and Y-Permutation methods) on input matrices.

MRQAP - For multivariate cases, if your dependent variable is continuous or count data (like in a negative binomial case), you should use MRQAP. If your dependent variable is binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent to using a linear probability model). You do need to interpret your results accordingly.

QAP Analysis - Computes QAP Correlation and Regression (Dekker and Y-Permutation methods) on input matrices. QAP is designed as a bivariate test (only two variables). Generally, QAP is perfectly fine for almost any bivariate network problem.

Semantic Network - Analyzes one or more mental map models, computing the central graphs and key concepts and statements.

Shortest Path - Computes the shortest path between two nodes and general statistics on the paths. The Sphere of Influence on each entity is also computed.

Simmelian Ties Analysis - Calculates the number of Asymmetric, Sole-Symmetric, and Simmelian ties* in all Agent by Agent and Organization by Organization graphs and computes the standard measures on them.

Sphere of Influence - For each individual, identifies the set of actors, groups, knowledge, resources, etc. that influence and are influenced by that actor.

Standard Network Analysis - Calculates the standard network analysis measures (degree centrality, betweenness, centrality, etc.)

Trails - Analyzes the trails that an entity class makes through another entity class; for example, how vessels pass through ports.

Unique Trails Report - Analyzes the path of an entity class through locations over time.

Version Test - Recomputes the measures contained within the DyNetML* file and compares them with the existing measures. This is a diagnostic tool.
29 Report Selection Wizard

The Report Selection Wizard provides step-by-step help to perform common analytical reports on your data with a series of pop-up windows requesting input. This tool will help identify the reports that are most relevant to the type of information provided. From the main menu select Analysis => Report Selection Wizard

This will bring a series of dialog boxes asking for the Networks, aspects, what you want to know, and what you're concerned about. After answering the questions ORA will run the reports that are more concerned with what you've indicated you need.

![Report Selection Wizard](image)

Select one or more meta-matrices below to begin.

- stargate
- sg1-origina

![Report Selection Wizard](image)

Which of the following aspects do you want to focus on?

- Who (people, groups, organizations...)
- What (tasks, events...)
- Where (locations)
- When (multiple time periods)
After selecting [Finish] ORA will generate it's reports and open them in both your browser and also in panel 3 of the main interface. Below is the beginning of the report run on the stargate dataset.

Since this function has such a large number of possibilities it's impossible to demonstrate them all.

29.1.1.1  Your actual report will be much longer.

29.2  Management Report

Input data: embassy_tanzania_ct_period3
Start time: Mon Jul 16 15:42:34 2007

29.3  Key Individuals
29.4 Emergent Leader (cognitive demand)

Measures the total amount of cognitive effort expended by each agent to do its tasks.
Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.378917</td>
<td>fazul_mohammed</td>
</tr>
<tr>
<td>2</td>
<td>0.353604</td>
<td>khalfan_mohamed</td>
</tr>
<tr>
<td>3</td>
<td>0.305313</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>4</td>
<td>0.280313</td>
<td>jihadist_mohammed_ali</td>
</tr>
<tr>
<td>5</td>
<td>0.276083</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>6</td>
<td>0.243792</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>7</td>
<td>0.192542</td>
<td>mohammed_salim</td>
</tr>
<tr>
<td>8</td>
<td>0.183771</td>
<td>ahmed_the_german</td>
</tr>
<tr>
<td>9</td>
<td>0.180042</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>10</td>
<td>0.177292</td>
<td>ahmed_ghaitani</td>
</tr>
</tbody>
</table>

29.5 Report continues...

30 Simulated Annealing Network Optimization
Select the Measures you would like to optimize. Note that you can select multiple measures to be optimized simultaneously. Graph Level allows you specify the Entity type (Agent, Agent; knowledge, knowledge; Task, Task; Resource, Resource). The black circles below highlight the areas of the Network Optimizer window pane that allow you to customize your network optimization.

After you have selected the measures you are interested in optimizing, select the [Next] button.

Choose the sub-networks that to be varied during the optimization process. If you chose Monte Carlo method you should also specify if you would like to run optimization with fixed or random density, and if you want to keep at least one non-zero element in every row of sub-Network.
Select the [Next] button

Then choose the optimization criterion: Sum or Product.

Select the [Next] button
Specify the location for the data log file, without specifying an extension. Select Verbose if you want to analyze the whole process of optimization.

Select the [Finish] button
The data log file will be displayed in the bottom panel of the main ORA Main Interface window.

31 Meta-Network Anonymizer

The Meta-Network Anonymize tool removes IDs (and optionally Titles) from any chosen NodeSet.

*This is particularly helpful if you are discussing sensitive network information about real people and wish to remove their names from the network model.*

From the main menu select Data Management => Meta-Network Anonymize….
1. Select a Meta-Network: All active Meta-Networks appear in the dropdown menu. Select the Meta-Network to anonymize.

2. Select the node class to anonymize: Placing a checkmark in the box next to the NodeSet selects the NodeSet to be anonymized. Both the ID and Title will be replaced by an identical value.

3. Anonymize node titles: A checkmark in this checkbox tells ORA to also anonymize the title attribute.

4. Create decoder files: Creates a .CSV* file for future reference with the Encoded ID/Title and Original ID/Title.

### 31.1 Example

On the left is the Agent NodeSet was selected without the Anonymize node titles checked. If the Anonymize node titles had been checked the NodeSet would have been changed as appears on the right.

*NOTE: ORA places the same value in both the Node ID and Node Title when Anonymize node title is checked.*
31.2 Writing The File

When the [Anonymize] button is selected ORA writes a .CSV* file. The Save box allows the user to navigate to a directory to save the file.

Encoded ID, Original ID
A-1,A01
A-2,A02
A-3,A03
A-4,A04

31.3 Node Title

If the Anonymize node title is selected then ORA will also write the original Title to the file.
Encoded ID, Original ID,Title
E-1,E01,revanna_meeting
E-2,E02,summit_meeting
E-3,E03,revanna_bombardment
E-4,E04,sgc_meeting
32 Network Algebra

The Network Algebra allows you to perform mathematical operations on two Meta-Networks. The options in ORA are addition, subtraction, and multiplication.

*Note: The term Network Algebra is synonymous with Matrix Algebra in computational parlance. Also, the following images display "Matrix Algebra" in the title bar. This may or may not be the case for the most recent version of ORA.*

These functions help spot strong and weak connections within a Meta-Network.

I start with one Network loaded.

From the menu select Data Management => Network Algebra…

The Network Algebra dialog appears. There are six areas which you can manipulate. These are each described below the dialog box.

*Note: Both Networks should be the same dimensions.*

1. Select a MetaNetwork
This dropdown menu will show all the Networks you currently have active. To perform a math function on a Meta-Network, highlight it in the dropdown menu.

2. Select an Operation

This option allows you to choose which operation, Add, Subtract, or Multiply, you want to perform on the Networks.

- Add: Adds together corresponding cells of two different Networks.
- Subtract: Subtracts corresponding cells of two different Networks.
- Multiply: Multiplication is slightly different than the add or subtract. The number of rows in the first Meta-Network must equal the number of columns in the second. A Meta-Network can be multiplied by itself to help reveal specific strong and weak areas.
  - Add Networks:
  - Subtract Networks:
  - Multiply Networks:
  - Dot Products Networks:
  - Set the Diagonal:
  - Add by a Scalar:
  - Subtract by a Scalar:
  - Multiply by a Scalar:
  - Divide by a Scalar:
  - Transpose:

3. Select Network 1:

Next select the first Network you want to work with.
4. Select Network 2:

Then select the second Network to do the algebra on.

5. Add Network:

If you wish, you can add additional Networks to the equation. Different selections in the previous choices will give you different options in each dropdown.

6. Enter a name for the new Network:

When everything is set, type in the name for your new Network. Finally, select [OK] to create your new Network. You can then create more Networks if desired. When done, select [Cancel] to remove the dialog box from the screen.

Your new Network will now appear in the box with your Meta-Network. Next highlight the Network you just created.

Next, select the [Visualize Only this Network] button

You will get a warning box asking if you're sure you want to visualize only one Network. Select [OK] to run the Visualizer or close the box.
This will bring up the Visualizer displaying the Network. Your display will depend on the Network selected. In this particular example, there are only Agents and Links connecting Agents displayed in the Visualizer and the Legend.

Now we'll create a second Network by using the multiply operation. The second Network will put knowledge into the mix.

32.1.1 Note: Remember to name your file something different.
Highlight your newly created Network and select the Visualize Only this Network once again and select OK in the dialog box.
This time, since a Network with knowledge was selected the Visualizer and Legend display both Agents and Knowledge and also the Links connecting them all. Also the Matrix Algebra selected was multiplication it creates links which were not in the original Network.
These sets of menu items enable you to control the addition or removal of Meta-Networks, Meta-Nodes, and Networks as well as adding Attributes to a Meta-Node.

The Matrix Algebra*, Meta-Network Transform*, and Meta-Network Union… also create new Meta-Networks, Meta-Nodes, and Networks but do it with Mathematical operations.

Meta-Network Algebra… – Enables you to perform mathematical operations on two Meta-Networks.

Meta-Network Transform… – Tools which enable you to clean up a Visualizer display making it easier to read.

Meta-Network Anonymize… – Used for resetting the NodeID (and optionally the Node Title) to anonymous values.

Meta-Network Union – Creates a single Meta-Network from two (or more) existing Meta-Networks.

Meta-Network – Used for adding or removing Meta-Networks from use.

Node Class – Enables you to add, remove Node sets, as well as, change the size of the Node set. You can also add an Attribute to an existing Node Set. Depending on what you have selected different options may be grayed out.

Network – Similar to Node Class in that you can add or remove Networks. This function also enables you to Set the Diagonal of a graph to either -1, 0 or +1. Useful for setting consistent values on an agent-by-agent Network.
34 Meta-Network Union

The Meta-Network Union is used to combine two or more Meta-Networks together. There are tools to select which Meta-Networks to use or exclude and how to combine the link weights. ORA can save out the result as an entirely new MetaNetwork file.

The Select a collection of meta-networks has two options.

- Currently loaded in ORA will create a new Meta-Network from all the Meta-Networks loaded into ORA (except the ones that are excluded).
- All files in the directory allows you to navigate to a directory in which are stored multiple Meta-Networks.

Next is Select filters which narrows the Meta-Networks to use.

- Use only meta-networks in the date range: filters meta-networks which fall outside the selected dates. This information is maintained in a separate document file.
- Use only meta-networks with source: filters meta-networks which contain the source information contained in a separate document file.
Next is Select how to combine edge weights: contains the options for reducing the amount of edges within a Meta-Network.

I start out with two Meta-Networks, stargate_summit_allies and stargate_summit_badGuys and I will join them together into a single Meta-Network. Both the existing Meta-Networks contain 15 nodes.

From the main menu select Data Management => Meta-Network Union…

There is now a new Meta-Network in panel 1 called Union which is a combination of the two other Meta-Networks.
35 Meta-Network Transform

On some occasions the display in the Visualizer is too cluttered to make much sense of your network model. ORA offers a variety of ways to clean up the display in order to make it easier to view your data.

In the main menu select Data Management => Meta-Network Transform.…

The Meta-Network Transform dialog box will appear. It consists of three sections. The top section display a dropdown menu with all the currently active Meta-Networks. Use this menu to select the Meta-Network. The bottom section has two tabs. The Entire Meta-Network contains choices on how to transform the Meta-Networks. The Individual Networks tab allows you to select to work on only individual networks.

35.1 The "Entire Meta-Network" tab

Remove Isolates
Removes any isolates* from the selected meta-network.

Remove Pendants
Removes any pendants* from the selected meta-network.
Symmetrize by Method
Symmetrize turns directed or asymmetric network data into undirected or symmetric data. All three methods use a pair of values from the upper and lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1). If a network had a link from A to B but not from B to A then symmetrizing the network would create a reciprocal link from B to A.

- Maximum Compares the values and uses the larger of the values. This is called using the strongest value.
- Minimum Similar to Maximum only it uses the lower, or weaker, value.
- Average takes the two values and averages them.

Symmetrize bipartite graphs:
Symmetrize bipartite graphs* combines networks in the Meta-Network that are transposes of each other; for example, if there is an Agent x Location Network and a Location x Agent Network, then a single Agent x Location Network is created by combining the edges from both Networks.

This is used to reduce the number of Networks in a Meta-Network when Link direction does not matter.

Remove Links:
When using weighted links this functions allows for links to be removed from view. You can choose from six options for the removal of links.

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>lessThan</td>
</tr>
<tr>
<td>lessThanEquals</td>
</tr>
<tr>
<td>equals</td>
</tr>
<tr>
<td>notEquals</td>
</tr>
<tr>
<td>greaterThan</td>
</tr>
<tr>
<td>greaterThanEquals</td>
</tr>
</tbody>
</table>

Binarize (set link weights to one):
Binarize* takes all links weighted greater than 0 and make them all equal to "1". All links will be either 1 or 0.

Create partition Networks by attribute:
This partitions the Node Set according to the values of the specified entity attribute and then creates a group of new graphs based on the partitioned Meta-Node. This kind of grouping is often done in network analysis to understand how some Meta-Nodes are embedded in various social roles or how they interact within larger Meta-Nodes. The dropdown menu will contain all the attributes in the meta-network.

Example, if you have an Agent Meta-Node that has a gender attribute for each node that takes on values male and female, then using this feature four new Agent x Agent Networks would be created that contained links from males to males, males to females, females to males, and females to females. No new Meta-Node is created and no data is changed.

Create union matrices
This creates new graphs that are the union of all graphs of the same type. If the Meta-Network had two Agent x Agent Networks, then using this feature would create a new Agent x Agent Network which would contain all the links that were present in the original two Networks.

**Create a meta-matrix (one matrix with one node class)**

Creates a new Meta-Network with a single Node Class and a single Network. The nodes are prefixed with the name of the Node Class they were taken from.

### 35.2 The "Individual Networks" tab

Choose one or more networks to transform by placing a checkmark in the box. If you want to exclude a network, remove the checkmark. Then select one or more transformations to apply:

- **Symmetrize by method**: Symmetrize is a tool that is used to turn directed or asymmetric network data into undirected or symmetric data. All three methods use a pair of values from the upper and lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1).
- **Remove links**: When using weighted links this functions allows for links to be removed from view. You can choose from six options for the removal of links.
- **Binarize (set link weights to one)**: Will take any weighted link and make them all equal to "1".
- **Transpose the given matrix**: 

### 36 Copy / Paste

ORA offers multiple options for copying Meta-Networks, NodeSets, and Networks. Copy/Paste Editor Values:

The easiest way is to use the Ctrl-C keystroke to copy and the Ctrl-V keystroke to paste. A duplicate of the Meta-Network, NodeSet, or Network will appear underneath the original.

- **Copy / Paste Meta-Network** duplicates the selected Meta-Network.
- **Copy / Paste NodeSet** duplicates the selected NodeSet.
- **Copy / Paste Network** duplicates the selected Network.
- **Copy / Paste Values** duplicates the values selected in the Editor.
37  Copy / Paste Meta-Network
37.1  Create New Network from Existing Network

What follows are procedures to create a new Network with previously existing data. This is useful to do to experiment on your data by duplicating an entire Network thus preserving the original data set. Highlight the Network you want to duplicate.

From the main menu select Edit => Copy Meta-Network. Notice that only the Copy Meta-Network is available. The Paste Meta-Network option is grayed out. Once you have copied a Meta-Network the Paste Meta-Network will become active indicating you have information in the clipboard.

From the main menu select Edit => Paste Meta-Network. At this point the Paste Meta-Network will become solid.

There will now be a second Meta-Network with the same name as your original file.
It's best to differentiate this from the original file so we'll attach -NEW to the end of the filename. In panel 2 you'll find a textbox titled Meta-Network ID. Change the name to whatever you need in order to differentiate it from the original file.

You'll notice in panel 1 that each Meta-Network now has an individual name.

38 Copy / Paste Network

Copy / Paste Network is very much like Copy / Paste NodeSet, the ability to quickly duplicate Networks.
First, select the network to duplicate.

From the main menu select Edit => Copy Node Network(s)
From the main menu select Edit => Paste Node Network(s)

A dialog box will appear asking for the name of the new Network. Type in a new name and select [OK].

Your new Network set will appear underneath the selected Network

You can also select multiple Networks for duplication. ORA will ask you to input a new name of each of the newly created Networks.
39 Copy / Paste NodeSet

If you find the need to run a destructive routine on a Node Set then creating a duplicate is a good idea.
First, select the node to duplicate.

From the main menu select Edit => Copy Node Class(es)

From the main menu select Edit => Paste Node Class(es)

A dialog box will appear asking for the name of the new Node Set. Type in a new name and select [OK].

Your new node set will appear underneath the selected NodeSet.
You can also select multiple NodeSets for duplication. ORA will ask you to input a new name of each of the newly created NodeSets.

40 Copy / Paste Editor Values
40.1 Creating a new Meta-Node

There are times you need to create a new Meta-Node with existing values from another Meta-Node. What follows are procedures to accomplish this task:

In this example a second Meta-Node will be created from the original set of nodes.


Select the Add New Node Class... button.
This will bring up the Create node Class dialog box. I give it a new name, Agent-new, leave the type as Agent, and set the Enter a size for the NodeSet to 4 in order to create a new set with only the members of SG-1. Then select the [OK] button.

A new NodeSet will appear in the left panel, Agent-new [Agent]: size 4.

Go back to the original NodeSet.

Move the pointer into the topmost cell. Click in the cell col_jack_o'neill. Without releasing the button slide down four cells to teal’c.
From the main menu select Edit => Copy Editor Values.

Re-Select the new NodeSet.

Move the pointer into the topmost cell and click the button. Now drag the pointer down to the bottom cell.

From the main menu select Edit => Paste Editor Values
The values are now copied into the new NodeSet.

### 41 Edit Menu

Below is an image of the Edit Menu. Further below is a description of the Edit Menu functions accessible through the Edit Menu.

**Copy Editor Values / Paste Editor Values**

Used to transfer information between Meta-Nodes. The Meta-Nodes created can be identically sized (allowing you to paste an entire column in) or a smaller, subset allowing you to choose only a portion of the original set.

**Copy Meta-Network / Paste Meta-Network**

Used for quickly creating duplicate Meta-Networks. When you first start the program the Paste Meta-Networks is grayed out. It will only become active once you've used the Copy Meta-Network menu item.

**Preferences**

Contains settings for controlling the environment for working within ORA.

### 42 Hovering / Tool Tips
Hovering the pointer over various parts of the panels will reveal information about the Meta-Network.

Hovering over the parts in Panel 1 will reveal different information about the Meta-Networks, Meta-Nodes, and Networks.

In the following example, we can see the "Tools Tips" as they appear in the View Measures Over Time tool.
What follows is an example of tool tips in the color nodes by measure tool in the ORA Visualizer.

When working with the visualizer, you must have the “Show mouse over” display option selected to get tool tips within the Visualizer.

Below is a screen shot of where to find the show mouse over option in the ORA Visualizer.
43 Preferences
43.1 Setting up your environment

The ORA preferences tool allows you to group Reports and a set of files to open automatically thus saving the analyst time when revisiting data reports.

43.2 Reports

From this window you can rename and restore report names, export settings for automatic loading, and import previously created data sets. Below is the default preference window.

To rename a report Right-click on the name. A small box will popup, Rename this Report. If you wish to rename this report Left-click the box.
A dialog box will appear. Enter the name you want to rename the chosen report.

In this case I chose the name fizzbin.

To rename the report select OK. The report formerly known as Change in Key Modes is now known as fizzbin.
Now say you wish you hadn't renamed all those reports cause a name like fizzbin really doesn't make much sense. Select the button marker Reset report names. A dialog box will appear asking if you want to reset your report names.

*Note: Resetting report names resets ALL report names!*

Now all your reports names are back to their defaults.
Now let's say that you know that you don't need every single report to show up in the program. You can set which reports are visible and hidden. By un-checking the box to the left of the name the report will be invisible to the program.
43.3 Export Settings

After you've finally decided which reports you want visible (and invisible) and what you want all your reports to be called you can save this setting for future reference. So even if someone else changes report names or visibility settings you can call your personnel setting up and quickly resume your work.

First select the Export Settings button at the bottom of the dialog box. This will bring up a second dialog box. Select OK to confirm this is the action you wish. If not, select the X in the top-right corner.

This will bring up a Save dialog box. Type in the name you want to save your settings at and select Save.

So the next time you start up the program and names and settings have been changed you can select Import Settings, navigate to the directory you saved you Settings file and have ORA reset the names and visibility settings.
Save this file in a place you remember so you can call up your settings quickly.
43.4 Data Sets

This dialog box controls what Networks will load up during startup. There are three options.

43.5 1. Do not load any files at startup

ORA will start up with no files loaded in panel 1.

43.6 2. Restore previously loaded workspace

Whatever files were loaded (and saved) when you quit the program last will be reloaded the next time the program is started.
43.7 3. Load specified files below is a little more involved.

First select the Load specified files below radio button. Then select the Add Files button.

The Open dialog box will appear. Navigate to the directory of the files you want to automatically open. Select one or more files. In order to select more than one file press and hold the Ctrl key while selecting multiple files. You will see them appear in the File name text field. When you have selected all your files select the Open button.

In the ORA preference dialog box the files you selected will appear under the Add Files button.
If at some time in the future you wish to delete one or more of the files you selected from automatically opening up on startup you can clear multiple files from the list. Select one or more files (pressing and holding the Ctrl key for multiple files. Then select the OK button.

You will be prompted to confirm your choice.

If you selected Yes then the selected files will be removed from the list of files to load at startup.
Use this panel to determine which data files to load at startup.

You can specify a set of files to always load at startup here, or you can re-load whichever files are loaded when you close the program.

- Do not load any files at startup
- Restore previously loaded workspace files at startup
- Load specified files below:

  ![File Path]

  ![File Path]

[Add Files] [Remove Files]

[OK] [Cancel]
45  CEMAP II

CEMAP II is an tool within ORA that allows you to pull in a variety of network data by defining certain parameters about the network types you are interested in obtaining. Whereas the original CEMAP tool allows you to pull in predefined network parameters relating to email, CEMAP II allows the user versatility in defining exactly what network data you interested in obtaining. It can be used as a tool to input data from a variety of other programs, so long as those programs can output into CSV files or other table sets. See further below for instruction on importing data using CEMAP II.

It should also be noted that CEMAP II is similar to unfixing the fixed parts of CEMAP, thus allowing greater flexibility for the user in defining variables relating to network types (i.e., agent x agent, agent x task, agent x knowledge).

45.1  Key Components / Core Functionality

The user needs to be aware of several key area of the CEMAP II GUI as well as the methodology for using the tool. In turn, there are two primary areas of the GUI, which correlate to the user’s methodology for using the tool. Those areas will be explained in greater detail further below this document. However, what the you need to be aware of is CEMAP II's core functionality:

1.  Table set
2.  Templates
3.  Mapping (between the Table sets and Templates)

Other key points to know about CEMAP II:

- It is user extendable
- It is about Modules. When new ones are added, new documentation can be added as well regarding the latest additional module.
- It uses an API to get information from places like social networking sites such as Facebook.

45.2  How to Access CEMAP II

CEMAP II is accessible from ORA’s main menu bar (screen shot below):

Main Menu Bar > File > CEMAP II
(screen shot above: Accessing CEMAP II from ORA’s Main Menu Bar)

(Note: Before the GUI is accessible, you may see the above warning message).
45.3 CEMAP II GUI

45.4 Lesson on using CEMAP II to import network data

>>> Go to a step-by-step lesson on how to important data from Facebook into CEMAP II

45.5 Networking in CEMAP (original tool)

(Note: This help refers specifically to the original CEMAP Tool. Eventually, CEMAP II will replace CEMAP)

Network type 1 Social network (SN) represents social network data that can be extracted from email headers (e.g. agent-agent networks). In Social Networks, entities represent people, and edges represent exchanged emails (frequency count). This network type does not require any text coding in AutoMap.

Networks types 2 and 3 are extracted by performing text coding in AutoMap. More specifically, Knowledge Networks (KK) represent semantic network or mental models
that are contained in the bodies of individual emails. In KK, entities represent knowledge items, and edges represent the co-occurrence of terms in text. For Meta-Matrix (MM), texts are coded in AutoMap according to a taxonomy or ontology (e.g. meta-matrix, while are ontologies can be specified by the user). In MM, entities represent instances of categories (e.g. agent, knowledge, resources) of the ontology, and edges represent co-occurrences of terms in texts.

Networks types 4 and 5 result from the combination of SN with KK and MM, respectively. In type 4, entities represent people and knowledge, and edges represent emails and mental models. In type 5, nodes represent the categories of the taxonomy as specified by the user, and the edges represent the co-occurrence of the terms that represent instances of the taxonomy in the corpus. For the creation of type 4 and 5, the extraction of type 2 and 3, respectively, is mandatory.

CEMAP stores all network data as DyNetML files (a derivate of XML). This data can be analyzed with any package that reads DyNetML. We recommend using the ORA software for this purpose (http://www.casos.cs.cmu.edu/projects/ora/index.html).

45.6 The Top textfields

- Input File -or- HTTP URL

  Input File -or- HTTP URL – Input Data Set. You specify the email client, inbox type, username, and password as semicolon separated values. The location can be either file or server (e.g. pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword).

45.6.1 NOTE: The following information is what is needed to access an email account.

- Server – The IP address or URL of the server.
- Port – The port on the server to connect to.
- UserID – ID of the User.
- Password – The User's Password for accessing the Mailbox.
- Mailbox/Folder – The ID of the mailbox to use.

lip>File Directories

45.7 The Directory Buttons

- This section allows the user to dictate where the end files will be written to.
- Select Output Directory for full document bodies – Directory to save the body of the email text.
- Select Output Directory for document bodies (new content Only) – Directory to save body of the email. Discards all the repeat material that is quoted from previous emails.
Select Output Directory for document bodies (forward content Only) – Directory to save Forwarding content.
Select Output Directory for SubjectLine Bodies – Directory to save the Subject Lines of the email.
Select Output Filename for Header Network file – Directory to write a single containing the Header.

45.8 Checkboxes at the bottom

- Anonymize Agents – Anonymize Agents changes the agents name (only agents) to A# (# is a number) in DyNetML.
- SSL (Secure Sockets Layer) (For IMAP and POP3 only) – Creates a secure connection between a client and a server, over which any amount of data can be sent securely.
- De-Dupe Messages – Ignores identical emails.

The file prefix makes it possible to put all the files in the same directory

45.9 The Start Button

The Start Extraction button begins the process.

45.10 Extraction of network type 1 data:

1. This network type is needed to perform social network analysis (SNA) based on header information only.
2. In CEMAP, Analysis Type, select the type of your mail box.
3. In CEMAP, Input Data Set, specify your email client, inbox type, username, and password as semicolon separated values, e.g. pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword
4. In CEMAP, Enter Destination Directory for Texts, put in a directory of your choice, e.g. C:\textInput. The email bodies will be stored in AutoMap format (.txt) under this directory. Make sure that this directory does exits on your machine.
5. In CEMAP, Enter Destination File for Network, put in a directory AND filename of your choice. The filename extension needs to be .xml. e.g. C:\output\AA.xml.
6. You are now ready to extract network type 1. In order to do so, press the Start Extraction button. As a result, CEMAP will extract network data from the email headers (e.g. agent by agent) and store it as one XML file under the directory that is specified in the Destination File for Network.
7. You can pick up the output file and load it into the SNA package of your choice. We recommend using the ORA package (http://www.casos.cs.cmu.edu/projects/ora/download.php).

To extract networks of type 2, perform Semantic Network Analysis in AutoMap.
To extract networks of type 3, perform Meta-Matrix Text Analysis in AutoMap.

To extract networks of type 4, merge networks of type one and 2.

To extract networks of type 5, merge networks of type one and 3.

CEMAP is a feature in AutoMap that will import email files into AutoMap to analyze the text in the emails, such as who exchanges information, who provides what information, etc.

45.11 To use the feature:

- In the AutoMap menu bar, select Tools > Open CASOS Email Parser (CEMAP).
- In the ORA menu bar, select File > CEMAP Email-Importer….

Once that is selected the CASOS — Email Analyzer window will appear. The Email Analyzer window is where you will type in your information of what type of network you would like to create while importing your emails.

45.12 The different types of imports are

- Full email
- Header information only
- Forwarded/New emails
- Subject lines only

45.13 Type Selection

Select the type of Format your email is in, from the drop down menu.

- MBOX – A generic term for a family of related file formats used for holding collections of electronic mail messages. All messages in an mbox mailbox are concatenated and stored as plain text in a single file. The beginning of each message is indicated by a line whose first five characters are "From" (the so-called "From_line" or "From' line") and a blank line is appended to the end of each message. For a while, the mbox format was popular because text processing tools can be readily used on the plain text files used to store the e-mail messages. This is want you see when you View Source in a browser.
- POP3 – (Post Office Protocol) version 3 (POP3) is an application-layer Internet standard protocol to retrieve e-mail from a remote server over a TCP/IP connection.
- IMAP – (Internet Message Access Protocol) Is an application layer Internet protocol operating on port 143 that allows a local client to access e-mail on a remote server.
o TXT – Exported email files from outlook – will require a Data (file) set identifier
o CasosDB – for internal use only
o DyNetml – Proprietary format for ORA.

Once you have selected what type of format you would like to use, click on the Start Extraction button. This will begin the process of importing your emails.

45.14 Examples of POP3 and IMAP setups

Below are examples of setting up CEMAP with POP or MAP servers. Refer to the documentation with a particular server regarding the exact Server, Port, or other pertinent information necessary.
CEMAP is an ORA tool that primarily allows you to pull network data in the form of emails into ORA. However, the CEMAP tool could be used to convert any sources of data in the world into DyNetML, ORA's native file format, for analysis.

Setting up CEMAP is similar to setting up a new ISP mail client. What follows are procedures to configure this tool and how to use it.
Each email has an identifying number in a long number showing the date, for example: [20060308042751s1500bi66e]. The 20060308 is in the year/month/day format and says this email was sent on March 8, 2006.

The CASOS Email Parser (CEMAP) that is launched through AutoMap/ORA (http://www.casos.cs.cmu.edu/projects/automap/software.html) enables the extraction of different types of network information from emails (e.g. who exchanges information, who provides what information, etc.). The following image shows what types of information can be extracted with CEMAP.

Network type 1 Social network (SN) represents social network data that can be extracted from email headers (e.g. agent-agent networks). In Social Networks, entities represent people, and edges represent exchanged emails (frequency count). This network type does not require any text coding in AutoMap.

Networks types 2 and 3 are extracted by performing text coding in AutoMap. More specifically, Knowledge Networks (KK) represent semantic network or mental models that are contained in the bodies of individual emails. In KK, entities represent knowledge items, and edges represent the co-occurrence of terms in text. For Meta-Matrix (MM), texts are coded in AutoMap according to a taxonomy or ontology (e.g. meta-matrix, while are ontologies can be specified by the user). In MM, entities represent instances of categories (e.g. agent, knowledge, resources) of the ontology, and edges represent co-occurrences of terms in texts.

Networks types 4 and 5 result from the combination of SN with KK and MM, respectively. In type 4, entities represent people and knowledge, and edges represent emails and mental models. In type 5, nodes represent the categories of the taxonomy as specified by the user, and the edges represent the co-occurrence of the terms that represent instances of the taxonomy in the corpus. For the creation of type 4 and 5, the extraction of type 2 and 3, respectively, is mandatory.
CEMAP stores all network data as DyNetML files (a derivate of XML). This data can be analyzed with any package that reads DyNetML. We recommend using the ORA software for this purpose (http://www.casos.cs.cmu.edu/projects/ora/index.html).
46.1 The Top text fields

- Input File -or- HTTP URL

Input File -or- HTTP URL – Input Data Set. You specify the email client, inbox type, username, and password as semicolon separated values. The location can be either file or server (e.g. pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword).

46.1.1 NOTE : The following information is what is needed to access an email account.

- Server – The IP address or URL of the server.
- Port – The port on the server to connect to.
- UserID – ID of the User.
- Password – The User's Password for accessing the Mailbox.
- Mailbox/Folder – The ID of the mailbox to use.

lip>File Directories

46.2 The Directory Buttons

- This section allows the user to dictate where the end files will be written to.
- Select Output Directory for full document bodies – Directory to save the body of the email text.
- Select Output Directory for document bodies (new content Only) – Directory to save body of the email. Discards all the repeat material that is quoted from previous emails.
- Select Output Directory for document bodies (forward content Only) – Directory to save Forwarding content.
- Select Output Directory for Subject Line Bodies – Directory to save the Subject Lines of the email.
- Select Output Filename for Header Network file – Directory to write a single containing the Header.

46.3 Checkboxes at the bottom

- Anonymize Agents – Anonymize Agents changes the agents name (only agents) to A# (# is a number) in DyNetML.
- SSL (Secure Sockets Layer) (For IMAP and POP3 only) – Creates a secure connection between a client and a server, over which any amount of data can be sent securely.
- De-Dupe Messages – Ignores identical emails.

The file prefix makes it possible to put all the files in the same directory
46.4 The Start Button

The Start Extraction button begins the process.

46.5 Extraction of network type 1 data:

1. This network type is needed to perform social network analysis (SNA) based on header information only.
2. In CEMAP, Analysis Type, select the type of your mailbox.
3. In CEMAP, Input Data Set, specify your email client, inbox type, username, and password as semicolon separated values, e.g. pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword
4. In CEMAP, Enter Destination Directory for Texts, put in a directory of your choice, e.g. C:\textInput. The email bodies will be stored in AutoMap format (.txt) under this directory. Make sure that this directory exits on your machine.
5. In CEMAP, Enter Destination File for Network, put in a directory AND filename of your choice. The filename extension needs to be .xml. e.g. C:\output\AA.xml.
6. You are now ready to extract network type 1. In order to do so, press the Start Extraction button. As a result, CEMAP will extract network data from the email headers (e.g. agent by agent) and store it as one XML file under the directory that is specified in the Destination File for Network.
7. You can pick up the output file and load it into the SNA package of your choice. We recommend using the ORA package (http://www.casos.cs.cmu.edu/projects/ora/download.php).

To extract networks of type 2, perform Semantic Network Analysis in AutoMap.
To extract networks of type 3, perform Meta-Matrix Text Analysis in AutoMap.
To extract networks of type 4, merge networks of type one and 2.
To extract networks of type 5, merge networks of type one and 3.
CEMAP is a feature in AutoMap that will import email files into AutoMap to analyze the text in the emails, such as who exchanges information, who provides what information, etc.

46.6 To use the feature:

- In the AutoMap menu bar, select Tools => Open CASOS Email Parser (CEMAP).
- In the ORA menu bar, select File => CEMAP Email-Importer….

Once that is selected the CASOS — Email Analyzer window will appear. The Email Analyzer window is where you will type in your information of what type of network you would like to create while importing your emails.

46.7 The different types of imports are

- Full email
- Header information only
- Forwarded/New emails
- Subject lines only
46.8 Type Selection

Select the type of Format your email is in, from the drop down menu.

- MBOX – A generic term for a family of related file formats used for holding collections of electronic mail messages. All messages in an mbox mailbox are concatenated and stored as plain text in a single file. The beginning of each message is indicated by a line whose first five characters are "From" (the so-called "From_ line" or "'From' line") and a blank line is appended to the end of each message. For a while, the mbox format was popular because text processing tools can be readily used on the plain text files used to store the e-mail messages. This is what you see when you View Source in a browser.

- POP3 – *(Post Office Protocol)* version 3 (POP3) is an application-layer Internet standard protocol to retrieve e-mail from a remote server over a TCP/IP connection.

- IMAP – *(Internet Message Access Protocol)* Is an application layer Internet protocol operating on port 143 that allows a local client to access e-mail on a remote server.

- TXT – Exported email files from outlook – will require a Data (file) set identifier

- CasosDB – for internal use only

- DyNetml – Proprietary format for ORA.

Once you have selected what type of format you would like to use, click on the Start Extraction button. This will begin the process of importing your emails.
46.9 Examples of POP3 and IMAP setups

Below are examples of setting up CEMAP with POP or MAP servers. Refer to the documentation with a particular server regarding the exact Server, Port, or other pertinent information necessary.
47 Data Import Wizard

ORA’s Data Import Wizard allows the importing of files in a variety of File Formats. The idea behind the data import wizard is that users come to ORA with a variety of file formats from various different network analytical tools. Very rare is it that an analyst has a MetaNetwork ready to load. Moreover, network data may exist in a separate file or in a variety of file formats, which then need to be merged together.

The ORA Data Import Wizard makes it easy for the user to take their data in its native format and separate files and convert it to a MetaNetwork, which in turn creates a DyNetML file.

The files can be in any of the following formats: CSV, UCINET, GraphML, or Pajek. ORA uses the file extension to determine the native file format to assign to your network. Therefore, if you change a file extension from its native extension (e.g., GraphML file such as "example.gml" to "example.dot" ORA will not recognize the data format).

This section will review the basics of the Data Import Wizard. See Creating a MetaNetwork in the Lessons section for more comprehensive information on importing.

From the Main Menu select File => Data Import Wizard…. This brings up the Import Data in ORA dialog box.
47.1 Primary Uses of the Data Import Wizard

- Create a meta-network from separate network files: Use this option to select multiple networks in one of the several native file formats indicated above and pull them into ORA. The file formats don't have to match. ORA will then combine all the network files into one MetaNetwork, which will then be saved as a DyNetML* file (ORA's native file format). See Lesson 202 — Import into ORA
- Create a meta-network from table data: Text files in the form of rows of Nodes and columns of Attributes will be used to populate existing NodeSets. See Lesson 202 — Import into ORA
- Import node attributes from table data: Text files used to import Attributes to a Node. See Lesson 202 — Attributes

47.2 Importing other data formats

If your file format is in any of the following native specifications, you can simply select which one using the appropriate radio button and select Next. ORA will pull the network data will create a MetaNetwork based on its knowledge of the native file format. The primary benefit here is that it saves you time from describing to ORA how your network is formatted (e.g., what is Who, what is a connection). The following formats are recognized by ORA and can be imported directly using the Data Import Wizard:

- AutoMap Thesaurus
- DyNetML
- Analyst Notebook – See Lesson 301 — Analyst Notebook
- GMU Pythia
- Caesar III
- Path Finder
- Trails
- Thing Finder
- PenLink
48 File Menu

Below is an image of the File Menu accessible from ORA’s main title bar menu. Further below are descriptions of the various tools accessible through the File Menu.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Data Management</th>
<th>Generate Net</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Meta-Network…" /></td>
<td>Ctrl+O</td>
<td>Ctrl+S</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td><img src="image" alt="Data Import Wizard…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import Database…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import CASOS Database…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open Workspace…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CEMAP Parser…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Meta-Network…" /></td>
<td>Ctrl+S</td>
<td>Ctrl+S</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td><img src="image" alt="Save Meta-Network As…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Save Workspace" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Network Format Converter…" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Open Meta-Network…

Open Meta-Network opens a single Network with the following formats:
- Dynetml* (the native ORA xml format), .dl, .#h (UCINet), .csv* (comma separated values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml*, .stl* (GMU model), .lo (pathfinder)

Data Import Wizard…

Data Import Wizard contains additional options for importing Networks such as multiple file importing. See Lessons for more comprehensive information regarding this function.

Import Database…

Import Database is an advanced feature for importing a database.

Import CASOS Database…

Open Workspace…

Open Workspace allows you to open an entire workspace that you were previously using. A workspace consists of a set of Meta-Networks that were all open at the same time, and saved as a workspace.

CEMAP Parser…

Save Meta-Network
Initially this item is grayed out. Save Meta-Network only becomes active when you've made a change to a Network. You can use it as an indicator whether you've made a change to the active Meta-Network. Notice as you highlight each Meta-Network the icon in the toolbar will be grayed out (no changes) or colored (changes made to that Meta-Network).

Save Meta-Network As…

Save Meta-Network As… save the changes you've made in a Meta-Network under a new filename.

Save Workspace

Save Workspace save the active Meta-Networks into a Workspace which can be opened up at a later date.

Network Format Converter…

Network Format Converter takes files from one format and convert it to an ORA format.

Exit

Exit

Close the program and leave

49 Import Database

The Import Database function is an advanced feature and is beyond the scope of this help file. However, to connect a database and import network information directly into ORA, please contact Jeff Reminga at CASOS for detailed instruction.

Jeff Reminga — jreminga@cs.cmu.edu
50 Network Format Converter

The Network Format Converter is a tool to take files from one format and convert it to ORA’s native format, DyNetML.

The image below shows the main interface with no Meta-Network loaded.

From the Main Menu File => Network File Converter.
The dialog box will appear. Go to the tab marked Load Network.
Move the pointer over the inverted triangle to select the format of the file to convert. Below is the list of file types available to convert:

- DYNETML
- ASSAMML
- UCINET
- DL
- CSV

Select CSV then select the [Load] button. This will bring up the Open dialog box.

Select the file you wish to convert and select the Open button. Your screen should now look like that below.
Now select the Save Network tab. Select the file format you want to convert your file to. In this case we'll leave it at DYNETML.

Select the [Save] button. Then navigate to the directory you want to save your file. Then type in the name you want your file to be called. 

**NOTE:** Remember to type in the extension .xml so it will be recognized by ORA.

In order to access this file in ORA go to File => Open Meta-Network and open it normally.

Below is a screenshot showing the newly saved file agent_agent_labelled.xml.
Below is a series of procedures describing how to load a Meta-Network into ORA. Most commonly, an analyst familiar with ORA will open a DyNetML* file. These files are in the XML* format. However, if your original data is not in this file format, an analyst can use the Import Data Wizard to convert the data to DyNetML.

From the Main Menu select File => Open Meta-Network. This brings up the initial Help dialog box. Select the [OK] button to continue.

This brings up an Open dialog Box. Navigate to the directory with your DynetML files, select the Meta-Networks to work with in the Open dialog box, and click [OK].
The selected file will then appear in Panel 1 of the main interface.

52 Open Workspace

What follows are procedures to use the Open Workspace tool in ORA. This function allows you to open multiple files at once. The purpose of this tool is save the analyst time in revisiting a previous network analysis environment.

From the Main Menu select File => Open Workspace

The Open Workspace dialog box will appear giving you an explanation of its function.
If you're sure, select [OK]. This brings up the Open ORA Workspace dialog box. Navigate to the directory where you saved your workspace files and select one.

**Workspace files will have the extension OWS.**
All the files that were saved from a previous Save Workspace will be reloaded in the ORA.

### 52.1 Save Meta-Network

What follows are procedures for saving a Meta-Network. This option is initially **grayed out** when you first load a Meta-Network. This signifies that the Meta-Network is currently unchanged.
Whenever you make ANY change within the Meta-Network the option will become full-color indicating it is time save changes.
After clicking the icon in the toolbar, or selecting the menu item, it will become grayed out again till you change your Meta-Network once again.
52.2 No change in the Meta-Network

Save Meta-Network
Save Meta-Network As...
Save Workspace

52.3 After a change was made to a Meta-Network

Save Meta-Network
Save Meta-Network As...
Save Workspace

52.4 Save Meta-Network As...

If you need to save a Meta-Network under a different name use select File => Save Meta-Network As.... This will leave the original file intact and create a new Meta-Network with the new file name.

52.5 Save Workspace

While working with multiple Meta-Networks an analyst may want to retain that information for later use. To make it easier to reload the same files you can use the Save Workspace menu item.

From the Main Menu select File => Save Workspace. This brings up the Save Workspace dialog box. This informs you exactly what you're going to do.

![Save Workspace Dialog Box]

A Workspace saves the list of files which are currently loaded in ORA so they can be easily loaded again in the future.

To save your workspace now, click OK, otherwise click Cancel.
After selecting [OK] the Open ORA Workspace dialog box will appear. Navigate to the directory you want to save your workspace files to.

This Workspace can then be called up with the Load Workspace in a future session.

53 Caesar III

Caesar III is an software application for the design of decision making organizations at the operational and tactical levels; it takes into consideration cultural differences in coalitions and of adversaries. What follows in overview of how Caesar III and ORA can work together.

ORA can import data from Caesar III. See the Data Import Wizard for detailed instructions.

The Design View and Analysis View can be generated from a series of matrixes describing the communications among decision makers (agents). The goal should be producing the matrixes out of a social network. The analysis view has cognition aspects. The nature of a link is determined by the timing of communication during the decision making process.
Meta-Networks are generated by ORA. Then through Caesar III's Design and Analysis Views their structure is analyzed.

Reference at the George Mason University web site:
http://sysarch.gmu.edu/main/software/

Contact George Mason University at the above URL for instruction on downloading Caesar III data.

54 Command and Control
54.1 C2 Structure and Meta-Network

A Meta-network is a representation of a complex adaptive system. As such a system it has agents, expertise, resources and tasks. Inherent in this data, Meta-networks contain the C2 structure of an organization, which are the links of a social network among commanders represented in the following ways:

- Command chains
- Information sharing relations
- Result/response sharing relations

However, meta-networks may only have one commander-to-commander network without classifying the nature of links.

An analyst oftentimes needs a method to infer the nature of relations among commanders based on a given meta-network. That is where this tool can help.

ORA uses the task assignment and communication directions to infer the nature of a link.
54.2 C2 structure in CAESAR III

Design View and Analysis View can be generated from a series of matrixes describing the communications among decision makers (agents). The goal should be producing the matrixes out of a social network. The analysis view has cognition aspects The nature of a link is determined by the timing of communication during the decision making process.

54.3 Meta-Network

Network among people (, knowledge, resources, tasks, etc). Data for statistical analysis, not exactly an analysis tool. Reveal the organizational structure, influence propagation, command and control structure, etc. Widely used in organizational science, counter-terrorism, structure reformation, etc.

54.4 C2 structure extraction in ORA

ORA provides a function, Command and Control Structure Generator. Automatic generation of C2 structure based on a target task and a social network among decision makers. Generated influence network is directly loadable in CAESAR III. It is not a complete C2 structure but a reasonable inference (or approximation).

From the main menu select File ⇒ Command and Control Structure Generator. This brings up the Command and Control Structure Generator Wizard.

54.5 C2 Structure Generation Procedure

Determine a target task to analyze. Extract the task network of the target task. Extract the related (assigned) agents of the task network. The other agents are aggregated and represented as the outside world (IN and OUT). Regard the agent-to-agent network as a information sharing network. Determine the network level based on the link directions and network topology. Then, extract a command chain from links bridging different network level. Determine the result sharing requirement based on the task network (i.e. the link direction between the two tasks indicate the result sharing requirement) Then, create a result sharing network based on the requirements.
55 Extracting a Task Network for the Command and Control

What follows are procedures and an overview of extracting a task network for command and control analysis using ORA with Caesar III.

In a Meta-network, there are event-to-event networks and task-to-task networks contained in most data sets. We select one task to analyze and use this ORA tool to discover the steps needed for the task in question.

In the images below, we are extracting a task network needed for the bomb_preparation task node.

The idea is to find tasks should be completed to accomplish the objective, bomb_preparation (e.g., find the trace to a purchase_oxygen task. Provide_money → get_money → purchase_oxygen).
55.1 Assigned Agents

Identify the task network. Find all the assigned agents. Agents directly linked to a task in the task network.

55.2 Approximated Information Sharing Network

Just the agent-to-agent network in a meta-network.
55.3 Inferred Command Chain

Determine the network level. Find the inferred hierarchy of the organization. Find the command chain from the hierarchy.

Red arrows are command chains. Purple arrows are social network links.
55.4 Inferred Result Sharing Network

The task network defines the task prerequisites. Then, the result of a task should be informed to the agents doing the next task. Create a result sharing network by using the above inference rule.

Ahmed_ghallani should inform the result of purchase_oxygen to the agents doing bomb_preparation. Purchase_oxygen is a prerequisite of bomb_preparation.

55.5 Visualization by CAESAR III

Generated by ORA. Target task: surveillance. Design view and analysis view in CAESAR III.
56 Create Expected Interaction Networks

Below is an image of the Expertise Correlation tool in ORA and procedures on using the various options it contains:

![Expertise Correlation Tool](image)

Below are links to the Measures section pertaining to each Correlation.

Expertise Correlation… : Measures the complementarity of two agents based on their knowledge.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samanth</th>
<th>daniel_jackson</th>
<th>tealc</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.14285715</td>
<td>0.2857143</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>maj_samanth</td>
<td>0.14285715</td>
<td>0.0</td>
<td>0.2857143</td>
<td>0.14285715</td>
<td>0.14285715</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.16666667</td>
<td>0.16666667</td>
<td>0.0</td>
<td>0.16666667</td>
<td>0.16666667</td>
</tr>
<tr>
<td>tealc</td>
<td>0.0</td>
<td>0.14285715</td>
<td>0.2857143</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.125</td>
<td>0.25</td>
<td>0.375</td>
<td>0.125</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Similarity Correlation

Measures the degree of similarity between agents based on the number of knowledge bits they both have.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samanth</th>
<th>daniel_jackson</th>
<th>tealc</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>1.0</td>
<td>0.33333334</td>
<td>0.25</td>
<td>1.0</td>
<td>0.5</td>
</tr>
<tr>
<td>maj_samanth</td>
<td>0.33333334</td>
<td>1.0</td>
<td>0.25</td>
<td>0.33333334</td>
<td>0.0</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.25</td>
<td>0.25</td>
<td>1.0</td>
<td>0.25</td>
<td>0.0</td>
</tr>
<tr>
<td>tealc</td>
<td>1.0</td>
<td>0.33333334</td>
<td>0.25</td>
<td>1.0</td>
<td>0.5</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.5</td>
<td>0.0</td>
<td>0.0</td>
<td>0.5</td>
<td>1.0</td>
</tr>
</tbody>
</table>
Distinctiveness Correlation...: Measures how distinct are two agents based on the number of knowledge bits they hold oppositely.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samantha</th>
<th>daniel_jackson</th>
<th>tealc</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.22222222</td>
<td>0.33333334</td>
<td>0.0</td>
<td>0.11111111</td>
</tr>
<tr>
<td>maj_samantha</td>
<td>0.22222222</td>
<td>0.0</td>
<td>0.33333334</td>
<td>0.22222222</td>
<td>0.33333334</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.33333334</td>
<td>0.33333334</td>
<td>0.0</td>
<td>0.33333334</td>
<td>0.44444445</td>
</tr>
<tr>
<td>tealc</td>
<td>0.0</td>
<td>0.22222222</td>
<td>0.33333334</td>
<td>0.0</td>
<td>0.11111111</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.11111111</td>
<td>0.33333334</td>
<td>0.44444445</td>
<td>0.11111111</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Resemblance Correlation...: Measures the degree of resemblance between agents based on the number of knowledge bits they both have or both do not have.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samantha</th>
<th>daniel_jackson</th>
<th>tealc</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>1.0</td>
<td>0.77777778</td>
<td>0.66666667</td>
<td>1.0</td>
<td>0.88888889</td>
</tr>
<tr>
<td>maj_samantha</td>
<td>0.77777778</td>
<td>1.0</td>
<td>0.66666667</td>
<td>0.7777778</td>
<td>0.6666667</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>0.66666667</td>
<td>0.66666667</td>
<td>1.0</td>
<td>0.6666667</td>
<td>0.55555556</td>
</tr>
<tr>
<td>tealc</td>
<td>1.0</td>
<td>0.77777778</td>
<td>0.66666667</td>
<td>1.0</td>
<td>0.88888889</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>0.88888889</td>
<td>0.66666667</td>
<td>0.55555556</td>
<td>0.8888889</td>
<td>1.0</td>
</tr>
</tbody>
</table>

### 57 Create Stylized Networks

What follows are images of the Generate Networks menu in ORA. This tool is used to create Stylized Networks. Stylized networks are models built upon common network structures evident in many real world environments.

#### 57.1 Create Erdős-Rényi Network

A model for generating random graphs by setting an Link between each pair of nodes with equal probability, independently of other Links.
57.2 Create Core-Periphery Network

The core-periphery structure of the network has a dense central core of key agents and a large periphery of marginal agents.

The core-periphery structure is an ideal typical pattern that divides both the rows and the columns into two classes. One of the blocks on the main diagonal (the core) is a high-density block; the other block on the main diagonal (the periphery) is a low-density block. The core-periphery model is indifferent to the density of ties in the off-diagonal blocks.

When we apply the core-periphery model to actor-by-actor data (Core/Periphery), the model seeks to identify a set of actors who have high density of links among themselves (the core) by sharing many events in common, and another set of actors who have very low density of ties among themselves (the periphery) by having few events in common. Actors in the core are able to coordinate their actions, those in the periphery are not. As a consequence, actors in the core are at a structural advantage in exchange relations with actors in the periphery.

57.3 Create Scale-Free Network

Some nodes act as highly connected hubs (high-degree), although most nodes are of low degree. Scale-free networks' structure and dynamics are independent of the system's size N, the number of nodes the system has. In other words, a network that is scale-free will have the same properties no matter what the number of its entities is.

Their most distinguishing characteristic is that their degree distribution follows a power law relationship, \( P(k) \sim k^{-\gamma} \),

\[ P(k) \sim k^{-\gamma} \]

Where the probability \( P(k) \) that a node in the network connects with \( k \) other nodes was roughly proportional to \( k^{-\gamma} \), and this function gave a roughly good fit to their observed data. The coefficient \( \gamma \) may vary approximately from 2 to 3 for most real networks.

57.4 Create Cellular Network

57.5 Create Lattice Network

A Lattice Network is a large-world network

A graph in where nodes are placed at the integer coordinate points of the n-dimensional Euclidean space and each node connects to nodes which are exactly one unit away from it. (i.e. if the lattice is two dimensional and the length of the lattice is 2 along the first and 2 along the second dimension, then it has 4 nodes and they're placed at coordinates (1,1), (1,2), (2,1), (2,2)) The two nodes are connected if the difference of one of their coordinates is one or minus one and all their other coordinates are exactly the same.
57.6 Create Small-World Network

A type of graph in which most nodes are NOT neighbors of one another, but most nodes can be reached from every other node by a small number of hops or steps. A small world network, where nodes represent people and links connect people that know each other, captures the small world phenomenon of strangers being linked by a mutual acquaintance.

The small-world behavior is characterized by the fact that the distance between any two inks is of the order of that for a random network and, at the same time, the concept of neighborhood is preserved.

A Small-World Network is a regular network with a degree of random long range connections. It is rarely disrupted by the elimination of one node.

57.7 Fixed Degree-Distribution Network

A random graph is constructed by specifying as input: (a) the number of nodes in the network, and (b) the number of links for each node. The graph is random according to the input, however it should be noted that not all degree sequences are illogical so this algorithm may produce an empty graph as a result.

58 Fixed Degree-Distribution Network

Below are procedures for using ORA’s Create Fixed Degree Distribution Network tool. This tool creates a random graph constructed by specifying as input: (a) the number of nodes in the network, and; (b) the number of links for each node. The graph is random according to the input, however it should be noted that not all degree sequences are illogical so this algorithm may produce an empty graph as a result.

Create Fixed Degree Distribution Network

Set the options below to create a Fixed Degree Distribution network.

- Allow self-loops:
- Construct directed-tie network:
- If Directed, then count is inbound, else outbound:
- Degree List (Comma seperated values; no format):

The input for the degree sequence is a comma delimited list of the number of edges. Correspondingly, the number of nodes is determined by the number of parameters entered.
To facilitate simplified entry, a shortcut can be made by specifying the number of nodes at a specific number of edges. Further, the node id in the generated graph will correspond with the position in the input string.

Degree sequences that are illogical will be impossible to generate, e.g., 2@20 (two nodes with 20 ties each; impossible because the maximum ties a node can have in this network of size two is 1 tie.) Further, some networks can be difficult to produce due to the specific degree distribution and the random process used to construct the network, so the algorithm is designed to make up to 10 separate attempts at constructing the exact distribution. After 10 attempts, the algorithm will return the error meta-network. The user may chose to resubmit the same request for another up-to-10 attempts at making the network.

For example, the following are valid input strings (with self-loops off and undirected):

- 1,5,3,0,1 - produces a 5 node network with one isolate and 2 pendants, etc.
- 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes with 2 edges.
- 10@5,10@3 - will produce a 20 node network

The following are valid input strings but illogical:

- 100,0,1 - is illogical and will produce a null meta-network named with an error message
- 3@2,1 - is illogical and will produce a null meta-network named with an error message
- 10@5,10@3,1 - is illogical will produce a null meta-network named with an error message

58.1 Input Fields:

Allow self-loops:
- Checked: allows the generation of a node tied to itself
- Unchecked: disallows the generation of a node tied to itself

Construct directed-tie network
- Checked: generates directed network
- Unchecked: generates an undirected network

If directed is inbound specified, else outbound is specified
- Checked: the degree list is incoming ties
- Unchecked: the degree list is outgoing ties

Degree list:
- Enter the degree listing – in the desired node order.
59 Generate Networks

Below is an image of the Generate networks menu, accessible from ORA’s main title bar menu. Further below are descriptions of the various tools available to Generate Networks. This tool is used to generate networks, often stylized networks, according to predefined algorithms.

### Influence Network Generator

Used to create an Influence Network file for use in the external program Pythia.

### Command and Control Structure Generator

Used to create Network files for use in the external program Caesar III.

### Generate Inferred Links

Uses existing links to infer connections where data is incomplete or missing. *For instance, if Node A is two paths removed from Node C and Node C is only connected to Node B, it could be inferred that Node A has a path to Node B.*

### Randomize Existing Networks

Scrambles the links of a graph. Randomize Networks is run on the same Network multiple times in order to help determine if existing Network is random or not.

### Create Stylized Network

Generates new Networks using various Mathematical formulas including Erdős-Rény, Core-Periphery, Scale-Free, Cellular, Lattice, and Small-World Networks.

### Create Expected Interaction Network

Predicts the expected interaction of a network given known tasks and other available network data.

### Construct Trailset

Used to create a data set to be used within the View Trail Set function. A Trail is a set of nodes and links that form a single unbroken chain, such that no node or link is repeated.

60 Influence Network Generator
This tool takes a meta-network and generates an influence network that is readable by Pythia. Pythia (GMU) takes an influence net and reasons about it. ORA can generate influence nets for Pythia from meta-networks. ORA can read in a Pythia influence net and assess its structure. When ORA generates an influence network, the user then has to work with Pythia and a SME to get the probability distributions to make sense. Basically by inferring the influence network from the meta-network via ORA you save a lot of the startup time in building an influence network.

ORA provides a function, the Influence Network Generation. This function is used in conjunction with the external program Pythia. More information about the Pythia program can be found at:

An Influence Network is a hypotheses regarding tasks, performance, event happening, and related events. This functions covers how to generate an influence network from a social network using ORA and examines the probability of event happenings based on the state and influence of supporting nodes.

The file generated by this function is directly loadable in Pythia. It is not a complete influence network and the user will need to make adjustments to the generated networks. It uses basic ontological* interpretations and inferred baseline probabilities where the user specifies positive/negative probability.

We create an influence network based on: Extracting a task network which directs the target task to analyze. Then examine the complexity, importance, personnel/resource/expertise assignment of the tasks.

The examinations become influence network nodes containing ontological interpretation when: The task is done — the task is complex — the task is important — there are sufficient actors associated with the task — resources are available — expertise is available.

Then links are created as in the task network and background hypotheses nodes link to a task node.

60.1 Running the Routine

From the main menu select File => Influence Network Generator…. This brings up the Influence network step by step creation dialog box. There are three options: Task Based, Event Based, and Belief Based. This example will follow the Task Based function. Each function contains similar step dialog boxes.
Select [Next] to continue.

Step 1: In the header bar it shows which function you're chosen and the number of steps involved. It also tracks which step you're currently on. From the dropdown menu select the task to be analyzed. The positive/negative influence values from task to task can be adjusted. Then select [Next].
Step 2 : Settings for the Threshold of personnel, the positive/negative influence of the links and Heuristics* settings determining Baseline probability.

Step 3 : Settings dealing with the Complexity of the personnel, expertise, and resources, the positive/negative influence of the links and Heuristics* settings determining Baseline probability. The parameters for complexity can be adjusted.
Step 4: Settings dealing with the Out-Degree and Betweenness of the task, the positive/negative influence of the links and Heuristics* settings determining Baseline probability. The parameters for complexity can be adjusted.

Step 5: Settings dealing with the Resources directly linked to task or assigned to personnel, the positive/negative influence of the links and Heuristics* settings determining Baseline probability.
Step 6: Settings dealing with the Expertise directly linked to task or assigned to personnel, the positive/negative influence of the links and Heuristics* settings determining Baseline probability.

Step 7: Displays the results before saving the file. When ready, select the [Convert] button.
Navigate to your selected directory, give it a filename and select [Save].

The two other functions are Event Based (14 steps) and Belief Based (3 steps). Both of these follow the same procedure of setting you parameters and saving the file for use in Pythia.

61 Extracting a Task Network for the Influence Network Generator

What follows are procedures to extract a Task Network for the Influence Network Generator.
In a Meta-Network there is an event-to-event network and a task-to-task network. Choose one task to analyze.

Here we look at bomb preparation. Find the tasks that need completed to accomplish the objective. Then trace from provide_money, get_money, purchase_oxygen.

The complexity of the task depends on three items. Resources / Expertise required and number of person required.

- **Very Low** (default baseline=1.0): 0 resource/expertise required / 1 person required.
• Low (default baseline=0.9): 1 resource/expertise required / Less than 3 persons required.
• Medium (default baseline=0.8): Less than 4 resource/expertise required / Less than 4 persons required.
• High (default baseline=0.7): Less than 8 resource/expertise required / Less than 7 persons required.
• Very High (default baseline=0.6): More than 7 resource/expertise required / More than 6 persons required.
The importance of the task is determined as using standardized degree centrality and betweenness (ranging (0~1):

- Very Low (default baseline=0.4): Not connected to other tasks
- Low (0.5): Low out-degree density and low betweenness in task network
- Medium (0.6): Medium out-degree density and low betweenness in task network
- High (0.7): High out-degree density or medium betweenness in task network
- Very High (0.8): High out-degree density in task network

The actor assignment of the task is determined if sufficient actors are associated with the task.

- No personnel (default baseline=0): No assigned actors
- Insufficient (0.25): Only 75% of resources/expertise are covered by assigned actors.
- Almost sufficient (0.5): More than 75% of resources/expertise are covered by the assigned actors.
- Sufficient (0.7): At most one person associated with each resource and each expertise connected to the task.
- More than sufficient (0.8): More than one person associated with some resources and expertise connected to the task.
Resource / Expertise availability
Finds if Expertise and Resource are directly accessible. The availability is determined as follows:

- Redundantly available/accessible baseline probability=0.75): More than one person with the expertise associated with the task.
- Available/accessible (0.6): One person with the expertise/resource is associated with the task.
- Unavailable/inaccessible (0.25): No person with the expertise/resource is associated with the task.

62 Pythia

Pythia is a timed influence net application. Conversely, data from Pythia can be loaded into ORA using the Data Import Wizard.

In conjunction with the Pythia application from George Mason University, data from ORA can be loaded into Pythia to create organizational displays.

What follows is a brief example of creating an organizational display using ORA with Pythia.

Start from an ORA Task Network (shown below)
The data can be loaded into Pythia to create an organizational display.

Reference at the George Mason University website: http://sysarch.gmu.edu/main/software/

Contact George Mason at the above URL for instructions on downloading Pythia and additional instructions on how to use the tool.

63 Randomize Existing Network

What follows are procedures for randomizing an existing network.

Note: This is commonly done to test a hypothesis about a given network. If after conducting experiments, there is no significant difference between a hypothesis and a random graph, the evidence supporting the hypothesis could be weak.

A random graph* is obtained by starting with a set of n nodes and adding Links between them at random. Different random network models produce different probability distributions on networks.

The theory of random networks studies typical properties of random networks, those that hold with high probability for networks drawn from a particular distribution. For example, we might ask for a given value of n and p what the probability is that G(n,p) is connected. In studying such questions, researchers often concentrate on the limit behavior of random networks—the values that various probabilities converge to as n grows very large. Percolation theory* characterizes the connectedness of random networks, especially infinitely large ones.
Random networks are widely used in the probabilistic method, where one tries to prove the existence of networks with certain properties. The existence of a property on a random network implies, via the famous Szemerédi regularity lemma, the existence of that property on almost all networks.
63.1 Creating a Random Graph

This function randomizes the Links in a Network.
From the menu select Generate networks => Randomize Existing Network

The dialog box and form the drop down menu select the Network you want to randomize.

In left side panel a new Network will appear named after the selected Network and denoting it has been randomized.

First, return to the original Network and select one of the Networks such as the agent x agent.
Then select the Visualize Only this Network.
You will get a visualization of the agent x agent Network.

Now select the newly created randomized Network you just created. Select the same agent x agent graph as per the original Network.

And again, select the Visualize Only this Graph.
As shown in the Visualizer the links have been randomized.

![Network Diagram]

64 Construct Trail Set

What follows are procedures for Constructing a Trail set in ORA. The Construct Trail set is used in conjunction with the Loom function. A Trail set is a set of nodes and links that form a single unbroken chain, such that no node or link is repeated. This function will take any Network and form a new Network usable by the Loom function.

From the main menu select Generate Networks => Construct Trail set
This will automatically create a new Network form the selected graph.

Now you can use this new Network in the Loom function.

65 Attributes

An attribute* is an extra container that can be attached to an Meta-Node. You can add a value to this container. To add an attribute to an Meta-Node right-click on the Meta-Node name. This will bring up the contextual menu below.

65.1 Add Attribute

Type in the name for your new attribute and select [OK]. Let's say we want to add other languages spoken by the nodes.

The attribute you added will be inserted alphabetically in the editor.

You can now assign any text to this attribute for any of the rows in the Network which can be used later to help define your Network.
65.2 Add attribute (second option)

There is a second way to add attributes in the Editor tab. Below the matrix is a section called Attributes which contains two buttons, [Create] and [Delete].
Selecting [Create] brings up a dialog box and asks you to input the name for the new attribute.

![Input dialog box](image)

The new attribute is then inserted within the matrix.

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>pivot_point</th>
<th>order</th>
<th>where</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;set filter&gt;</td>
<td>&lt;set filter&gt;</td>
<td>&lt;set filter&gt;</td>
<td>&lt;set filter&gt;</td>
</tr>
</tbody>
</table>

65.3 Delete Attribute

And attributes can be removed just as easily by pressing the Delete button. The dialog box will present you with a dropdown menu where you can choose which attribute to delete.

![Delete attribute dialog box](image)
65.4 Import Attribute

The [Import] button allows for the quick importing or an attribute(s) through the Editor panel. Use a .csv file with rows as nodes and columns as attributes. This can be done with, or without, an ID column.

1. Use the Textbox and Browse button to navigate to the csv file with the new attribute(s).
2. Select the radio button to use either 1) an ID column, or 2) a file in the same order as NodeSet.
3. This section contains all the attributes in the file. If one was chosen to identify the NodeSet then it will be grayed out. For attributes NOT grayed out you can chose to make then Categorical* or Continuous*.
4. Select All / Clear All buttons places a checkmark in all columns or removes same.
5. Placing a checkmark in the Create new nodes for unrecognized nodes creates new nodes into the select NodeSet if no node for an attribute currently exists.
6. Import / Cancel tells ORA to begin the import or cancel the operation.
66 Contextual Menus

What follows are descriptions and images relating to the contextual menus in ORA. Right-clicking on any Meta-Network, NodeSet, or Network brings up a contextual menu with the functions available with each.

The first four are self-explanatory. Transform… opens up the Meta-Network Transform… dialog box.

The first two are self-explanatory. Add Attribute … opens up the attribute function in order to add attributes to a Node Set.
The first two are self-explanatory.

- **Set Diagonal…**: Used on a square network to set cells 1,1 through x,x to the same value. In binary view the choice is 1: True (+1) 2: True (-1) 3: False (0). In numeric view you can put any value into the diagonal.
- **Fold Network…**: This function creates a new network using matrix algebra. Below are four variations of a four x four network and the results when each is folded.

<table>
<thead>
<tr>
<th>Knowledge_1</th>
<th>Knowledge_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Knowledge_1</th>
<th>Knowledge_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Knowledge_1</th>
<th>Knowledge_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>1.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Knowledge_1</th>
<th>Knowledge_2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

- **Save Network…**: (also called Exporting a Network) Any network can be saved individually to a file in one of the following formats: CSV*, DL, DyNetML*, or UNCINET (.##h). Also check File Formats for more information.
- **Binarize Network**: Turns all non-zero numbers to [1] and leaving all [0] untouched.
- **Remove Links…**: Removes links in accordance to the selection in the dropdown menu (as seen in the images below).

- **Symmetrize…**: 
67 Contextual Menus - Multi Files

Includes: *Union Meta-Networks, Intersect Meta-Networks, Conform Meta-Networks*

There's also a separate contextual menu when you've got two or more Meta-Networks selected. Open up multiple Meta-Networks in the Main Interface. Load two or more files into Panel 1. We'll demonstrate this on two Meta-Networks containing Bob, Carol Ted, & Alice. The agents are identical but the tasks in each are different, except for driving which appears in both and has slightly different values. Between the time of cooking In and eating Out Alice's feelings for Ted have grown.

**Cooking In** and

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>set filter</td>
<td>set filter</td>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
<tr>
<td>shopping</td>
<td>chief_cook</td>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
</tr>
<tr>
<td>walker</td>
<td>busboy(girl)</td>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>sous_chef</td>
<td>driver</td>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>set filter</td>
<td>set filter</td>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
<tr>
<td>cooking</td>
<td>eating</td>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
</tr>
<tr>
<td>cooking</td>
<td>eating</td>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>cooking</td>
<td>eating</td>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
</tr>
</tbody>
</table>

**Eating Out**
Highlight both of them by holding down the [Control] while clicking on each file. Then Right-click on one of the files. This brings up the contextual menu.

```
Meta-Network Manager
+ bcta_cookingIn
+ bcta_eatingOut
```

The Add New MetaNetwork & Remove Selected Meta-Network are self-explanatory. The Union Meta-Network will create a new Meta-Network using one of five actions: sum, binary, average, minimum, or maximum.

- Sum : In any identical network all values from all networks are added together. (i.e. bob’s score of 4.0 in both meta-networks are added together for a total of 8.0).

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>8.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>8.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>2.0</td>
<td>3.0</td>
<td>0.0</td>
<td>4.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>8.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

- Binary : Then in the binary option it doesn't matter what numbers appeared in either meta-network as it uses only 1 or 0 as a result. If any cell has a non-zero it will contain a 1 as a result.
Average: This option takes the sum of all identical cell values and divides them by the number of cells used. In cookingIn ted x Alice contained a 2 while in eatingOut the value for x Alice was a 1. This was averaged out to 1.5.

```
<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
```

- minimum: This function finds the smallest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x Alice both cells use the smaller value of "1" even though they are from different meta-networks.

```
<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
```

- Maximum: This function finds the largest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x Alice both cells use the larger value of "2" and "3" respectively, each taken from a different meta-network.

```
<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>3.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
```

Intersect Meta-Network works similar to the Union function and has the same five options. But in creating the new Meta-Network only nodes that appear in all Meta-Networks are carried over to the new Meta-Network.

For example: All four agents appear in both Meta-Networks and are brought over into the new Meta-Network. But though there were six tasks in the cookingIn and three tasks in eatingOut there is only one task (driver) in the new Meta-Network created from the intersect function. Only nodes found in all Meta-Networks are brought over.
INTERSECT minimum
- agent [size 4]
- jobs [Task] [size 1]
- bobCarolTedAlice [agent x agent]
- agent x jobs [agent x jobs]
And even though bob has a value for driver in cookingIn only carol has a value for driver in both Meta-Networks.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
<td>bob</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
<td>carol</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>1.0</td>
<td>ted</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>alice</td>
</tr>
</tbody>
</table>

Conform Meta-Network alters the selected Meta-Networks and makes them equal. union adds nodes that are found in one Meta-Network but not the other. intersect removes nodes that are not common to both.

**68 Creating A Network From An Excel Spreadsheet**

If you don't have a Network, you can create one from scratch. Below is step-by-step instruction on how to do this in ORA.

We will create an square, agent-by-agent Network. We say it is square because all row headings correspond directly to column headings. This is important as it relates to specific measures ORA can run on a graph. If the graph is not square, some measures will not work.

Open a blank Microsoft Excel work book. In column A we will enter the name of all the nodes that make up our social network or organization.

68.1.1 NOTE : When creating your spreadsheet, do not add any additional titles, notes, or other headings, which will interfere with the "square" properties of the Network.

Next, create column headings using the correlating names as they appear in row headings. Again, this will ensure that our Network will be square.
Next we will create links between each agent. We do this by entering a 1 if a direct connection or relationship exists and a 0 if it does not. Please note that headings that cross-reference themselves are considered redundant and thus are left blank or 0.

In the example below, Redundant cells are filled in with red strips to illustrate the self-loops. This redundancy should continue as a smooth diagonal line from the top left corner of your Network to the bottom right.

68.1.2 NOTE: If you don't end up with a diagonal line then your graph is not square.

Using 1s and 0s to establish link, complete your spreadsheet.

In the Network example, we have assigned links randomly. Within your organization or network, however, you can describe any direct connections or relationships you are interested in analyzing. For instance, you may determine that a direct connection exists if agents within your network consult with each other at least once a month; literally, it can be anything you decide.

Below is our completed Network (The red fill illustrates cells that do not require input due to their redundancy*).

Now that we have essentially built a Network from scratch using Excel, the next step is to save it in a compatible file format ORA can interpret. For Excel spreadsheets this will be the CSV* file format.

From the main menu select File => Save As
Make sure you save this file as a CSV (comma delimited)
You have now created a Network from scratch which can be loaded into ORA.
Now return to ORA and load up your new Network. Below is our new Network rendered in the ORA Visualizer. Notice the arrows only point from one node to another if there is a 1 in the column for a particular node. i.e. There is a "1" in the bob column for ted but a "0" in the ted column for bob. So an arrow points from ted to bob but NOT from bob to ted.

For a more in-depth explanation for creating Meta-Networks see the lessons section under Meta-Network.

69  Find
69.1  Find a Sub-set within a NodeSet

What follows are procedures for using the Find feature in ORA. By using the Find: textbox and the AND/OR selector you can display only the nodes you want to work with. This works by searching for Sub-Strings within the values.

69.1.1 NOTE : A search for "male" will find all values of "male" as well as "female" because "male" is a sub-string of "female".
Here is the whole NodeSet with only the gender and race attributes displayed. The AND/OR toggle is in its default AND setting.

First female is typed into the textbox and ORA will display all nodes where gender=female.
Next tauri is typed into the textbox (make sure there's a leading "space") and ORA will now only display nodes with gender=female and race=tauri.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>gender</th>
<th>race</th>
</tr>
</thead>
<tbody>
<tr>
<td>A02</td>
<td>maj_sam..</td>
<td>female</td>
<td>tauri</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
<td>female</td>
<td>tauri</td>
</tr>
</tbody>
</table>

But if the AND/OR setting is switched to OR the NodeSet who display everything with EITHER gender=female OR race=tauri.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>gender</th>
<th>race</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
<td>male</td>
<td>tauri</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam..</td>
<td>female</td>
<td>tauri</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
<td>male</td>
<td>tauri</td>
</tr>
<tr>
<td>A07</td>
<td>ren'ald</td>
<td>female</td>
<td>tokra</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
<td>female</td>
<td>tauri</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
<td>male</td>
<td>tauri</td>
</tr>
<tr>
<td>A11</td>
<td>gen_ham..</td>
<td>male</td>
<td>tauri</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
<td>female</td>
<td>gou'ald</td>
</tr>
</tbody>
</table>
70 Hovering

Hovering the pointer over various parts of the panels will reveal information about the Meta-Network.
Hovering over the parts in Panel 1 will reveal different information about the Meta-Networks, Meta-Nodes, and Networks.
Info Tab - Network

When a Network is selected there are also two tabs, Info and Editor. The Info tab contains a textbox, Network ID in which you can change the name of any network, The Source and Target Node sets, and whether this network is directed or not, the Link Count, and the Density.

The two buttons underneath allow the choice of Visualize this Network which will send the entire Meta-Network to the Visualizer or Visualize Only this Network which display only the currently selected Network. Below is an image of Info Tabs and Editor Tabs in ORA.

The Editor tab has two views: Binary and Numeric. Binary view is used when you only need to establish a connection between two nodes with no weights. It's a simple Yes or No arrangement.
The Numeric view allows you to treat links between various nodes with more or less importance. Notice that all the row nodes have a check marked connection to the column containing [yu] in the binary mode. This denotes they know one another. But in the numeric mode this value is a 0.5 which is used to denote previous acknowledgement but is an adversary.

72 Info Tab - NodeSet

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to display information regarding the Meta-Networks, NodeSets, and Networks. But this is the area where you can rename the Node Class ID and the Node Class Type. Place the cursor in the box, make sure the entire name is highlighted, and type in your new name. This area also gives you the Node Count of the selected Node Set as well as the Attribute Names contained within the NodeSet.
The Editor tab contains most of the editing functions.

1. The Search box for finding particular node(s) in a set.
2. The <set filter> for displaying only a particular sub-set of node(s).
3. The Checkboxes to designate which nodes to Delete or Merge.
4. The Nodes buttons: Create, Delete, Merge, and Clean.
5. The Attributes buttons: Create, Delete, and Import.
6. Use the Select/Clear buttons to place, or remove, all checkmarks from section 3.
73 ORA's Main Interface

The ORA interface is organized into three resizable window panes. Panel 1 contains a tree directory of the current Meta-Network(s) loaded into ORA. This contains the Meta-Networks currently active plus all their Meta-Nodes and Networks. Panel 2 contains the basic information about the highlighted Meta-Network such as how many nodes are represented. This panel also allows quick access to ORA's Visualizer, Reports and Chart tools. By selecting the Visualize button, the currently loaded Network will render in the ORA Visualizer, which will load in a separate window. Panel 3 is empty when ORA is first started up. It will contain any reports that you run. All three Panels can be resized to your preference.
73.1 Panel 1

Panel 1 contains all the Meta-Networks you currently have active. Clicking on the plus icon will expand the Meta-Network showing all the Meta-Nodes and Networks and clicking on the minus icon condenses the Meta-Network.

And if you hover the pointer over a graph it will display information about that Network.

73.2 Panel 2
73.3 With Meta-Network selected

Panel 2 displays the information regarding the Meta-Network itself.

1. Name of the active Meta-Network: You can also use this textbox to change the name of the Meta-Network.
2. Currently selected Meta-Network showing it's pathway.
3. Node Class Count: How many Meta-Nodes are contained with the Meta-Network.
4. Node Count: Total number of nodes within the Meta-Network.
5. Link Count: Total number of links within the Meta-Network.
6. Network Count: Total number of graphs within the Meta-Network
7. Total Density.

### 73.4 Editor Tab with NodeSet selected

When a NodeSet is selected changes can be made.

![Node Class: Agent](image)

The Nodes buttons allow you to search for particular nodes using the Find: box and And/or criteria - Add, Delete or Merge Nodes - Add, Delete, or Change Attributes. Further information can be read regarding the Tabs in Panel 2.
73.5 Editor Tab with Network selected

Further information can be read regarding the Tabs in Panel 2

73.6 Panel 3

Panel 3, which at the start is blank, will contain any reports that are run on the Meta-Network. See Generate Reports for more information.

74 Main Interface Tasks

There are a number of tasks that are performed from within the Main Interface to assist in controlling your Meta-Networks, NodeSets, and Networks. These functions are not associated with any of the Menu Items. For example, renaming Meta-Network, tool tips displayed while hovering, and creating and deleting Nodes & Attributes.

75 Create a New Meta-Network

What follows are procedures for creating a new Meta-Network. There are times you need to run measures on or visualize only part of an existing Meta-Network. This section will show you the easy way to create sub-sets of an existing Meta-Network.

First duplicate the Meta-Network. Highlight the Meta-Network then from the main menu select Edit ⇒ Copy Meta-Network. Then from the main menu select Edit ⇒ Paste Meta-Networks. It would be a good idea to rename this new Meta-Network immediately so as to not get it confused with the original. You can do this in the Editor tab, see Renaming.
Next, expand the Meta-Network you want by clicking the [+] if it isn't expanded already. Highlight the Node Set with the nodes you want to remove.

In panel 2 select the Editor tab which brings up the matrix with nodes on the vertical and attributes on the horizontal. Below each attribute is a <set filter>. Below left is the stargate_summit meta-network along with the ally attribute. I wish to make a new meta-network of the good guys only. In the dropdown menu under ally I select no. These are the nodes I want to remove.

Place a checkmark in the box of each node. Below the matrix in the section called Nodes are three buttons. Click the [Delete] button. The Node Set now contains only the nodes that had yes in the attribute ally.

With this same procedure I created a Meta-Network of only the allies.
76 Node Buttons

What follows are images and descriptions of some common button items and other interface elements in the ORA GUI.

76.1 Creating Node

Highlight a NodeSet where the node is to be added. Click [Create].

You will be prompted to input the number of new nodes you want to create in the NodeSet. Input the number of nodes to add and select [OK] and the new node(s) will appear at the bottom of the Node Set. The new node can then be renamed by clicking inside the cell.

76.2 Delete Node

To delete a node from a NodeSet place a checkmark in the box(es) to the left of the node(s) and select [Delete]. Select [OK] and all nodes with checkmarks will be deleted from the NodeSet.

76.3 Merge Nodes

The Merge button combines the links and attributes of the selected nodes and creates a merged or combined node. The nodes that were merged are removed, and replaced with the combined node. Used primarily when data needs to be consolidated.

Example: You have two nodes, jack and col_o'neill. These are actually the same person. Merge will combine their information into one node which could be named col_jack_o'neill.
Place checkmarks in the rows of the nodes you want to merge.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>position</th>
<th>leadership</th>
<th>gender</th>
<th>race</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack___</td>
<td>sg-1</td>
<td>male</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam__</td>
<td></td>
<td>female</td>
<td>tauri</td>
<td></td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac</td>
<td></td>
<td>male</td>
<td>tauri</td>
<td></td>
</tr>
<tr>
<td>A04</td>
<td>tealc</td>
<td></td>
<td>male</td>
<td>tauri</td>
<td>affa</td>
</tr>
<tr>
<td>A05</td>
<td>jack</td>
<td>sg-1_leader</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

From the drop down menus select the ID and Title to used for the merged node.

And one node emerges with the attributes from both nodes.

76.4 Clean Nodes
### 77 Renaming

#### 77.1 Renaming Meta-Networks, Meta-Nodes, and Networks

Below are procedures for rename a Meta-Network, Meta-Node, and/or Networks. This helps makes the information clearer for you. Below I renamed one of the Meta-Nodes to those guys and also renamed the type to who?. You can see how it's reflected throughout the entirely of panel 1. So you can rename any Meta-Node in a Meta-Network for better readability.

<table>
<thead>
<tr>
<th>Node Class ID</th>
<th>Node Class Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>agent</td>
</tr>
<tr>
<td>sg1_universe</td>
<td>agent</td>
</tr>
<tr>
<td>stargate_summit</td>
<td></td>
</tr>
<tr>
<td>- [agent] size: 30</td>
<td></td>
</tr>
<tr>
<td>- [event] size: 8</td>
<td></td>
</tr>
<tr>
<td>- [faction] size: 9</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Node Class ID</th>
<th>Node Class Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>those guys</td>
<td>agent</td>
</tr>
<tr>
<td>sg1_universe</td>
<td>agent</td>
</tr>
<tr>
<td>stargate_summit</td>
<td></td>
</tr>
<tr>
<td>- [agent] those...</td>
<td></td>
</tr>
<tr>
<td>- [event] size: 8</td>
<td></td>
</tr>
<tr>
<td>- [faction] size: 9</td>
<td></td>
</tr>
</tbody>
</table>

### 78 Procedure for adding a URI to launch a document from inside ORA's Visualizer

The following instruction demonstrates how to add a "document" attribute type to a Meta-Node and thus link with a URI so that a document can be launched from inside ORA.

First, load a Meta-Network into ORA. In this example we are going to be using the SG1 sample data set included with your installed copy of ORA.
Expand the Meta-Network in the Meta-Network Manager Pane. Then, right click an Node class (in this example we will use the agent), access the submenu and then select "Add Attribute."
Using the drop-down menu select, choose "document" from the list of available options (screen shot below):

You will see the "Create New Attribute" box appear. Type a name in the "Name" field for the document attribute you are adding.
In this example we are going to use the name Stargate Secret Terminology Document. You will see in the following screen shot, that the node title is now change to the name we specified in this field.

Once the node title has been changed, you can now enter a URI directly inside the corresponding blank field. In the following example we will enter a URI that is an absolute pathway to a document on the user's hard drive and then we will enter a web URL, which will launch the home page of Goggle in a browser window.

*Note: Using a absolute path, such as a pathway to a document that exists only one particular computer will not work when the data set is run on another computer and that pathway (hence document) is no longer available. For the greatest flexibility then it would make sense to URIs that are URLs, which will take the user to a document or web page on the World Wide Web that might serve as a document repository.*
Now, let us visualize our MetaNetwork.
Here we can see this node now has a URI associated with it. We can even see the attribute title as well although in this example it is truncated due to the length of the title. To actually launch this URI, right click on the node again to get the following menu:

In this example, a windows explorer is launched and the document contained in teh folder is displayed.
78.1 Adding Multiple URIs/URLs

You are now allowed to have more than one URI per node. Please note however that while the right-click menu can still be used for adding/accessing URIs, the preferred method is now via the Node Status window.

There’s a new URI tab that allows you to view URI’s, launch them, and add new ones. When adding new ones, the current convention is to create a new Attribute with name “URI-X”, where X is the earliest number that doesn’t already exist. So, adding a URI to nodes will create results such as “URI-1”, “URI-2”, etc. Currently, when finding URI’s to launch, only those that follow the above convention are included, but it will be expanded to include any attribute with URI or URL in it anywhere.

78.2 Related content...

- Attributes
- The Document Attribute
79 Visualize Buttons

There are two Visualize buttons and they work slightly different.

The Visualize this Network visualizes the chosen Network. In the Legend dialog box all NodeSets and Link Sets are available.

The Visualize Only this Network visualizes the chosen Network. But in the Legend only the NodeSet and Link Set chosen are displayed. This is a much quicker means to display a Network. ORA only makes computations for the chosen Network.
80 Edit Menu

Below is an image of the Edit Menu.

![Edit Menu Image]

81 Edit Menu

Below is an images of the Edit Menu in ORA. What follows are descriptions of the various sub-menus accessible by the Edit Menu.

Copy Editor Values / Paste Editor Values
Used to transfer information between Meta-Nodes. The Meta-Nodes created can be identically sized (allowing you to paste an entire column in) or a smaller, subset allowing you to choose only a portion of the original set.

Copy Meta-Network / Paste Meta-Network

Used for quickly creating duplicate Meta-Networks. When you first start the program the Paste Meta-Networks is grayed out. It will only become active once you've used the Copy Meta-Network menu item.

Preferences

Contains settings for controlling the environment for working within ORA.
## File Menu

Many of these options are more fully covered in Lesson 2 - Load and Save Data

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Data Management</th>
<th>Generate Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Meta-Network…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Import Wizard…</td>
<td>Ctrl+O</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Database…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import CASOS Database…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Workspace…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CEMAP Parser…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Meta-Network…</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Meta-Network As…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Workspace</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Format Converter…</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Open Meta-Network…**

Open Meta-Network opens a single Network with the following formats:
- Dynetml* (the native ORA xml format), .dl, .##h (UCINet), .csv* (comma separated values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml*, .stl* (GMU model), .lo (pathfinder)

**Data Import Wizard…**

Data Import Wizard contains additional options for importing Networks such as multiple file importing.

**Import Database…**

Import Database is an advanced feature for importing a database.

**Import CASOS Database…**

**Import Attribute File…**

The Import Attribute File is used to add an attribute into a file. The file selected must be in the .csv format.

**Import AutoMap Thesaurus File…**

Import a file created in AutoMap.

**Open Workspace…**

Open Workspace allows you to open an entire workspace that you were previously using. A workspace consists of a set of Meta-Networks that were all open at the same time, and saved as a workspace.

**CEMAP Parser…**
Save Meta-Network

Initially this item is grayed out. Save Meta-Network only becomes active when you've made a change to a Network. You can use it as an indicator whether you've made a change to the active Meta-Network. Notice as you highlight each Meta-Network the icon in the toolbar will be grayed out (no changes) or colored (changes made to that Meta-Network).

Save Meta-Network As…

Save Meta-Network As… save the changes you've made in a Meta-Network under a new filename.

Save Workspace

Save Workspace save the active Meta-Networks into a Workspace which can be opened up at a later date.

Network Format Converter…

Network Format Converter takes files from one format and convert it to an ORA format.

CSV Table Converter…

CSN Table Converter convert a .csv* file into an ORA format.

Exit

Close the program and leave

83 Chart Menu

Below is an image of the Chart Menu in ORA.

- New Chart Window … :Opens a new window for charting a separate Node Set.
- Save Chart Image … :Saves the currently displayed chart as a .png file. You will be asked to navigate to the directory of your choice.
- Close Window :Closes the window.
Measure Charts

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map. ORA Charts can be accessed through the Main Interface by clicking the [View Charts] button in the Network Composer window pane or from the Main Interface drop down menu Data Visualization => Charts.

The following dialog window will appear. Select the NodeSet you are interested in charting and select the [Next] button. For this example, we will simply select the currently loaded Node: Agents.
When you select [Next >] the Chart Results box will appear.

At the top are the three tabs for displaying the different charts: Bar Chart, Scatter Plot, and Histogram.
The Select a measure to view: dropdown menu will display the results of the selected measure in the box.

The Sort By: dropdown menu allows you to sort the results by Value, Named, or <unordered>.

The Show top: checkbox works with the textbox to the right allowing you to select the number of nodes to display. Removing the checkmark from the Show names checkbox displays the results with the names of the nodes. The [<Back>] button returns you to the initial dialog box where you can select a different node class.
85 The Charts

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram.

85.1 Bar Chart

A bar chart contains horizontal bars representing the individual nodes in the set. These rectangular bars are usually proportional to the magnitudes or frequencies of what they represent.
Bar charts are used for comparing two or more values. The bars can be horizontally or vertically oriented. Sometimes a stretched graphic is used instead of a solid bar.
85.2 Scatter Plot

A scatter plot uses Cartesian coordinates to display values for two variables. The data is displayed as a collection of points, each having one coordinate on the horizontal axis and one on the vertical axis.

A scatter plot does not specify dependent or independent variables. Either type of variable can be plotted on either axis. Scatter plots represent the association (not causation) between two variables.

A scatter plot can show various kinds of relationships, including positive (rising), negative (falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it suggests a positive correlation between the variables being studied. If the pattern of dots slopes from upper left to lower right, it suggests a negative correlation. A line of best fit can be drawn in order to study the correlation between the variables. An equation for the line of best fit can be computed using the method of linear regression.
In statistics, a histogram is a graphical display of tabulated frequencies. A histogram is the graphical version of a table which shows what proportion of cases fall into each of several or many specified categories. The histogram differs from a bar chart in that it is the area of the bar that denotes the value, not the height, a crucial distinction when the categories are not of uniform width (Lancaster, 1974). The categories are usually specified as non-overlapping intervals of some variable. The categories (bars) must be adjacent.

The word histogram is derived from histos and gramma in Greek, the first meaning web or mast and the second meaning drawing, record or writing. A histogram of something is thus, etymologically speaking, a drawing of the web of this something.
Drill Down

Below are procedures to trace a path through various nodes in different node sets using ORA’s drill down tool.
Drilldown allows for any path to be followed.
From the main menu select Data Visualization => Drill-Down Window.
From the drop down textbox select the node you wish to start with. Here we’ll begin with daniel_jackson.

The dialog box below will appear confirming you want to discontinue your last drill-down session.
Click on the node and a contextual menu will appear with all the links it has to other nodes. I select <event> (5 nodes).

![Diagram showing links]

This shows the five events the daniel_jackson was at.

![Diagram showing five events]
Next I select summit_meeting and from the contextual menu select <resource> (4 nodes).

It drills down showing the five links to resource nodes connected to the summit_meeting.

This can be continued for as long as you need.
The [+] and the [-] buttons increase and decrease the font size.
87 Visualization

Below are images of the ORA Visualizer Menus.

Measure Charts – When run this function will plot the three graphs, Bar Chart, Scatter Plot, and Histogram on the chosen Network.

View Measures Over Time – Requires multiple Networks. First plots points for measure selected on each of the Networks active with the option to see a direct line from the earliest to the latest point.

View Network Over Time – Requires multiple Networks. Displays nodes and links for each of the active Networks.

Drill-Down Window – Allows for quick, plotting of nodes connected to a chosen node.

GeoSpatial Networks – Analyze, forecast, and visualize a wide variety of spatial interactions and networks within a global-scale.

View Trails – Works with nodes moving between places over time. Requires the use of a trail set.

Network Visualizer

View Entire Meta-Matrix – This menu item calls up the Visualizer.

Path Finder – Calls up the Path Finder dialog box and uses the information input by the user to create a visualization.

Sphere of Influence – Calls up the Sphere of Influence dialog box and uses the information input by the user to create a visualization.
Key Set Selector – Calls up the Key Set Selector dialog box and uses the information input by the user to create a visualization.

88 Change Detection (Over-Time Viewer)

To analyze networks over time, several features have been created in ORA. They can be found in the Over-Time Viewer which can be accessed from the pull down menu.

A pop-up window will appear, asking the user how to conform the networks. When you have multiple networks over time, some nodes may appear in certain time periods and be absent from others. The user must therefore decide whether to:

a) include nodes as isolates in time periods where they are not observed (union):

b) exclude nodes that are not in all time periods (intersection)

c) calculate graph level measures on the networks as they are (do nothing).
ORA will spend a bit of time calculating measures and then the following screen will appear.

The data used in this example comes from IkeNet 3. IkeNet is a 5 year study conducted at the US Military Academy on the social network analysis of email traffic. There are
three different populations within the study. IkeNet 3 includes 24 cadets that serve in key leadership positions within a cadet regiment; 14 mid-career Army officers in a one year graduate program at Columbia University, with classes held at West Point; and a group of 30 faculty and cadets that conduct research in the area of network science. The networks analyzed are daily snapshots of the network. There are two node classes: agents and emails. Links are drawn from an agent to an email for each sent email, and from the email to agents for the received emails.

In the upper right the user can make some choices about the aggregation level. In other words, if you have daily networks, do you want to aggregate over 7 time periods to have weekly networks? Or perhaps you would prefer every 3 days. Below this are some options to restrict the time periods that the analyst wants to look at. This is particularly useful when there are many more than about 30 time periods.

In the upper right, the analyst will choose the particular measures that they want to analyze. So far, we have only explored network level measures. Theoretically, there is no reason why this will not work for any node level or meta network measure. Therefore, this capability is included in ORA.

One issue in SNCD is over-time dependence. ORA has a Fast Fourier Transform feature that allows the analyst to investigate the periodicity of network measures over time. Below is the frequency plot of the betweenness measure.

The analyst can use ORA to help determine which frequencies are significant. Selecting Dominant Frequencies on the radio button to the lower right, displays only the statistically significant frequencies.
The analyst will often want to transform the statistically significant frequencies from the frequency domain back into the time domain so that he/she can make better sense of them. To do this, the analyst must select the radio button on the lower right called Period Plot.

The period plot shows the analyst the expected periodicity in the over-time data. In the example, you can see weekly periodicity. The peaks and valleys in the period plot occur approximately every 7 days. At this point, the analyst may wish to merge the daily data into weekly networks. This would average out the effects of weekends and evenings that are likely to affect the properties of daily networks. Another approach is to simply look at the networks departure from what is expected.
The Filtered Plot radio button will create an over-time plot of how the measure deviates from what is expected, based on the periodicity of the measure. You can also plot the filtered measure with the original measure to see the difference as shown below.
The user may also wish to detect statistically significant change in the network over time. The user can select the Change Detection tab. There are three different control chart procedures that can be applied to the signal. We are applying the Cumulative Sum or CUSUM in this example. The user must enter the number of “In-control” networks.

This is the number of networks that you must assume to be typical. The procedure actually detects networks that are significantly different from the networks that are in the first however many networks are selected as in-control. For the CUSUM, the analyst can select a standardized magnitude of change to optimize the procedure for.

A novice user should just use the default value of 1. Finally, the user must determine the procedures sensitivity to false alarms. The user can select a decision interval, or specify the false positive risk, or specify the expected number of observations until a false positive is reached. For this example, we use a false positive risk of 0.01, which corresponds to a decision interval of 3.5 and 100 expected observations until a false positive.
The red line in the plot is the CUSUM statistic for detecting a decrease in the Betweenness Network Centralization. The blue line in the plot is the CUSUM statistic for detecting an increase in the Betweenness Network Centralization. The example above indicates that there may have been a statistically significant change in the network over time.

We detect a change in the network on 18 September 2008, when the blue line crosses the decision interval. This signals an increase in the Betweenness Network Centralization. The most likely time the change actually occurred was the last time the statistic was 0, which was 14 September 2008.

The cadet regimental chain of command assumed duties on 18 August. Part of the IkeNet3 experiment was to introduce blackberries to the chain of command and observe the impact. The blackberries were scheduled to be issued to the cadet chain of command on 18 September. They were notified at their weekly meeting on 14 September.

All of the cadets were not issued their blackberries until 22 September, but the first blackberry was issued on 18 September. Therefore, SNCD is successful at detecting this significant event in the organizational behavior of one of three subpopulations monitored. In other words, the behavior only changed for 24 out of 68 individuals in the network. This demonstrates the ability of SNCD to detect small persistent change in network behavior in background of noise.
89 GIS and Loom
89.1 Loom / Trails
89.2 1. Download training data and latest version of ORA

- Training data is included in ZIP: ORA is at http://www.casos.cs.cmu.edu/projects/ora/software.php

89.3 2. Open TAVI data in ORA

- Use File -> Open Meta Network… dialog to open TAVI.xml

- The clock icon in the Meta-Network Manager means that it is a dynamic meta network, meaning that there are continuous-time updates (“deltas”, which are listed below the top-level network) indicating how the network changes over time.

89.4 3. Open TAVI data in Loom

- To analyze data in Loom, you must have a relation that A) changes over time and B) stays many:one (i.e., a person must have only one location at any given time). Usually this is Agent x Location, but in theory you can select other relations.
In the main ORA screen, open the Visualizer -> View Trails dialog. Select the Person x Location relation.

When Loom opens, you will see three panels.

When Loom opens, you will see three panels.
At the top left is a list of Agents; the bottom left is a list of locations. Activating the check-box next to an agent will cause its trail to appear in the right hand panel. The large vertical strips correspond to locations, and the path moving between them is the trail indicating the agent’s location at each point in time.

89.5 4. Analyze and Manipulate

- Select agents until you find one with significant activity. Can you make out any regularity in the frequency of the agent’s movement?
Select 2 corresponding agents. Is there a correlation in the timing or sequence of their movements? Do they ever collocate (their lines arrive at the same location/time)?

- You can adjust colorings of agents or locations by clicking on the color swatch next to them. For printing, you can select the Grayscale option from the “view” menu.
To look at the exact timing of a trail segment, right click on it. You can also use the right-click menu to investigate the properties of a node or location.
When there is a great deal of activity, it can be difficult to clearly see the paths taken by agents. You can select Expand” from the menus to stretch the timescale so that highly frequent movements are more legible.

89.6 5. Import Singapore Data from TrailML

In addition to dynamic Meta-Networks, Loom can load from a standalone XML format called Trail-ML. We’ll use this to load a dataset that does not originate from a network, but sensor data.

In Loom, select File -> Open, and select SG.xml

This dataset corresponds to port records in which ships reveal to Singaporean authorities the actual timing of their transitions. Because of that, there is a distinction between paths that are explicitly reported, and those which must be inferred in order to make a trail continuous. For example, if we do not have a record of a ship’s movements for 2 weeks,
we must infer that he traveled between his last observed location and his first observation afterwards in the interim. Links of this kind are shown as dashed line.

89.7 6. Export Back to DyNetML

This data has far too many locations and agents to analyze in Loom. Instead, we can project it back into networks so that we can use our standard DNA to make sense of it.

In Loom, select File -> Export -> DyNetML… and save to a new file.

Then, open this file in the main ORA screen.

When Loom translates trails to networks, it creates a new MetaMatrix with the same Agents and Locations. There are 2 relations inside. The “Visit” relation is a 2-mode network indicating which actors visited which locations at any point in the time frame. The “Transition” relation is Location x Location, and connects any two points where an agent traveled directly between them.

As an example of analysis, open the transition relation in the network visualizer. You should see a clear community structure in the locations. Use “Color by Newman Grouping” to reveal these by color. The interpretation of this is that there are clusters of locations that are frequently traveled between – but these may or may not be spatially close! In the next section, we’ll consider trail data that has locations with actual GPS coordinates.

89.8 7. GIS

- Load the AIS.xml meta-network into the GeoSpatial Networks visualize
- Geospatial Networks (Beta)\Menu: Visualization
- Configure meta-network locations
- Menu: Tools->Configure Meta-Network Locations
- Select the “location” nodeset on the left and click the “Add GIS Attribute” button
- Choose the Latitude_Longitude type and select the “latitude” and “longitude” attributes for Latitude and Longitude, respectively.
- Click the “Next” button
- Select the “agent” nodeset on the left and select(CTRL+click) the Agent x Location network. This tells ORA to interpret the “Agent x Location” as meaning that agent nodes are located at locations they are connected to in this network.
- Go through the other nodesets and select the “* x Location” networks
- Click the “Finish” button Basic Navigation
- Select the pan tool from the toolbar
- Click on the map to recenter
- Select the zoom-in tool from the toolbar
- Click the map to zoom-in or select a region to view that region
- Select the zoom-out tool from the toolbar
Click the map to zoom-out

89.9  8. Size/Color by Network Measures

Open the Size/Color dialog boxes
Analyze Network → Size Nodes by Attribute or Measure
* Analyze Network → Color Nodes by Attribute or Measure
* Explore different network measures
* Size by Closeness centrality
* Size by Eigenvector centrality
* Explore the influence of aggregation on the network
* Open the dialog: Tools → Network Aggregator
* Move the slider back and forth to change the level of aggregation
* Repeat part 4) with different levels of aggregation
9.

Export the network from ORA
* As an image: File → Save Map → Save Map To PNG
* As a shapefile: File → Save Map → Save Map To SHP
* As a Google Earth file: File → Save Map → Save Map To KML
10.

Use the 3D visualization
* Options → Use 3D Visualization
* Explore the heatmap utilities
* Map Options → Show Heatmap Options
* Select the “Node Intensity” option
* Explore the Smoothing/Precision slider
* Explore the Color Sensitivity slider
90 GeoSpatial Actions Menu

<table>
<thead>
<tr>
<th>Actions</th>
<th>Tools</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Node Colors and Size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Attribute or Measure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Component</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Concor Grouping</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Newman Grouping</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size Nodes by Attribute or Measure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compute Standard Measures for Visible Network</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Undo:
Reset Nodes Colors and Size: Returns on nodes to their default colors and sizes.
Color Nodes by Attribute or Measure: Colors the nodes using
Color Nodes by Component:
Color Nodes by Concor Grouping: Colors nodes using Concor Grouping*.
Color Nodes by Newman Grouping: Colors nodes using Newman Grouping*
Size Nodes by Attribute or Measure: Sizes nodes using numerical data. NOTE: You
cannot size by an attribute using non-numerical data.
Compute Standard Measures for Visible Network:

91 GeoSpatial File Menu

Below are images of ORA’s GeoSpatial file menu:

Open Meta-Network…: Opens a NEW Meta-Network file into the Geospatial map.
REMEMBER: The new file needs to have both longitude and latitude data.
Add Data…
Open Meta-Network… : Opens a NEW Meta-Network file into the Geospatial map without removing the currently active data.
Add shapefile data
Add csv data

![ORA GIS CSV File Loader](image)

add e00 data
Save Map…
The Save Map To PNG (as an image file), Save Map To SHP (as a shape file) and Save Map To DynetML (as an XML file) all save the current file to their respective formats. Navigate to the directory you want to save the file and select OK.
Create Meta-Network From Visible Network…
Copy Image To Clipboard : Saves a picture of the current map to the clipboard which can be pasted into another program for use in demonstration purposes.
Close

92 GeoSpatial Options Menu

This section of help under development.

<table>
<thead>
<tr>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Edges</td>
<td>Show Labels</td>
</tr>
</tbody>
</table>

Show Edges :
Show Labels :

93 GeoSpatial Tools Menu

This section of help under development.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Resolution</td>
<td>Legend</td>
<td></td>
</tr>
</tbody>
</table>
Network Resolution:
Legend:
94 GeoSpatial Network Toolbar

94.1 Before running the Geospatial Function

The most important point before running the Geospatial function is that the MetaNetwork contains the proper data. It requires two attributes*: Longitude & Latitude. Also be sure your GeoSpatial Network is in the DynetML* format. Highlight the MetaNetwork in the main interface then from the main menu select Visualization ⇒ GeoSpatial Networks.

94.2 Toolbar

Copy Image to Clipboard: Places a copy of the current map in the clipboard which can be pasted into another program.

Pan Map: Place the cursor on the map and click the button. The map will re-center on those co-ordinates.

Select Place: Click and drag to capture nodes for information to display in an information window. This information will be displayed in an expanding tree format. Click and drag the cursor to include the nodes to display.
A pop-up window will display information for all the nodes captured by the cursor.

Zoom In: Place the cursor on the map and click the button. The map will re-center on those co-ordinates and also zoom in.
Zoom Out: Place the cursor on the map and click the button. The map will re-center on those co-ordinates and also zoom out.

Show Labels: Toggle the labels on & off.
Show Links: Toggle the links on & off.
Show Arrows: Toggle the arrows on & off.

Font Size: Increase or decrease font size using the up & down arrows.
Node Size: Increase or decrease node size using the up & down arrows.
Link Width: Increase or decrease link width using the up & down arrows.
MetaNode Manager:
95  GeoSpatial Network

The Geospatial Network tool in ORA allows for the plotting of a Meta-Network on a map of the globe using longitude and latitude for placing the nodes.

95.1  Important items to know before using the Geospatial Networks

1. The Meta-Network MUST contain a location NodeSet AND that NodeSet MUST contain longitude and latitude data.
2. The longitude and latitude use only numbers, not the n, e, s, & w normally associated with this terms. To put in a western or southern location, use a negative number.

96  View Trail Set

View Trail Set is a stand-alone program called up from ORA. Key points to View Trail Set are:

- It always involves both subjects and locations.
- Unlike a network, subject may revisit location.
- The time stream is an integral part of the data.
- Subjects exist at one location at a time (but longer relationship may be implicit in repeated visits).

The Foci of Activity are figuring out where people tend to go and guessing what they do there?

96.1.1  NOTE : Before you can use the View Trail Set function you must create a Trail Set

From the main menu select Data Visualization => View Trail Set
The Loom Input Chooser will appear which allows you to start Loom with any currently active Trail Set listed in the drop down menu.
After selecting your Trail Set you are presented with the Main Loom window. There are three panels to this window.

1. **agent** – Clicking in the checkboxes will activate/deactivate the agents from panel 3. You can select multiple agents to be displayed simultaneously.
2. **location** – List all the locations in the MetaNetwork.
3. **display** – This panel holds the currently selected agents and locations.
First we'll select two of the agents for display. With both agent's color being a shade of blue it could be difficult to distinguish their lines if they were close together. Can you really tell which one is Ren'al and which direction she took after the convergence?
You can change the color of any of the active trails. Click on the colored circle to the right of the name. This brings up the Choose Trail Color box. For our example we'll choose a bright, light color to contrast the dark blue.
The trails are then much easier to read.

Additionally if you Right-click on any of the colored bands in panel 3 an information menu will appear with details about that location.
97 View Measures Over Time

Using the View Measures Over Time on a Network allows an analyst to see how a network measures change over multiple time periods. In this example three Networks are loaded into ORA.

From the main menu select Data Visualization => View Measures Over Time

A dialog box will appear stating it will run on the currently loaded Networks. If you have any Networks you do not want in the calculation hit [Cancel] and remove them from Panel 1 before proceeding.

Once you have the Networks you wish to work with active, select [OK].
The View Measures Over Time box will appear. It consists of three sections:

1. Set Aggregation Level – A slider allowing you to choose between plotting all Networks or just the beginning and end points.
2. The Measures selection tabs – Choosing a particular tab will reveal the measures that are capable of being run on that particular node.
3. The Time / Value charting area – The area in which the plots will be plotted.
In this example I set the Aggregation Level to 1 and chose Clustering Coefficient. The program then plotted the three points from the three Networks I had loaded, tanzaniz_3, tanzaniz_4, and tanzaniz_5.
Moving the pointer to Aggregation level 2 draws a line from the beginning value to the ending value.
98 View Network Over Time

The View Network Over Time tool allows you to set up multiple Networks that encompass various time frames and view them in succession. First, make sure you have two or more Meta-Networks active in the left side panel.

Now select form the menu Data Visualization => View Network Over Time
This will bring up the Visualizer along with the Time Viewer window. At the start the pointer starts at the first position. You can see in the blue ellipse that hum is connected singularly to file.
Moving the pointer to the second position you can see that hum is no longer connected to file but it still connected to another node inside the cluster.

Moving the pointer to the third position causes hum to become a completely isolated node. file is still connected to the cluster.
98.1 Network Visualizer

From this sub-menu, you can call up the Visualizer and presetting various Visualizer functions.

98.1.1 The Entire Network:
This will display the entire Meta-Network that was currently selected. Any changes you need to make will have to be done once you're in the Visualizer. See The Visualizer section

98.1.2 View from Path Finder:
Calls up the Path Finder function in order to plot information for the Visualizer to use to find the connection between two nodes.

98.1.3 View from Sphere of Influence:
Calls up the Sphere of Influence function in order to plot information for the Visualizer to use to find the connection between two nodes.

98.1.4 View from Key Set:
Calls up the Key set function in order to plot information for the Visualizer to use to find the connection between two nodes.
The ORA Visualizer produces a graphical model of a Meta-Network comprised of Links and Nodes. Moreover, you can interact with your Meta-Network model by removing key actors, isolating certain links, focusing on any particular relationship between two nodes using tools such as the Path Finder.

You can apply a host of grouping algorithms, look at node’s Sphere of Influence, Locate Nodes, which may be hidden in complex clusters of nodes and links.

100.1 The Visualizer Interface

Below is a visualized Meta-Network of a Spider Man data set as it is displayed with the current tools available in the Visualizer. In this view all nodes and links are visualized. Note the different palette areas and options available from the Visualizer.

Note: In the following example we are using a special Spider Man Meta Network Model and not the SG-1, which appears throughout most of the help. You can following the instructions below with the SG-1 dataset or any other Meta-Network.
100.2 Features and How-Tos

100.2.1 Brighten/darken nodes, enlarge/shrink and Color Incident Edges

You easily manipulate the appearance of nodes and links by right clicking on a node and accessing the "appearance submenu".

In this example we will highlight a group of nodes and then "enlarge" them for enhanced viewer.

On the left side of the Visualizer, select the "dashed rectangle" icon, which is the Select Nodes tool. A tool tip will appear if you hover over this feature.
Drag a "selection rectangle" over a group of nodes of interest to you (image below).
"Right Click" inside the selection rectangle to access a right-click submenu.

Select the **Appearance Submenu**.

Select Enlarge (see image below).
On this submenu you will have the following choices:

- Enlarge (makes nodes bigger)
- Shrink (makes nodes smaller)
- Brighten (makes nodes brighter)
- Darken (makes nodes darker)
- Hide Labels (removes labels)
- Show Labels (restores or displays labels)

In this example we are going to select "enlarge." The nodes that were inside the selection rectangle will now display larger than the nodes outside of the selection rectangle.

By choosing a different option inside the appearance submenu (e.g., shrink, brighten, darken, etc.) you can apply the appearance option of your choosing.
100.2.2 Save only the selected sub-Meta-Network or re-ordering (it has an entry for Options which has been renamed “Display”.

In this example we are going to select only a portion of the visible Meta-Network (as done in the previous example) only this time we will save the selected nodes at its own Meta-Network.

To do this, again, activate the "dashed rectangle" node selection tool in the left window palette.
Next, select "Save Special" form the file menu drop down.

In the resulting submenu, select "Save Meta-Network (Only Selected Nodes) - (image below).
A pop-up window will appear. Name your new Sub-Meta-Network and save it to your desired location.
To visualize this Sub-Meta-Network, go to the file menu drop down. Select the file and then choose what you want to do with the new Meta-Network (e.g., append, replace, etc.). You could add it to the original, though in all likelihood you probably just want to analyze the new model by itself.

To analyze this by itself, choose the "Replace all Meta-Networks" option.

The Visualizer will now display the Sub-Meta-Network in the Visualizer. If you so choose, you could apply the tools over again as you see fit.
100.2.3 Ability to save selected sub-Meta Network/Network comprised of dotted-links/network comprised of non-dotted links, ability to launch into GIS (if network has locations with appropriate data)

The "Dotted lines" tool is a feature in the ORA Visualizer where you can set link parameters, or thresholds if you will. Furthermore, you can display linkages as dotted lines. If for example, a certain link scored below a certain criteria (in all likelihood "weight" linkage) you can opt to have it displayed as a dotted line.

What follows is an example on how to do display a Meta-Network, apply the dotted-lines tool, then choose to save the dotted line Meta-Network or the Meta-Network with the non-dotted lines.
To access The dotted lines tool

To access the tool, look for the "Hide Links with weight" just below the tools bar in the Visualizer. There is a pull down arrow. Select that and change the "Hide Link" weights button to the dotted lines option.

Note that you must have a Meta-Network that has weights attributed to the linkages. You can go to the editor in the main interface, choose the "Editor" and select "Binary View" to added weights.
Back in the Visualizer, select the "Change to dotted-line" links option in the pull down menu located below the tools bar.

This tool will display the "edge filter' tool bar. Here you can set ranges of values and scenarios to indicated dotted lines.

In this example we selected to change linkages to dotted lines if they were "Grater Than" 0.0 and "Greater Than" 0.7. You can see the result in the window below.

100.2.5 Tools: Node Locator. You can right click a node here to bring up the contextual menu

The Node locator allows you quickly find a node within a complex visualization, which may obscure the node from discernable observation.
From the Visualizer "Tools" menu > Node Locator

The Node Locator pop-up window palette will appear (image below):

The Node Locator presents tree format to find a particular lode and offers an "Alphabetical Order" and a "Categorical Order" array of top-level branch and leaf nodes.
100.2.6  Related Content....

Display/Options: Show Multiple Links Between Nodes, Link Labels

Node Status Pane - addition of URI and Sources tabs

Networks over Time

Time Clustering tab
Tab for viewing all the Timeslices in a list

Ability to easily create nodes/links

View Network Over Time panel

Saving Visualizations as an ORA-PNG
101Actions

This section of the help contains a description of the functions of the Action Menu:

<table>
<thead>
<tr>
<th>Actions</th>
<th>Tools</th>
<th>Layouts</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
<td>Show Links</td>
</tr>
<tr>
<td>Add Node(s)</td>
<td></td>
<td></td>
<td></td>
<td>Show Arrows</td>
</tr>
<tr>
<td>Add Edge</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isolates</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Periphery</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Isolated Nodes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recursively Hide Pendants</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recursively Hide Pendants and Isolates</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Nodes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Nodes Except Isolates</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Node Colors and Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Attribute or Measure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Component</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Concor Grouping</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Nodes by Newman Grouping</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size Nodes by Attribute or Measure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Node Occurence Transparencies</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compute Standard Measures for Visible Network</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Undo**: Undoes a variety of actions performed in the Visualizer.

**Add Node(s)**: Function for adding Nodes directly into the Visualizer.

**Add Link**: Function for adding links directly into the Visualizer.

**Isolates**
- **Periphery**: Moves Isolates back to their original position.
- **Hide Isolated Nodes**: Remove any node which has zero links connecting it to other nodes.
- **Combine into MetaNode**: Collects all the Isolated nodes into a Meta-Node.
- **Move into Column**: Moves all isolates to the right side of the screen in a column. The isolated nodes can be moved back using the Periphery option.
- **Hide Pendant Nodes**: Remove any node which has only one edge connecting it to another node.
Recursively Hide Pendants: This function will run both the Hide Pendant routine until there are no more Pendants.

Recursively Hide Pendants and Isolates: This function will run both the Hide Pendant and Hide Isolate routines until there are no more Pendants or Isolates.

Show All Nodes: Any nodes that were previously hidden will be revealed.

Show All Nodes Except Isolates: Reveal any nodes that were previously hidden with the exception of nodes that have no links connecting them to another node.

Set Title: Allows the user to specify a title for the Visualizer picture. Useful for creating slides that need a labeled picture. The title will appear centered at the top. If you wish to remove the title call the function up a second time, leave the textbox blank, and press [OK]. This will delete the title from the screen.

Reset Node Colors and Size: If colors and sizes have been changed this option will reset them to the defaults.

Color Nodes by Attribute or Measure: This allows the user to select a node attribute and color code the nodes according to its value for the attribute.

For Attribute: Each node will be colored depending on the value of its attribute.

For Measure: The user selects a measure to compute on the visible network and then the nodes are colored according to its value for the measure.

Color Nodes by Component: This computes the components of the visible network and then color codes the nodes according to which component it is in. A component is a single piece of a network whereby any two nodes in a component are connected by a sequence of links.

Color Nodes by Concor Grouping*: This computes the CONCOR algorithm on the visible network and then color codes the nodes according to which CONCOR group it belongs.

CONCOR then divides the data into two sets on the basis of these correlations. Then, within each set (if it has more than two actors) the process is repeated. The process continues until all actors are separated. The result is a binary branching tree that gives rise to a final partition.

Color Nodes by Newman Grouping*: This computes the Newman algorithm on the visible network and then color codes the nodes according to which Newman group it belongs.

Each pair of actors is correlated then each row extracted and correlated with each other row. Shows how similar is the vector of similarities of actor X to the vector of similarities of actor Y? Repeat this process over and over. The elements are iterated correlation matrix converge on a value of either +1 or -1.

Size Nodes by Attribute or Measure: Allows the user to scale node sizes based on a measure or node attribute. Measures are run on the visible network.

NOTE: All of the operations are on the visible network, that is, whatever nodes and edges are currently displayed in the Visualizer.
Compute Standard Measures for Visible Network: Compute Standard measures computes the following collection of measures on the visible network: Total Degree Centrality, Betweenness Centrality, Eigenvector Centrality, Cognitive Demand, Resource Exclusivity, Task Exclusivity, Knowledge Exclusivity. The measure values can then be viewed within the Entity Status Window.
Add Edge

**IMPORTANT NOTE:** Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File => Save Meta-Network As... (to save the entire Meta-Network with additions) or File => Add Meta-Network to ORA (to create a new Meta-Network using only the currently visible nodes). Changes cannot be saved back to the currently open Meta-Network.

1. **Start node**: The start of a directed edge.
2. **End node**: The end of a directed edge.
3. **Insert Nodes as they’re clicked**: Fills in the textboxes for Node. The first click adds the node in the Start node section. The second click adds the node to the End node section. Any further clicks will make the previous End node the start node and the newly clicked node becomes the new End node.
4. **Use an Existing network** will place the links within the chosen network form the dropdown menu and **Use a new network** creates a new network from the name in option 5.

**102**
5. New Network ID: is the name for the new network from option 4.
6. Link Weight: The weight to assign the edge between the nodes.

102.1.1 Since this function creates directed links a second edge would need created for reciprocal action.

Example: If a connection was made starting with A to B, a second connection would need to be made starting with B to A.

102.2 Adding a Missed Link

If after the Meta-Network was constructed and it's noticed an link is missing (e.g. janet_frazier should have been connected to gen_hammond), the missing link can be added immediately without returning to the editor.
From the Visualizer menu select Actions => Add Edge(s).

Be sure that the Insert Nodes as they're clicked has been check marked and that Use an existing network is selected with the correct network is visible in the dropdown. Then select the [Create Edge] button.

The two nodes are now connected with a directed link.

102.2.1 NOTE: this created a directional link from janet_frazier to gen_hammond but not the other way. To make it go both ways, a second link from gen_hammond to janet_frazier would need to be created.
**Add Node**

**IMPORTANT NOTE:** Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File => Save Meta-Network As... (to save the entire Meta-Network with additions) or File => Add Meta-Network to ORA (to create a new Meta-Network using only the currently visible nodes). Changes cannot be saved back to the currently open Meta-Network.

The Add Node(s) function allows addition of nodes to the current Visualizer. These added Nodes are not added to the currently open Meta-Network. If there is a need to save the Meta-Network with the added nodes then use the menu item File => Save Meta-Network to File... and create a new Meta-Network.

Below is the NodeSet for Stargate with the original 16 node NodeSet.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack,...</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam...</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
</tr>
<tr>
<td>A04</td>
<td>tea'c</td>
</tr>
<tr>
<td>A05</td>
<td>jacob_cart...</td>
</tr>
<tr>
<td>A06</td>
<td>lt_ellicott</td>
</tr>
<tr>
<td>A07</td>
<td>ren'al</td>
</tr>
<tr>
<td>A08</td>
<td>aldwin</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
</tr>
<tr>
<td>A11</td>
<td>gen_ham...</td>
</tr>
<tr>
<td>A12</td>
<td>lantash</td>
</tr>
<tr>
<td>A13</td>
<td>narim</td>
</tr>
<tr>
<td>A14</td>
<td>travell</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
</tr>
<tr>
<td>A16</td>
<td>yu</td>
</tr>
</tbody>
</table>
From the main menu select, Actions => Add Node(s) which brings up the Add Node(s) dialog box.

1. **Use an Existing Node Set:**
   allows for a NodeSet selectable in option 2 or Use a new Node Set creates a new empty NodeSet.

2. This dropdown gives the option for selecting a pre-existing NodeSet to place the new node.
3. The **Node ID:** textbox is used for giving the new node an ID.
4. The **Number to Create:** specifies the number of new nodes.

**NOTE:** If the **Number to Create** is larger than 1 then the text placed in section 3 for **Node ID** will be used as a prefix for all new nodes created.

After inputting the information to add node A17, the Visualizer will now display the new node as A17 with no connection. In order to display this node with a title will require saving the Meta-Network and changing the information within the ORA Editor.
103.1 Adding Multiple Nodes

The procedure for adding multiple nodes is similar to adding a single node. The exception is the text in the Node ID: textbox. When adding multiple nodes only use a prefix. ORA will attach numbers, starting at 1, for each node.

Here's the addition of three new nodes and the prefix A will be used. Three nodes, A_1, A_2, and A_3 are created on screen.

NOTE: You can only use a prefix ONCE. ORA will not accept any previously used prefixes a second time.
To add additional nodes use a different prefix.

NOTE: Now either save the altered Meta-Network using the File => Save Meta-Network As... to a new filename or continue with Add Link(s).

104 Add Nodes and Links in Visualizer

ORA allows the addition of Nodes and Links directly into the Visualizer to create customized Networks on the fly.

Add Node(s): allows for the addition of one or more nodes directly into the Visualizer. These nodes will initially contain Node IDs only. Any titles or attribute settings will be made after the Meta-Network is saved into a new file. These nodes can be added to existing NodeSets or completely new NodeSets.

Add Edge(s): allows for the addition of edges connecting nodes (either previous nodes or newly constructed nodes) to enhance, or create, Networks.

NOTE: Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File => Save Meta-Network As... (to save the entire Meta-Network with additions) or File => Add Meta-Network to ORA (to create a new Meta-Network using only the currently visible nodes). Changes cannot be saved back to the currently open Meta-Network.

104.1 The difference between the Save options.
Save Meta-Network As... writes a complete set of NodeSets and Networks to the DynetML file. If only saves the visible nodes. If none of the nodes of a NodeSet are visible, then an empty NodeSet will be saved to the file.
Add Meta-Network to ORA saves directly into ORA and creates only NodeSets and Networks that are currently visible in the Visualizer.

105 Brand New Network

This function also allows the creation of Networks from Scratch. First, remove the checkmarks from all the NodeSets in the Legend to remove them from the screen.

105.1 The Dataset

Next prepare your data for inclusion. Here is a small, five node, NodeSet.

A01 col_jack_o'neill
A02 maj-samantha_carter
A03 daniel_jackson
A04 teal'c
A05 gen_hammond

From the main menu select Actions => Add Node(s).
In the dialog box activate the Use a new Node Set radio button. Underneath, in the Type: dropdown menu, select the type of NodeSet. Then in the New NodeSet ID: textbox give it a name. Then select the [Create Node(s)] button.

The five nodes will appear in the Visualizer with the prefix and attached numbers. Now it's time to connect the nodes.
From the Visualizer menu select Actions => Add Link(s).

After selecting [Create Link] a new link will be drawn in the Visualizer.
Now switch the NodeSet to use to Use an existing network, select the newly created NodeSet in the dropdown, and create the rest of the links.

All of the links are now complete.

Save the Meta-Network with either Save Meta-Network As… or Add Meta-Network to ORA and use the ORA editor to add in titles and attributes.
106Color Nodes by Attribute

When the agent-by-agent network is opened all the nodes default to the color red. ORA has default colors for all the various NodeSets. But ORA can also color the nodes based on their individual attributes. Here’s the default agent-by-agent NodeSet in red.

From the Visualizer main menu select Actions … Color Nodes by Attribute or Measure. This brings up the Node Color Selector dialog box.
Selecting the down arrow for Select an Attribute:. Highlight an attribute from the list. ORA gives default colors to the nodes.

In some instances the color distinction isn't highly visible. And for presentation purposes a good contrast is necessary. To bring up the Color Selector click on the color you want to change.
Select a new color from the swatches. Then select [OK]

![Swatch selection dialog box](image)

Your new color choice is now reflected in the dialog box.

<table>
<thead>
<tr>
<th>female</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>male</td>
<td></td>
</tr>
</tbody>
</table>

And the nodes with the attribute you selected are now a new, and brighter, color.
107 Compute Standard Measures

This function runs four standard measures:

Cognitive Demand: Cognitive Demand measures the total amount of effort expended by each agent to do its tasks. Individuals who are high in cognitive demand value are emergent leaders. Removal of these individuals tends to be quite disruptive to networks.

Centrality, Betweenness: Betweenness tells us which node is the most connected to other parts of a network. For example, Betweenness can tell us which person in a network is the most central to the network as a whole. Betweenness measures the number of times that connections must pass through a single individual to be connected.

Centrality, Eigenvector: Eigenvector Centrality reflects one's connections to other well-connected people. A person connected to many isolated people in an organization will have a much lower score in this measure than those that are connected to people that have many connections themselves. This would be true even if such a WHO might have a high amount of actual connections (i.e. high degree centrality).

Centrality, Total Degree: Degree Centrality tells us the relative number of direct connections a WHO might have in a network; the higher the score the more likely a WHO might be likely to receive and potentially pass on critical information that flows through the organization.

These values can be viewed either by hovering over a node and revealing the tooltip or double clicking a node and bringing up the Node status dialog and selecting the Measures tab.
108.1 Isolates

108.1 Periphery

Places isolates that were moved into column back to their original positions.

108.2 Hide Isolate Nodes

To further simply a visualization, it may prove useful to remove isolated nodes from the visualization.

Isolated nodes are not directly linked or connected to other nodes, which share direct links with each other. In the screen shot below, the red ellipses highlights an isolated nodes which need removed.

Select from the Main Menu: Actions => Hide Isolated Nodes.

In the screen shot below, after removing isolated nodes, the visualization is further simplified.

108.3 Combine into MetaNode

This option will combine all the Isolates into one MetaNode. This can be expanded right-clicking to bring up the contextual menu.
108.4 Move into Column

This function is used to move isolate nodes from the main viewing area to move easily view the connected nodes. These will be lined up on the left side of the screen.

NOTE: The original dataset was changed in order to create the isolates.
NOTE: If the names are not viewable and off the screen, change the position of the labels.

The isolates can be returned to the original position using the Periphery options.

109 Removing Pendants

Pendants share links with only one other node. Their linkage is tangential and therefore isolated from the core linkages you may be interested in examining. Pendant Nodes, like Isolated Nodes, can be removed.

From the drop down menu in the Visualizer select Tools => Hide Pendant Entities.

Below is a Before/After screen shot of the visualization before showing the removal of the pendant entities.

110 Resize Nodes by Attribute
Resize by Attribute uses the numerical value of an attribute to size the nodes. Sizes will be scaled accordingly. Below is an attribute created for this example.

The numbers range from 0 to 10 and denote approximate rank. 10 denoting general/leader down through the ranks to 5 for civilians and finally 0 for persons not involved.

<table>
<thead>
<tr>
<th>Node ID</th>
<th>Node Title</th>
<th>rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>col_jack...</td>
<td>9</td>
</tr>
<tr>
<td>A02</td>
<td>maj_sam...</td>
<td>7</td>
</tr>
<tr>
<td>A03</td>
<td>daniel_jac...</td>
<td>5</td>
</tr>
<tr>
<td>A04</td>
<td>teal't</td>
<td>5</td>
</tr>
<tr>
<td>A05</td>
<td>jacob_cart...</td>
<td>5</td>
</tr>
<tr>
<td>A06</td>
<td>lt_elliott</td>
<td>6</td>
</tr>
<tr>
<td>A07</td>
<td>ren'al</td>
<td>10</td>
</tr>
<tr>
<td>A08</td>
<td>aldwin</td>
<td>5</td>
</tr>
<tr>
<td>A09</td>
<td>janet_frazier</td>
<td>5</td>
</tr>
<tr>
<td>A10</td>
<td>maj_man...</td>
<td>8</td>
</tr>
<tr>
<td>A11</td>
<td>gen_harm...</td>
<td>10</td>
</tr>
<tr>
<td>A12</td>
<td>lantash</td>
<td>7</td>
</tr>
<tr>
<td>A13</td>
<td>narim</td>
<td>2</td>
</tr>
<tr>
<td>A14</td>
<td>travell</td>
<td>10</td>
</tr>
<tr>
<td>A15</td>
<td>osiris</td>
<td>0</td>
</tr>
<tr>
<td>A16</td>
<td>yu</td>
<td>0</td>
</tr>
</tbody>
</table>
From the main menu select Actions => Size Nodes by Attribute or Measure. Then select the attribute to use for the sizing. When finished, select [Close].

NOTE: Sizing nodes by attributes only works with attributes of numerical content. Alpha content will have no affect on the size of the nodes.

Each node will now be displayed according to the value in the chosen attribute.

NOTE: The numerals are not displayed in ORA and are shown only for display purposes.

111 Resize Nodes by Measure
ORA has the capability to visualize nodes by scaling them relative to each other in relation to common SNA Measures or Attributes as selected within the ORA Visualizer.

The key benefit to sizing nodes by Measure or Attribute is the ability to conceptually capture which nodes in your network figure more prominently in terms of measures by simply gauging their size visually and intuitively.

First, visualize one of your networks. Below is the Stargate agent x event network to find the agent with expertise regarding events in the scenario.
From the main menu select Actions => Size Nodes by Attribute or Measure. From the bottom textbox I selected Cognitive Expertise. Each of the nodes in turn grows to reflect its value from that measure.

The display now changes to reflect each node's value by size.

We'll compare two nodes: daniel_jackson and teal'c.

daniel_jackson's cognitive expertise value is 0.2400 and is displayed with a large red circle while teal'c's value is 0.1556 is displayed by a much smaller red circle. The values can be read in the Node Status dialog box.
111.1 Cognitive Measure for daniel_jackson

<table>
<thead>
<tr>
<th>General Info</th>
<th>Attributes</th>
<th>Measures</th>
<th>Neighbors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>0.2400</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

111.2 Cognitive Measure for teal'c

<table>
<thead>
<tr>
<th>General Info</th>
<th>Attributes</th>
<th>Measures</th>
<th>Neighbors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cognitive Expertise</td>
<td>0.1556</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

112 File Menu

Below is an image of the file menu from ORA’s main interface.

Open Meta-Network…
This opens an Open File dialog box so you can navigate to a directory and open a Meta-Network into the Visualizer.

Save Image to File…
This opens a Save As… dialog box and allows you to save an image of the current Visualizer in one of the formats listed below.

Save Meta-Network to File…
After you've made changes to the information you can save the current status of the Meta-Network into a new file in a DynetML* format.

Copy Image to Clipboard
Similar to the Save Image to File… only saves it to the clipboard where you can paste it into an image-editing program.

Add Meta-Network to ORA

Save the currently visible network into a new Meta-Network titled, New Meta-Network. This new Meta-Network can be renamed accordingly.

Visualize in 3-D

Close

Close the Visualizer and returns to the Main Interface.
113 Link Color

In ORA you can color links according to several preferences.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samantha_carter</th>
<th>daniel_jackson</th>
<th>teal'c</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td></td>
<td>2.0</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>maj_samantha_carter</td>
<td>2.0</td>
<td></td>
<td>1.0</td>
<td>2.0</td>
<td>1.0</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>1.0</td>
<td></td>
<td>0.0</td>
<td>1.0</td>
<td>2.0</td>
</tr>
<tr>
<td>teal'c</td>
<td>2.0</td>
<td></td>
<td>2.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

113.1.1 NOTE: For this example all the nodes are colored black so as to decrease the color confusion.

NOTE: For this example the link weights have been drastically altered from the original values to assist in display purposes.

NOTE: Below is a warning for the placement of the Min and Max sliders. When the sliders are set to the absolute left and right positions this causes all the colors to be set to red. Move the sliders in to prevent this.
113.2 Even Distribution - The Full spectrum

The colors used are evenly distributed across the chosen spectrum. Using a NodeSet with weights of 2, 4, 6, 8, & 10 would have three colors chosen at evenly spaced intervals across the spectrum.
113.3 Even Distribution - The Limited spectrum

Limiting the spectrum to smaller set will cause some of the numbers to contain very similar colors. This might make it difficult to tell the various shades of blue apart. Use this only when there are a very limited number of values.
113.4 Scale to Weight

When scaling to weight the 100 values cause a spread to occur that makes all other values in the same general color area.
113.5 Link Values

When a link is bi-directional and the weights of the links are not the same the Visualizer will color the link that was drawn last.

113.6 Change link Color

After setting the type Even Distribution/Scale by Weight the color of the links can be set manually through the color changer. Click on the color box of any of the links to bring up the color change dialog box. Select a new color and select [OK].
**114 Comments**

While in the Visualizer Comments can be added to the display. Right-click a node and from the contextual menu select Add Comment. The comment is placed in a colored box with a dashed arrow connecting them to the original node.  
*NOTE: These comments are not saved when exiting the Visualizer.*  
*NOTE: The main use of these comments would be in creating screenshots for display in order to add commentary for a report.*  
Below is a section of the Stargate scenario with the unexpected appearance of Osiris.

![Diagram](image)

**114.1 Adding a Comment**

A comment is added stating Osiris’s arrival changes the plan.

![Diagram](image)  
Osiris' arrival changes Daniel's plan

From the main menu, under the Tools item, the font size and color, as well as the color of the box, can be changed.
114.2 Adding Multiple Comments

It is also possible to add multiple comments to the same node.

114.2.1 REMEMBER: These comments are not saved when exiting the Visualizer.

114.3 Deleting a Comment
A comment can be deleted by first selecting that comment. A right-click brings up the contextual menu. From this menu select Delete Selected Node(s).

115 Node Images

Nodes can be replaced with various symbols or pictures. There are a few items to note.

1. All images should be reduced to a maximum of 40 x 40 pixels before using in ORA. Bigger images will be reduced to this size and the image quality may be degraded.
2. If a picture is placed on a background with the color R=255, B=0, G=192 the background will be changed to the color of the node.

115.1 Setting a Image Folder

The Set Picture option is designed with modularity in mind, with adding new images as easy as putting a folder with images in the include\OraFiles\images\Visualizer\node folder. The dialog will automatically read that folder for subfolders, use the subfolder names as categories, and the images inside the subfolders as the images for each category.

115.2 Set Picture

Right-click on any node and select Set Picture from the contextual menu. The Node Selector dialog box will appear. The drop down menu contains various types of node images. With a node selected a custom image can be applied.

115.3 Custom
The Custom option allows for the inclusion of a user's own icons. The custom category is used for images that have been previously loaded in the current meta-network. Clicking OK applies the currently selected node's image to all nodes selected in the Visualizer.

Additional information can be found in the Node Shaper section.

The [New Image] button brings up a navigation box from which to navigate any directory and select an image file. The picture types can be jpg/jpeg, gif, or png. These will all be collected into the Custom section.

**NOTE:** Remember to reduce the picture size BEFORE importing it into ORA.

To set a new image right-click the node and select Set Picture. This brings up the picture dialog box. Locate the appropriate picture and select it. A black border will appear around the image. Select [OK] will set the picture to the node.
Options

Below is an image of the options menu in ORA.

<table>
<thead>
<tr>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Scale Nodes</td>
<td></td>
</tr>
<tr>
<td>Show Mouse Overs</td>
<td></td>
</tr>
<tr>
<td>Show Links</td>
<td>Show Link Weights</td>
</tr>
<tr>
<td>Show Arrows</td>
<td>Show Self Links (Loops)</td>
</tr>
<tr>
<td>Link Color</td>
<td></td>
</tr>
<tr>
<td>Show Labels</td>
<td>Load Node Images</td>
</tr>
<tr>
<td>Label Style</td>
<td></td>
</tr>
<tr>
<td>Node Style</td>
<td></td>
</tr>
<tr>
<td>Show Comments</td>
<td>Set Comments Font</td>
</tr>
<tr>
<td>Set Comments Color</td>
<td></td>
</tr>
<tr>
<td>Set Title</td>
<td>Set Title Font</td>
</tr>
<tr>
<td>Show Title</td>
<td></td>
</tr>
<tr>
<td>Title Location</td>
<td></td>
</tr>
<tr>
<td>Black And White Only</td>
<td>Background Color</td>
</tr>
<tr>
<td>Background Image</td>
<td></td>
</tr>
</tbody>
</table>

Log Scale Nodes –
Show Mouse Overs – Toggles the information boxes on and off whenever you hover the mouse over a node or link in the Visualizer.

Show Links – Toggles on/off the display of links between nodes.
Show Link Weights – Toggles whether the weight of various links is displayed.
Show Arrows – Toggles on/off the display of the arrows of the links.
Show Self Links (Loops) – Shows whether there is a connection between a node and itself. It is designated with a circle pointing back to itself.

![Diagram](image)

Link Color – Options for coloring the links.

<table>
<thead>
<tr>
<th>Link Color</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Match Source Node</td>
</tr>
<tr>
<td></td>
<td>Match Target Node</td>
</tr>
</tbody>
</table>

Show Labels – Toggles on/off the display of the labels of the nodes.

Load Node Images –

Label Style – Determines the placement of the labels of the nodes.

<table>
<thead>
<tr>
<th>Label Style</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>On Right of Node</td>
</tr>
<tr>
<td></td>
<td>On Left of Node</td>
</tr>
<tr>
<td></td>
<td>On Top of Node</td>
</tr>
<tr>
<td></td>
<td>On Bottom of Node</td>
</tr>
<tr>
<td></td>
<td>Centered on Node</td>
</tr>
</tbody>
</table>

Node Style – Rotates between the three sizes and styles for the display of the nodes.

<table>
<thead>
<tr>
<th>Node Style</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Small</td>
</tr>
<tr>
<td></td>
<td>Medium</td>
</tr>
<tr>
<td></td>
<td>Large</td>
</tr>
</tbody>
</table>

Match Source Node colors the link the same as the source and Match Target Node will change the color to match the target. Helpful when you need various points of reference for the links.

Show Comment – Toggles on/off the display of comments

Set Comments Font – Set font for ALL comments

Set Comments Color – Set color for ALL comments

Set Title – Type in the title for this screen shot

Set Title Font – Select the font for the title
Show Title –
Title Location –

Black and White Only – Removes all colors form the Visualizer.
Background Color – Changing the background color changes it in both the Visualizer and the Legend.

116.1.1 NOTE : Some of the possible background colors can make it difficult to view the Visualizer. Your best choice is black (although white is used in the examples for easier printing).

Background Image – Allows you to chose a .jpg, .gif, or .png to use as a background.

Please be aware that some pictures may make viewing the network somewhat difficult.
Creating A Meta-Node

A Meta-Node contains multiple nodes collapsed into one. You can create Meta-nodes based on the node sets in your organization, or you can create MetaNodes based on the attributes of the nodes.

To create Meta-nodes, you must access the Meta-node Manager. There are two ways to do this:

From the drop down menu select Tools => Meta-Nodes or select the Meta-Node Manager button on the toolbar.

And it brings up the Meta-Node dialog box.
1. **Expand all meta-nodes expands all meta-nodes to their respective single nodes.**

2. **Select how to create links between Meta-Nodes:**
   - Absolute count of the links: Counts each link from any node in the Meta-Node to any other node as 1.0.
   - Proportion of the maximum possible links:
   - Block model links and weights:

3. **Meta-Node Creation is controlled by three buttons:**
   - By Node Class: Creates Meta-Nodes based on current NodeSets.
   - By Most Recent Grouping: Creates Meta-Nodes based on the most recent use of the **Group Viewer**.
   - By Attribute…: Creates Meta-Nodes on one individual attribute.

4. **Select an Attribute**: Allows for the selection of the attribute to group on.

5. **Funnel nodes without this attribute**: Collects all nodes without the above attribute and places them into one collective Meta-Node.

### 118Meta-Node - Attribute

This button creates Meta-Nodes using a single attribute. It's used in conjunction with the Funnel Nodes checkbox. Below is an image of the Select an attribute box:

Choosing group without the Funnel Nodes checked creates a confusing display.
Next place a checkmark in the Funnel nodes box and select groups for a cleaner display.

Leaving the Funnel nodes option unchecked works best with fewer NodeSets. Below only the agent and tasks NodeSets were used. Without funneling the individual tasks can be viewed as to which agent Meta-Node they connect to. It also reveals that groups in area 1 are not connected to any tasks and that groups in area 2 are all the agent nodes that had no groups affiliation.
Recent Groupings is used in conjunction with the Group Viewer.

Content under development

Node creation is done via three buttons in the Meta-Node Creation section.
This button will create Meta-Nodes for each NodeSet.
Drill Down Wizard

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall node class (knowledge, tasks, resources, agents) or by choosing individual nodes from a checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer:

From the ORA Visualizer Main Menu select Tools => Drill Down.

The following window box will appear.

The top sections allows you to choose the nodes for use. The bottom tabs allow for choosing specific nodes within a set.
Drill Down Wizard Example

Using the Embassy Meta-Network, we will render the various node classes using the Drill-Down Wizard Tool. The screen shot below displays the Embassy Meta-Network as it should first appear in the Visualizer.
From the Main Menu select Tools => Drill Down.
This will bring up the Drill Down dialog box as shown below.
Here, select the node class Knowledge by selecting the Knowledge check mark box. The screen shot below, displays the end result that you should now see in the Visualizer.

Next, with the Knowledge node box checked, add the node class Task. The screen shot below displays the end result.
Next use the search bar feature of the Drill-Down Wizard to narrow the search. Enter the word Bombing in the Visualizer search field below. Then select the check box on the bombing row. The screen should now reflect your new search parameters. Everything not associated with bombing has been turned off.
123Drill Down Wizard Explained

The ORA Drill Down Wizard can be broken down into three primary sections of input:

1. **Section 1**: enables you choose individual node sets or combination of node sets to display in the Visualizer.
2. **Section 2**: of the Drill Down Wizard enables you to search for a particular node within your Meta-Network. This can be handy when you dealing with large node sets and the one you are interested in finding is not easily located.
3. **Section 3**: enables you check mark an individual node within your Meta-Network by node class if so desired.
**Node Status**

The Node Status Window is used to reveal pertinent information about one selected node. The window can be brought up by either selecting it from the main menu, Tools => Node status or by double-clicking the node in the Visualizer. The dialog box below will appear. There are four tabs available which will display the node's information.

You can switch nodes by selecting any other node in the Visualizer. ORA will automatically change the display.
This tab displays all the attributes for the node selected as well as its value.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>symbiote</td>
<td>ren'ial</td>
</tr>
<tr>
<td>position</td>
<td>tok'ra_council</td>
</tr>
<tr>
<td>dies_when</td>
<td>revanna_attack</td>
</tr>
<tr>
<td>ally</td>
<td>yes</td>
</tr>
<tr>
<td>host</td>
<td>unknown</td>
</tr>
<tr>
<td>dies</td>
<td>dies</td>
</tr>
<tr>
<td>leadership</td>
<td>tok'ra_council</td>
</tr>
<tr>
<td>servitude</td>
<td>tok'ra</td>
</tr>
<tr>
<td>gender</td>
<td>female</td>
</tr>
<tr>
<td>race</td>
<td>tok'ra</td>
</tr>
<tr>
<td>race_2</td>
<td>human</td>
</tr>
</tbody>
</table>

This window shows information for the currently selected node in the visualizer.

To select a node in the visualizer, click on the node. To de-select a node, click it again.

Show the window when a node is selected

Node Status: jacob_carter_selmak
Node class is "agent"
ID is "jacob_carter_selmak"
22 links
The Neighbors tab displays which other nodes have a connection as well as the strength of the link.

<table>
<thead>
<tr>
<th>Neighbor</th>
<th>Strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>crystal_tunneling</td>
<td>1.0</td>
</tr>
<tr>
<td>make_memory_altering...</td>
<td>3.0</td>
</tr>
<tr>
<td>pilot</td>
<td>0.5</td>
</tr>
<tr>
<td>make_symbiote_poison</td>
<td>3.0</td>
</tr>
<tr>
<td>ring_room_location</td>
<td>0.5</td>
</tr>
</tbody>
</table>

125Group Viewer

The Group Viewer helps separate nodes into distinct groups. We’ll use one of the networks for each of the groups to further examine the breakdown. There are six groupings which can be called up:

- Clique
- CONCOR
- FOG
- Johnson
- K-FOG
- Newman
126 Group Viewer-CONCOR

Below is an image of the Group Viewer window and procedures for using this tool.

![Group Viewer Window](image)

**Parameters**

- Use out-links (matrix rows)? The links leading out of the chosen node into another node.
- Use in-links (matrix columns)? The links leading into the chosen node from another node.

**Example**

The example uses the network agent x task. For each of the three possibilities in, out, both the display is shown with the number of groups set to 4. The resulting displays show how the in and out links affect the groupings.
126.3 Use both in-links and out-links

126.4 Use in-links

126.5 Use out-links
127 Group Viewer-FOG

Below is an image of the Group Viewer FOG window and procedures for using this tool.

FOG stands for Fuzzy Overlapping Groups. Individual nodes can have links to multiple groups at varying strengths. This function shows those multiple links.

127.1 Parameters

Select the number of trees per node:
Select the tree size:

127.2 Example

I used the agent x task network and ran the FOG group viewer on is. Following is the progression of groups from 1 to 3 using the parameters in the dialog above.
The group at the bottom right consists primarily of the SGC members.
The group at the bottom left consists primarily of the Tok-ra and the Tollan.
The top group has one singular member and links to three members of the other groups.

Osiris is the only person not belonging to any of the above mentioned groups and the function placed her in the group it deemed most fitting.
Group Viewer-Johnson

Below is an image of the Group Viewer Johnson window and procedures for applying the Johnson algorithm.

128.1 Parameters

Relationship type:
- Similarity
- Dissimilarity

Link method:
- SingleLink
- CompleteLink
- AverageLink
129 Group Viewer - K-FOG

Below is an image of the Group Viewer K-Fog window and procedures for applying the K-FOG algorithm.

129.1 Parameters

Select the number of trees per node:
Select the tree size:
Using the numbers Number of trees per node=2 and tree size=2 I created ten sets of runs for 2 groups. Below is a sample of the first run.
After 10 runs the following numbers were obtained. Each run gave successively varying results with the top ten nodes with multiple links as follows:

<table>
<thead>
<tr>
<th>TOTAL RUNS</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>defend_revenna</td>
<td>9</td>
</tr>
<tr>
<td>hide_data_crystal</td>
<td>6</td>
</tr>
<tr>
<td>present_plan_to_sgc</td>
<td>5</td>
</tr>
<tr>
<td>find_tunnel_crystals</td>
<td>4</td>
</tr>
<tr>
<td>fly_cargoshop</td>
<td>4</td>
</tr>
<tr>
<td>create_memory_drug</td>
<td>4</td>
</tr>
<tr>
<td>Ren'al</td>
<td>3</td>
</tr>
<tr>
<td>infiltrate_summit</td>
<td>3</td>
</tr>
<tr>
<td>find_ring_room</td>
<td>3</td>
</tr>
<tr>
<td>poison_jaffa_at_gate</td>
<td>3</td>
</tr>
</tbody>
</table>

130Group Viewer-Newman

Below is an image of the Group Viewer window and procedures for applying the Newman grouping algorithm:

![Group Viewer window](image)

This window will let you compute and visualize groups within the currently visible network. Select the algorithm you want to see, then compute the groups and select the number of groups.

Algorithm: **Newman**

Select a number of groups to see: 4

[Compute] [Reset] [Close]
The Newman grouping is used to find clusters in a network. I began increasing the number of groups to view until the larger cluster began to break up.

In this case the nodes remained clustered (with only one or two nodes breaking off) until I reached 4 as the number of groups. Then the network broke up into two large and two small clusters. The nodes in each of the two large clusters have a commonality as to the organizations they belong to and the tasks they were assigned.

**131KeySet Selector**

Below is an image of the Stargate data set visualized. We will use the KeySet selector to simplified this visualization.
131.1 Visualizer Commands

The Show Only Checked Items, Add Checked Items, Show All But Checked Items, Remove Checked Items all work on selecting/deselecting nodes within the table from where they can be checked or unchecked for display.

Create Meta-Node

Highlight Checked Items
132 Keyset Selector Examples

Following is a short example of the KeySet Selector. It covers the main aspects of the tool only.

In the Filter Commands textbox the word poison is typed which causes all nodes with poison in any attribute to be revealed. Pressing the [Select All] button places a checkmark in all the nodes.
Lastly in the Visualizer Commands pressing the [Show Only Checked Items] button hides all but the checked items.

The [Clear All] button is pressed to clear all the checkmarks. poison is replaced in the Filter Commands with the word sg-1. Be aware that even though only nodes with sg-1 are to be added the two nodes with sg-17 also appear as sg-1 is a sub-string of sg-17. SO instead of using the [Select All] button checkmarks are manually placed in the checkboxes desired.
The [Add Checked Items] button is pressed and the four new nodes are added to the Visualizer.

With the four nodes of sg-1 still check marked press the [Highlight Checked Items]. The four nodes are now displayed in a larger format.

The last button, [Create Meta-Node] will cull nodes into a Meta-Node.
**Legend**

The Legend dialog box allows you to quickly hide and reveal nodes and links in the Visualizer. Use the checkboxes to change a NodeSets visibility. When you first call up the Visualizer all the boxes will contain checkboxes...

![Legend](image)

...and in the Visualizer all nodes and links are revealed. A little hard to make heads or tails of something like that.
By using the Legend checkboxes you can selectively show/hide nodes and links. Deselect the checkbox to the left of Agent. Instantly all of the Agent nodes are hidden along with any connections they had with the rest of the nodes. The node structure is a little easier to see now.

Next think about a particular set of connections you'd like to see, say a task x task network and how the agents relate to the tasks.
From the Legend box menu select Control => Hide All nodes. Then again from the menu Control => Refresh Legend. Now place checkmarks in the checkboxes for agent, task, and task x task. All the tasks will be linked together as per your network and all the agents will have connections to the tasks they are associated with.

Another example is how knowledge relates to specific tasks. From the Legend menu select Control => Hide All Nodes. Now place checkmarks next to knowledge, task, and
Now the Visualizer reveals which knowledge is required for which specific tasks.

### 134 Legend Control Menu

Below is an image of the Legend Control window:

<table>
<thead>
<tr>
<th>Control</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show All Entities</td>
<td></td>
</tr>
<tr>
<td>Hide All Entities</td>
<td></td>
</tr>
<tr>
<td>Refresh Legend</td>
<td></td>
</tr>
</tbody>
</table>

- **Show All Nodes**: Will bring into view all entities in the MetaNetwork. Good to use if you need to make a fresh start.
- **Hide All Nodes**: Hides every entity. Good starting point when you only wish to display a small subset of entities.
- **Refresh Legend**: After using the menu items above and/or using the checkboxes this item will bring the Visualizer up to date.

### 135 Legend Edit Menu

Below is an image of the Legend Edit Menu and a description of this tool:

<table>
<thead>
<tr>
<th>Edit</th>
<th>Control</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Copy Legend Image to Clipboard</td>
</tr>
</tbody>
</table>

- **Copy Legend Image to Clipboard**: Copies an image of the entire legend that can be pasted into an image-editing program.

### 136 Node Color
The color of a NodeSet can be changed in the Visualizer. Below are procedures for doing this task.

136.1.1 **NOTE**: This color change is in effect for as long as the Visualizer is open. If you close and re-open the Visualizer the colors will revert to their default colors.

Here is a section with the default colors of red for agents and cyan for tasks.

Open the Legend window (if it's not open already) and click once on the NodeSet you want to change. This will bring up the Color Change dialog window.

Select [OK] and the new color will be displayed for the chosen NodeSet.
The newly selected color appears in both the Visualizer and Legend windows.
Node Shaper

The Node Shaper allows you to change the size of individual node(s) or assigning pictures. Below is an image of the Node Shaper window and a description of how to change the shape of the nodes in your model.
1. Select a Style: Select from three Node Style Sizes or use an image in its place of the node.
2. Select a Shape: An optional shape can be used instead of the Node Set’s default shape. The node will retain its default NodeSet color.
3. Select Node to Re-Shape: The bottom section contains the controls for selecting which nodes to work with. Typing anything in the Find textbox will automatically filter out non-matching nodes.
4. NodeSet tabs: Select which NodeSets to view. ALL shows every node or the tabs will show only their individual NodeSets.
5. Checkboxes: Place a checkmark in the box next to the nodes you want to change.
6. Filters: Use for filtering based on individual attributes. You can filter on more than one attribute at time. An example can be found in Create a new Meta-Network.
7. Select/Clear All buttons: Will either Select or Clear all VISIBILE nodes. If a check marked node has been filtered out and is currently NOT visible when the Clear All button is pressed, then that node will retain its checkmark and be affected by future changes.
8. Apply/Load Changes: After any changes have been made to the top portions selecting the [Apply Changes] buttons will cause them to be displayed in the Visualizer.
9. Close:

138 Node Shaper Examples (using images)
138.1 Original agent x agent Network

Below is the agent x agent network in the normal medium sized nodes.
We will proceed to change the shape of the nodes to varying sizes as well as add image and picture icons to the nodes.
138.2 Multiple Sized Nodes

By using the Find textbox and the Filters I placed checkmarks in all members of the SGC. Then the Large Node Style was selected and the [Apply Changes] button was pressed.
138.3 Picture Replacement

Here three different symbols were used to denote 1) the SG-1 team (the blue circles), 2) the SG-17 team (the green circles), and 3) the SGC who are not members of either team. This was accomplished by filtering which group was to be displayed. Then checkmarks were placed and Image Node Style was selected. Then for each group an individual picture was applied to all the selected nodes together.

Lastly is the ability to assign a picture of the actual person the node represents (or location, object, etc.).

138.3.1 NOTE: It's suggested that any picture to be used should be reduced to a maximum of 40 x 40 pixels before importing as this is the size ORA will reduce it automatically.
How the Node Shaper Changes the NodeSet

What follows are examples of how the Node Shaper changes the NodeSet. Whenever the Node Shaper is called and a node is assigned something other than its default shape, new attributes will be added to every NodeSet, not just the NodeSet you're working with.

- **Drawing Type**: This will define what type of node is to be drawn, shape of image. There are three options for size (small, medium, and large) and one option for image.
- **Nodes Shape**: There are four large shapes (circle, rectangle, ellipse, and hexagon), eight medium shapes (circle, hexagon, down triangle, pentagon, diamond, square, up triangle, and octagon), and one small shape.
- **Image**: Contains the name of the file associated with that node.

Changing one node will create these three attributes and place the default value in every node in every NodeSet. Any of these attributes can be manually changed from within the Main Interface Editor.
This is useful if you have changed many nodes and want to restore them all to their defaults quickly and easily. The quickest way is using the Copy and Paste method.

Column "1" contains the modified values. In column "2" three values of medium are highlighted and copied using Ctrl-C. In column "3" the cursor is moved to the top cell and Ctrl-V is used to paste those three values in. In column "4" this is repeated until all values are back to their defaults.

If the Image attribute contained a filename then changing Drawing Type to image will re-link that file to the picture. Any of the four Drawing Type values can be placed in this column.
140 View Networks Over Time

The Networks Over Time loads multiple Meta-Networks into the Visualizer and displays them as Time Slices. What follows are procedures to do this:

First, highlight the Meta-Networks to load into the Visualizer. For this example I divided the whole Stargate Summit network into four distinct phases. 1) The meetings; 2) What was supposed to happen; 3) What did happen; 4) The attack on the Tok'ra home world. These are Summit 1-4.

The dialog box appears for you to verify you've chosen the correct Meta-Networks. Place a checkbox in the ones you want or Check All. Then select [View].
To control the Over Time function from the main menu, select Tools => Networks Over Time.

The Phase Duration has two controls. Transition Phase duration sets the amount of time in milliseconds for the fading out of the previous set and the fading in of the new set. The Display Phase duration sets the amount of time in milliseconds that a set will be displayed before moving to the next set.

Constant maintains a node's position throughout all Time Slices. Determined by Time Slice allows you to move a node independently in each Time Slice.

Record Node Locations upon Exiting a Meta-Network maintains a node's position when changing Time Slices. NOTE: It does not maintain the node's positions after you exit the Visualizer. Upon returning to the Visualizer all nodes will be in default positions.

The Slider bar controls which Time Slice is displayed. The buttons at the bottom, [Play] and [Stop] control the motion display.
140.1 Summit-1

The initial meetings between the SGC and the Tok'ra

140.2 Summit-2

The plan as it was supposed to go
140.3 Summit-3

What really happened when Osiris showed up unexpectedly. Instead of poisoning the Summit daniel_jackson decides to forgo that action after hearing the information from Osiris. He's almost found out but still escapes.

140.4 Summit-3

What was happening back on Revenna while daniel_jackson was at the Summit.

140.4.1 NOTE : Measures and reports run on these multi-MetaNetworks are for all connections, not the individual MetaNetworks.
141 The Path Finder

The Path Finder is used to find, not only, the shortest path between two nodes but also paths to other nodes when particular situations occur. Below is an image of the The Path Finder tool and a description of its various elements.

141.1 The interface contains four sections:

Start node: Select the NodeSet/Node to begin the path.
End node: Select the NodeSet/Node to end the path.
Options: Options regarding link parameters and which NodeSets to use.
Advanced Options: Options regarding whether, and how, to use one particular node within the set.
141.2 Using only Agent nodes (tolerance = 0)

Using only the Agent NodeSet the pathway requires three intervening nodes.

<table>
<thead>
<tr>
<th></th>
<th>col_jack_o'neill</th>
<th>maj_samant...</th>
<th>daniel_jackson</th>
<th>teal'c</th>
<th>gen_hammond</th>
</tr>
</thead>
<tbody>
<tr>
<td>col_jack_o'neill</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>5.0</td>
<td>0.0</td>
</tr>
<tr>
<td>maj_samant...</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>daniel_jackson</td>
<td>-1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>-1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>teal'c</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>gen_hammond</td>
<td>-5.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

141.2.1 NOTE: For this example the values in the Network have been altered from the regular values.

141.3 Tolerance of "1", nothing else checked.

141.3.1.1 Shortest path: 1

141.3.1.2 There is the direct link from gen_hammond to col_jack_o'neill and the secondary pathway with teal'c in the middle.

141.4 Use link direction

141.4.1.1 Shortest path: 2

The path direction must lead from the source to the target.

141.4.1.2 The link from gen_hammond to col-jack-o'neill is removed as it's a directional link in the wrong direction. The shortest link is "2".
141.5 Use link weight (Remove links with negative values)

141.5.1.1.1 Shortest path: 6

141.5.2 Use link weights finds the shortest path from A to B using minimal weights as opposed to minimal number of links. Also the shortest path is the total of the link weights — not the number of links total.

141.5.2.1 The shortest path is from col_jack_o'neill to teal'c (5) then from teal'c to gen_hammond (1) for a total of "6".

141.6 Use link weight (Convert negative links to positive values)

141.6.1.1.1 Shortest path: 3

Uses the absolute values of numbers. A negative number becomes a positive number.
141.7 Use link direction and link weight with absolute values

141.7.1.1 Shortest path: 3
142Sphere of Influence

Each node within a network has a unique Sphere of Influence or Ego Network. Essentially it’s a direct relationship with its neighbors as a function of specified path length. The ORA Visualizer allows you to focus on this relationship by creating an Ego Map centered on any particular node you choose.

From the Visualizer Main Menu select Tools => Sphere of Influence.
The following dialog box will then appear. From here you can select the Size of your sphere’s influence, the node Sets, and Key Sets to use.
142.1 Select a sphere of influence radius

The drop down box allows you to choose the path length for a particular node(s). The value starts out at 0. Below is an example of a radius of 0, 1, 2, and 3. In many other cases the links will branch out as you increase the radius.

Auto-Zoom: Maximizes your ego network within the Visualizer.
Auto-Center: Keeps the visualized Ego Network centered within the Visualizer display.
Hide connections between levels: Removes any connections between nodes that do not have a connection to any node in the filter.
Expand only these nodes: Allows you to select the components you wish to have displayed in a node’s Sphere of Influence.
Filter Commands: Used for selecting the filters to use on the current visualization.
Node selection table: Allows the selection of individual nodes for visualization. First selected is symbiote_poison in the bottom table. Then the NodeSets events and locations were added. Only the nodes that are linked to the original symbiote_poison are displayed in the Visualizer.
142.2 A Sphere of Influence Example

This example will show how to take one node and expand upon it to show how it is related to nodes in other node sets. First, from the table at the bottom, select a node. Here we select the symbiote_poison. From the Expands only these nodes: place a checkmark in location. It reveals that symbiote_poison is connected to two locations, revanna and hasaraSystem_spaceStation.

Next we'll place a checkmark next to tasks:. This reveals that there are two tasks that relate directly to symbiote_poison, poison_jaffa_at_gate and poison_summit.
Now that we've got a couple of nodes on the screen let's increase the radius of the sphere to 2. The tree will now display all nodes within 2 links of symbiote_poison.

Lastly you can eliminate any node sets by removing them from the list. Remove the checkmark from tasks: to reveal only the locations up to two links away.

The Sphere of Influence allows you to hone your search and show only the nodes you need to see.
143 Visualizer Tools

The ORA Visualizer provides a suite of tools to visually analyze your Meta-Network:

<table>
<thead>
<tr>
<th>Tools</th>
<th>Layouts</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Viewer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key Set Selector</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legend</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meta-Nodes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Finder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sphere of Influence</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block Maps</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Networks Over Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Shaper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vector Maps</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Drill Down

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall node class knowledge, tasks, resources, agents) or by choosing individual nodes from a checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer:

Node Status

The Node Status Window is selected by default. It first pops-up when you select any node in the Visualizer. This window provides you with a snapshot of the currently selected node by displaying that nodes unique Attributes, Measures, and Neighbors.

Group Viewer

Allows viewing of current display to be viewed in various grouping: CONCOR, Newman, Johnson, FOG, and K-FOG

Key Set Selector

Helps put a set of arbitrary items on the screen.

Legend

Allows for toggling visibility of nodes and links on the fly.

Meta-Nodes

A Meta-Node contains multiple nodes collapsed into one. You can create Meta-Nodes based on the NodeSets in your organization, or you can create Meta-Nodes based on the attributes of the nodes. To create Meta-Nodes, you must access the Meta-Node Manager.

Path Finder

The Path Finder allows you to focus or drill down on a particular node, or multiple nodes, that you may be interested in analyzing in greater detail.

Sphere of Influence
Each node within a network has a unique Sphere of Influence or Ego Network, essentially it's direct relationship with its neighbors as a function of specified path length.
Block Maps

Block Maps display varying intensities of data by displaying “blocks” correlating to the value of data. For instance, a block map displaying node centrality values would reserve the largest block for the node highest in that value. Color is used to as well to visualize different values with the darkest color reserved for the highest value. Block Maps can also be referred to as heat maps.

Networks Over Time

Allows you to view a version of your network across multiple time periods.

Node Shaper

Allows the altering of nodes on an individual basis including shape, size, and image changes.

Vector Maps

144Hide Links With Weight

ORA can visualize your network with only the more weighted links displayed. Below are procedures to accomplish this task.

You can select to hide links either Less Than or Greater Than a certain value. Below is an agent x location network. And there are three tooltips displayed for jacob_carter for the values of 1.0, 2.0, and 3.0. We'll keep the hiding style as Less Than.
First we'll increase the value to 1.1 hiding all lower values. The link to the hasaraSystem_spaceStation is removed from view. The others, however are still on the screen.

Now let's increase the value to 2.1. This removes the link from jacob_carter to revenna.

If we increases to value to 3.1 then all of the links would be removed. In this way you can remove links which are of lesser important to concentrate on a smaller set of data.
Hyperbolic View

The Hyperbolic function creates a bulge within your visualization adding a sense of depth. By moving the slider from right to left, you can increase or decrease this bulge effect and create different depth-added views. By moving the network around the window you can create the view you need. The Hyperbolic radio button and slider can be found at the bottom of the window.

This tool is useful when nodes may be very tight on screen such as the ones in the following images. Using the Hyperbolic tool you can help space them out for easier viewing. Here is how to do so:

145.1.1.1  **Note**: The Hyperbolic function, when selected, converts the slider to this feature. This is also true of using the zoom and rotate functions. Use all three in conjunction to get your visualization just the way you want it. Scroll down below this screen shot for another when viewed with the Hyperbolic feature.
Select the Hyperbolic tool and move the slider to the right. Then click-and-hold on some part of the white background and move the entire network to the left. You will notice the space between the nodes begins to increase the closer they come to the center of the screen.

Now the nodes are able to be read much easier.

**145.1.1.2  Note:** It is useful to use this tool in conjunction with the Rotate and Magnify tools to obtain just the view you desire.
Show / Hide Labels

Node labels, which often prove helpful in describing Networks, can sometimes clutter a visualization. Thus, it may be necessary to eliminate labels from your visualization. The following procedure will help clarify the screen when it is clouded by the many labels:

1. To remove labels go to Visualizer tool bar and find the Show Labels button.

This initial screen shot shows the Visualizer with all the labels.

When you click the Label button on the Visualizer tool bar ORA toggles the labels on and off. Note that now a much more clearer conceptual picture of the network is produced. You can flip between the two views.
147 Removing nodes In The Visualizer

You can remove nodes directly from the ORA Visualizer by right clicking on a node and selecting Hide Node. Below is an example of removing an node using the Hide Node tool.

Find the node you want to hide. Here we will hide ren'al.

Place the cursor over the node and right-click on the node to bring up the contextual menu. Highlight Hide node. gen_hammond and the four task nodes are now separated from the rest of the network.
Rotating A Visualization

You can rotate a visualization with the slider bar at the bottom of the interface or from the tool bar at the top. To do this from the slider bar, click the rotate option toward the bottom of the interface. This activates the rotate feature.

As you move the slider from the left to right, your visualization will rotate correspondingly. From the tool bar, you can click inside the rotate icon, which will turn the visualization depending on exactly where you clicked.

In the screen shot below, the yellow ellipses highlight where to access ORA's rotate tool both at the bottom and top of the Visualizer interface.

*Note: Use the rotate feature in tandem with the magnifying glass to find a visualization's maximum screen size.*
149 The Tool Bar Explained

This section explains the function of each of the toolbar's buttons. When you first load a Meta-Network you will see the pause button depressed in the Visualizer tool bar. You can layout the Meta-Network by clicking the play button. The visualization will space apart across the screen. This is called laying out a Network. The Visualizer is separating nodes and links that, at first, appear on top of each other. You can pause this process again when you think the Meta-Network is satisfactorily spaced apart or you can let ORA lay out the entire Meta-Network. Your computer speed, as well as the complexity of Meta-Network, will determine how long this takes.

149.1 Copy Paste

The Copy Paste feature allows you quickly capture a visualization and save it to be pasted into another document later.

149.2 Play / Pause

The Play Pause function works very similar to the play pause feature on any device. The pause button (two vertical bars) is depressed, the Visualizer stops laying out a Meta-Network. When the play button is depressed (right pointed triangle) ORA Visualizer begins laying out the Meta-Network as described above. The red ellipse highlights on the tool bar where this feature is located and accessible.

149.3 Magnifying / Maximizing

The Magnifying Glass icon with the plus sign inside it, allows you to instantly fill the Visualizer window pane with the currently rendered Meta-Network. The red circle in the screen shot above highlights where to access this feature on the Visualizer tool bar. If there are any nodes off screen, clicking the button once will bring all the nodes into view on the screen.

NOTE: This function works well when selecting a small part of your overall Meta-Network and magnifying it to fill the Visualizer screen.
149.4 Rotating The Visualization

See also Rotating a Visualization

To Rotate your visualization look for the word next to the Noon-pointing sundial icon in the tool bar. This feature is another way to manipulate your visualization to fill the entire Visualizer window pane.

NOTE: Use this feature in conjunction with the magnifying glass function to work your visualization into largest size possible.

Show Labels
See also Show/Hide Labels

The Show Labels button allows you to toggle the labels on & off in the Visualizer. Default is ON.

149.5 Show Links

The Show Links button allows you to toggle the links on & off in the Visualizer. Default is ON.

149.6 Show Arrows

The Show Arrows button allows you to toggle the arrows on & off in the Visualizer and show directional data. Default is OFF.

149.7 Font Size

The Font Size allows for setting the size of the font in the Visualizer
This allows you to change the size of the font to suit your needs for each individual Visualizer set. It ranges from 4, which is almost unreadable, to extremely large numbers, which can also be unreadable by virtue of overcrowding. So pick the size of font that best suits your screen.

**149.8 Node Size**

The Node Size allows for changing the node size, larger or smaller by increments of one. Four is the smallest size possible and creates a very small, difficult to see dot. As the number increases is becomes easier to see the individual nodes until the number gets to a point where it can simply overpower the screen. But this gives you the ability to customize the entity size to suit your needs.

**149.9 Link Width**

The Link Width allows for changing the general width of the line, larger or smaller. And as the options before you can pick the exact size which best suits your needs for the display.
149.10 Meta-Node Size

See also Creating a Meta-Node

Use the Meta Node Manager to handle creating and removing Meta-Nodes.

149.11 Node Sizes

The Toggle Node Size button rotates through three sizes for the nodes (as seen below).
149.12 Pointers

The Visualizer uses two modes of pointers.

The left pointer, Pan Image, controls the movement of the screen. Press and hold the mouse button and move the mouse to move the screen.

The right pointer, Select Nodes, selects a group of nodes. Press and hold the mouse button. Moving the mouse selects nodes within the area scanned area.

NOTE: Selecting a second set of nodes will De-Select the first set.
NOTE: Dashed marquee used in example only. Not seen in actual program.

149.13 Hide Links by Weight

Hide Links by Weight

Use the Hide Links with Weight to select which links to display. As long as there are links with different values you can hide links of smaller values leaving only the more important links visible. This can assist in seeing links that might normally be too cluttered to view. Below left is a Meta-Network with all links in view. Below right is the same Meta-Network with links less than 2.0 hidden.
**Zooming**

At the bottom of the Visualizer interface is a sliding zoom bar (image below). You can drag the scrollbar left (to zoom out) or right (to zoom in).

In the screenshot below the zoombar has been set to the far left, the absolute zoom out possible. At this point very little is distinguishable.
In the next shot the zoombar has been placed almost to the far right, absolute zoom in. It allows for extreme close-ups of various parts of the Meta-Network.

Note: Clicking on the Magnifying glass in the Visualizer tool bar will set the view to include all visible nodes.
FOG indicates that nodes can belong to more than one group in varying strengths and that there is a likelihood that those nodes will participate in events associated with the groups it is connected to.

Before you start it is a good idea to Show link Weights. This will assist you in seeing more clearly the strength of the connections from each node to each group.

From the Visualizer menu select Option => Show link Weights
From the Visualizer menu select Tools => Group Viewer

After the Group Viewer appears select FOG from the drop-down menu. Then select the [Compute] button.
The display starts out with all agents connected to one single group. You'll notice that some links are weighted heavier than others.

Under Select a number of groups to see: increase the number to 2 groups. For this example let's concentrate on ali_mohamed. At 2 groups he is connected to both of them. Thusly he still has contact with the entire network. His connection with the group on the left is stronger than his connection to the group on the right.

Now let's increase the display to 3 groups. ali_mohamed is still connected to 2 groups but there is a third group he is not connected to.
After an increase to 4 groups you can see that ali_mohamed is still connected to basically the same people as before but the grouping is again changed and ali_mohamed is connected to 3 of the 4 groups. You'll notice that the strength of the link to the group in the lower left is the strongest connection and he has no connection to the group in the lower right.

Our final increase to 5 groups shows little change to the groups on the left but the groups that ali_mohamed are not connected to have split into 2 separate groups.

By left-clicking on any node or group you bring up the Node Status dialog box from where you can retrieve information about its attributes, measures, and neighbors.
151.1.1 IMPORTANT!

After you run the FOG Group viewer there are Node Sets and Graphs that are created in the Matrix. These will be displayed in any future work in the Visualizer. If you do not need them after you are done with the Group Viewer then don't forget to delete them. Deleting the Node Set for the FOG group will delete any associated Graph.

Mouse Overs

When you pass the pointer over any Node in the Visualizer a yellow tooltip box will appear showing information on links to other nodes as well as values for measures that have been run.

Below is a screenshot comparing two mouse-overs.
Attribute: If an attribute is empty ORA will leave a blank line for that attribute. Only if the attribute has a value will it be displayed.

Neighbors: displays all the links to other nodes.

The option to turn the mouse-over ON or OFF can be found on the menu at Options => Show Mouse Overs. The checkmark denotes whether or not the Mouse Overs are active.
153 Visualizer Patterns

This is a list of common patterns that can make it easier to find various clusters as the underlying structure of your network.

- 153.1 No Links
- 153.2 Group
- 153.3 Bowtie
- 153.4 Chain
- 153.5 Circle
- 153.6 Star
<table>
<thead>
<tr>
<th>153.7 Cognitive Demand</th>
<th>153.8 Degree Centrality</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Cognitive Demand Diagram" /></td>
<td><img src="image2" alt="Degree Centrality Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>153.9 Eigenvector Centrality</th>
<th>153.10 High Betweenness and No Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Eigenvector Centrality Diagram" /></td>
<td><img src="image4" alt="High Betweenness and No Degree Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>153.11 Exclusivity</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Exclusivity Diagram" /></td>
<td></td>
</tr>
</tbody>
</table>
The ORA Visualizer

The ORA Visualizer renders a Meta-Network graphically. It allows you to interact with your data in a variety of ways: remove key actors, isolate certain links, or focus on any particular relationship by using tools such as the Path Finder and grouping algorithms. Below is a visualized Meta-Network of the Stargate Summit/Last Stand dataset. In this view all nodes and links are visualized.
Most of the time it's easier to visualize the individual networks. Below is the agent x event network.

With the tools in the Visualizer you can pick the exact nodes and links you wish to visualize.

**155 Visualizer Contextual Menus**

Most of the functions you'll need in the Visualizer are accessible from ORA's in ORA's contextual menu by right-clicking on any of the entities inside a visualization.

Below is an image of the contextual menu that appears when you right-click a node in the Visualizer:
Select Node
Select Node highlights the selected node. Selecting a node a second time un-highlights it.

Hide Node
Hide Node removes the selected node (along with all links) from view in the Visualizer.

Center Node
Brings the node to the center of the Visualizer.

Pin Node
Works as a toggle in pinning and unpinning a node. While a node is pinned it is unaffected when the [Play] button is pressed or the user moves other nodes around the screen. Allows for the creation of a more understandable screen display.

Expand Node
Shows all nodes and links connected to the selected node.

Set Picture
Combine into Meta-Node
Multiple nodes can be selected and combined into a Meta-Node which will contain links to all the nodes that the individual nodes had. The four large circles of SG-1 are selected. The and green circles show which tasks are associated with these agents. Press, and hold, the Control key while selecting each node for the Meta-Node. Then without releasing the Control key, right-click one of the nodes to bring up the contextual menu. Select Combine into Meta-Node.
After combining the task nodes that were linked to the individual nodes are now linked to the sg-1 Meta-Node.

155.1.1 NOTE: If additions or deletions of NodeSets needs done expand the Meta-Node before proceeding.

Add Comment

Attaches a comment to the currently selected node. Good for making notes for display purposes.
Delete Selected Node(s)

Allows for the deletion of nodes from a Meta-Network from within the Visualizer.

**155.1.2 NODE :** This deletion is permanent once the Meta-Network is saved. If there is any question regarding the deletion then remove the Meta-Network from ORA before saving and reload the Meta-Network.

155.2 Pin Submenu

**Pin All Nodes**

Globally pins all nodes. Nodes are unaffected by the [Play] button or the movement of other nodes.

**Unpin all Nodes**

Removed the pinning of all nodes.

**Pin Selected Node(s)**

If the selected node(s) is unpinned this makes the selected node immobile in the Visualizer.

**Unpin Selected Node(s)**

If the selected node is pinned this makes the node mobile again and will be affected by the Play button.
155.3 URL Submenu

**Attach URL**
Can attach a URL that is associated with the node. The first time this function is used it will create a new attribute in the NodeSet and give the node’s attribute the value you typed in.

**Go To URL**
Will open up your default browser and go to the URL that is saved for the node selected.
ORA Charts

157.1 Charts

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map. ORA Charts can be accessed through the Main Interface by clicking the View Charts For This MetaNetwork button in the MetaNetwork Composer window pane or from the Main Interface drop down menu.

From the Main Menu select Data Visualization => Charts; OR
Select the [Charts] button.

In the screen shot below, ellipses highlight both methods to access ORA Charts.
After choosing Reports, the following pop-up window will appear. Select the network you are interested in Charting and select the [Next] button. For this example, we will simply select the currently loaded network Agents. ORA produces the following Bar Chart, displayed in the screen shot below.

By now, you should be able to access ORA Charts by loading a MetaNetwork by either using the [Charts] button in the MetaNetwork Composer window pane or from the Main Menu of the main interface. See Chart Types Explained for more detailed information about the four chart types.
157.2 Chart Types Explained

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram.

157.3 ORA Bar Chart

A bar chart, also known as a bar graph, is a chart with rectangular bars of lengths usually proportional to the magnitudes or frequencies of what they represent. Bar charts are used for comparing two or more values. The bars can be horizontally or vertically oriented. Sometimes a stretched graphic is used instead of a solid bar.
A scatter plot, scatter diagram or scatter graph is a chart that uses Cartesian coordinates to display values for two variables. The data is displayed as a collection of points, each having one coordinate on the horizontal axis and one on the vertical axis. 

A scatter plot does not specify dependent or independent variables. Either type of variable can be plotted on either axis. Scatter plots represent the association (not causation) between two variables. 

A scatter plot can show various kinds of relationships, including positive (rising), negative (falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it suggests a positive correlation between the variables being studied. If the pattern of dots slopes from upper left to lower right, it suggests a negative correlation. A line of best fit can be drawn in order to study the correlation between the variables. An equation for the line of best fit can be computed using the method of linear regression.
157.5 Histogram

The word histogram is derived from *histos* and *gramma* in Greek, the first meaning web or mast and the second meaning a drawing, record or writing. A histogram of something is thus, etymologically speaking, a drawing of the web of this something.

In statistics, a histogram is a graphical display of tabulated frequencies. Moreover, a histogram is the graphical version of a table which shows what proportion of cases fall into each of several or many specified categories.

The histogram differs from a bar chart in that it is the area of the bar that denotes the value, not the height, a crucial distinction when the categories are not of uniform width (*Lancaster, 1974*). The categories are usually specified as non-overlapping intervals of some variable. The categories (bars) must be adjacent.
Over-Time Viewer

The Over-Time Viewer enables you to study changes within your organization or network over a time period. For instance, the overall centrality value of your network can be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. Please note that the time interval is dependent only on your data collection samples. Such an analysis can then be compared to external or internal events.

As an example, let us say you are interested in learning how the events of September 11, 2001 affected a terrorist organization or how the passing of anti-terrorism legislation impacted the same network. In either case, you can run measures in the Over Time Viewer on your network samples (loaded as multiple MetaNetworks) then compare the results against such external events.

There are three lessons showing the functions of the Overtime Viewer.

1. Lesson 5: Overtime Viewer
2. Lesson 6: Immediate Impact
3. Lesson 7: Near Term Impact Analysis

The Over-Time Viewer enables you to study changes within your organization or network over a time period. For instance, the overall centrality value of your network can be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. Please note that the time interval is dependent only on your data collection samples. Such an analysis can then be compared to external or internal events.

As an example, let us say you are interested in learning how the events of September 11, 2001 affected a terrorist organization or how the passing of anti-terrorism legislation impacted the same network. In either case, you can run measures in the Over Time Viewer on your network samples (loaded as multiple MetaNetworks) then compare the results against such external events.
Measures

ORA Measures

ORA contains well over 100 measures. A measure is a function that takes as input a Meta-Network and outputs a single value or a vector of values. Consider the measure Density. The output for this measure is a single number used to analyze an organization. By default, all measures are run on a Meta-Network. To view which measures are available, go to the Tools menu and select the Measures Manager.

The Measures Manager dialog box will appear. A drop down box displays the measures in ORA.
The Measures Manager categorizes measures in the following ways: Entity Level, Graph Level, and Risk Category.

An Entity Level Measure is one that is defined for, and gives a value for, each entity in a network. If there are x nodes in a network, then the metric is calculated x times, once each for each node. Examples are Degree Centrality, Betweenness, and Cognitive Demand.

A Graph Level Measure is one that is defined for, and gives a value for, the network as a whole. The metric is calculated once for the network. Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness.

Some reports use a predefined set of measures, and these are not affected by the Measure Manager selections (for example, the Intel, Context, Located SubGroups, Sphere of Influence, and Immediate Impact reports). The Risk Report, however, uses only the measures selected in the Measure Manager.

The following sets of entities (with their abbreviated symbol) are used throughout the document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following networks defined on these entity sets are used throughout the documentation.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Entity Sets</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>AA</td>
<td>Agent</td>
<td>Communication Network</td>
</tr>
<tr>
<td>AK</td>
<td>Agent Knowledge</td>
<td>Knowledge Network</td>
</tr>
<tr>
<td>AR</td>
<td>Agent Resource</td>
<td>Capabilities Network</td>
</tr>
<tr>
<td>AT</td>
<td>Agent Task</td>
<td>Assignment Network</td>
</tr>
<tr>
<td>KK</td>
<td>Knowledge Knowledge</td>
<td>Information Network</td>
</tr>
<tr>
<td>KR</td>
<td>Knowledge Resource</td>
<td>Training Network</td>
</tr>
<tr>
<td>KT</td>
<td>Knowledge Task</td>
<td>Knowledge Requirement Network</td>
</tr>
<tr>
<td>RR</td>
<td>Resource Resource</td>
<td>Resource Substitute Network</td>
</tr>
<tr>
<td>RT</td>
<td>Resource Task</td>
<td>Resource Requirement Network</td>
</tr>
<tr>
<td>TT</td>
<td>Task Task</td>
<td>Precedence Network</td>
</tr>
</tbody>
</table>

161.1 Input:

This lists each of the Networks that are required as input to the measure. If a measure takes as input a specific network from the Meta-Network, such as the Agent x Knowledge (AK) matrix, then it is listed. If the measure runs on any square (unimodal) network then N is given. A measure can require more than one input matrix.

a. Each input matrix can have one or more of the following requirements:
   i. square: the matrix must have the same number of rows as columns
ii. binary: it must be binary data (i.e. any links in the network are assumed to have a weight of one)
iii. symmetric: the network must be undirected

b. ORA does the following when a network does not meet one or more of the above requirements:
   i. square: measure is not computed
   ii. binary: measure is computed, and edge weights are ignored (all edges are given value one)
   iii. symmetric: measure is computed, and the matrix is first symmetrized using the union method

A complete list of all measures available in ORA, along with references, input and output specifications, can be found in the following ORA Measures sections.

162 Access Index: Knowledge and Resource

The average shortest path length between entities, excluding infinite distances. The Boolean value is true if a particular agent is the only agent who knows a piece of knowledge and who is known by exactly one other agent. The one agent known also has its KAI set to one. 
Ashworth, 2003

TYPE: Entity Level

INPUT:

Knowledge: AK: binary; AA: binary

Resource: AR: binary; AA: binary

OUTPUT: Binary

The Knowledge Access Index (KAI) for agent i is defined as follows:

let

\[ S_i = \{s \mid AK(i, s) \land (\text{sum}(AK(:, s)) = 1) \land (\text{sum}(A(i, :) = 1)) \} \]

for Resource replace AK with AR

Then

\[ KAI_i = \left( S_i \neq \emptyset \right) \lor \left( \exists j \mid S_j \neq \emptyset \land A(j, i) = 1 \right) \]

for Resource replace KAI with RAI
Actual Workload, Knowledge and Resource Based

The knowledge an agent uses to perform the tasks to which it is assigned. Carley, 2002

**TYPE:** Entity Level

**INPUT:**

Knowledge: AK: binary; KT: binary; AT: binary

Resource: AR: binary; RT: binary; AT: binary

**OUTPUT:** $\mathcal{R} \in [0, 1]$

Actual Workload for agent $i$ is defined as follows:

$$\left[ AK \times KT \times AT^\prime \right](i, i) / \text{sum}(KT)$$

*Note how Potential Workload is the first matrix product.*

**Measure:** Average Distance

The average shortest path length between entities, excluding infinite distances.

**TYPE:** Agent Level

**INPUT:** $N$: square, binary

**OUTPUT:** Graph Level:

$\mathcal{R} \in [0, N]$  

Let $G=(V,E)$ represent a square network. Define a set $S$ of all pairs $(i,j)$ of entities such that $i$ can reach $j$. Then average the shortest paths.

let $S = \{(i,j) \mid j \text{ is reachable in } G \text{ from } j \}$

Then,

$$\text{Average Distance} = \frac{\sum_{(i,j) \in S} d_G(i, j)}{|S|}$$
**Boundary Spanner**

An entity which, if removed from a network, creates a new component. This is often called a Gate Keeper entity.

High betweenness, low centrality. An employee with few direct connections, but if removed from the network will result in an unconnected sub-group.

Cormen, Leiserson, Riverest, Stein, 2001 p.558

TYPE: Agent Level

INPUT: N: square, binary, symmetric

OUTPUT: Entity level: Binary

A Boundary Spanner is an articulation point of N, as defined in the referenced book.

**Boundary Spanner**

An entity which, if removed from a network, creates a new component. This is often called a Gate Keeper entity.

High betweenness, low centrality. An employee with few direct connections, but if removed from the network will result in an unconnected sub-group.

Cormen, Leiserson, Riverest, Stein, 2001 p.558

TYPE: Agent Level

INPUT: N: square, binary, symmetric

OUTPUT: Entity level: Binary

A Boundary Spanner is an articulation point of N, as defined in the referenced book.

**Boundary Measures**

Boundry Spanner :
Boundry Spanner, Potential
**Breath Column/Row**

This is the fraction of entities with column/row degree greater than one.

**TYPE:** Entity Level

**INPUT:** N: binary

**OUTPUT:** $\bar{R} \in [0,1]

Let $d = \text{the Column degree vector of the network } N$

Then, the Column Breadth of $N$ is:

$$\frac{\sum_{i=1}^{\mid d \mid} (d_i > 1)}{\mid d \mid}$$

**NOTE:** Row breadth is identical, except that $d$ is defined using the row degree, rather than the column degree.

**Capability**

This computes the number of connections for each entity. Then scales the value based on the variation from the average degree

**TYPE:** Entity Level

**INPUT:** N: square, binary

**OUTPUT:** $\bar{R} \in [0,1]

Let $RD = \text{the vector of row degrees for each entity in the network. Scale } RD \text{ by dividing each element by the largest value in } RD.$

Then the Capability of node $i$ is:

$$\frac{1}{(1.0 + e^{-(RD_i - 0.5)*10})}$$

**Note:** for the most connected entity, this value tends to 1.0, for the least connected node it tends to 0, and for the average connected entity it tends to 0.5.
Centrality, Betweenness

Betweenness tells us which node is the most connected to other parts of a network. For example, Betweenness can tell us which person in a network is the most central to the network as a whole. Betweenness measures the number of times that connections must pass through a single individual to be connected.

This measure indicates the extent that an individual is a “broker of indirect connections” among all others in network. One might say someone with high Betweenness is a gatekeeper of information flow. People that occur on many shortest paths among other People have highest Betweenness value. Betweenness is one of the key measures used by those interested in networks.

Freeman, 1979

TYPE: Entity Level

INPUT: N: square

OUTPUT: \( \sum R \in [0,1] \)

Let \( G=(V,E) \) be the graph representation for the network. Let \( n=|V| \), and fix an entity \( v \in V \).

For \( (u,w) \in V \times V \), let \( n_G(u,w) \) be the number of geodesics in \( G \) from \( u \) to \( w \).

If \( (u,w) \in E \), then set \( n_G(u,w)=1 \).

Define the following:

let

\[
\begin{align*}
S &= \{ (u, w) \in V \times V \mid d_G(u, w) = d_G(u, v) + d_G(v, w) \} \\
\text{between} &= \sum_{(u,w) \in S} (n_G(u, v) \times n_G(v, w)) / n_G(u, w) \\
\text{let} &= \frac{\text{between}}{(n-1)(n-2)/2}.
\end{align*}
\]

Then Betweenness Centrality of the entity \( v = \text{between} / ((n-1)(n-2)/2) \).

Note: if \( G \) is not symmetric, then between is normalized by \( (n-1)(n-2) \).
**Centrality, Bonacich Power**

The Bonacich Power Centrality computes the centrality of each entity based on the centrality of its neighbors. Beta should be chosen such that its absolute value is less than the reciprocal of the largest eigenvalue of N.


**INPUT:** N: square

**OUTPUT:**

Let $A$ = adjacency representation of the network $N$. Then Bonacich Power Centrality for the network is the solution $c$ to the following system of linear equations:

$$(I - \beta A)^{-1} c = A e,$$

where $I$ is the identity matrix, and $e$ a vector of ones.

*Note that if beta is 0, then $c$ is simply equal to the row degree of each entity.* The values of $c$ are not normalized.
Closeness measures the path length from one person to another in a network. For example, it tells us which person is central to an organization. Moreover, Closeness reveals how long it takes information to spread from one individual to others in the network. High scoring individuals in Closeness have the shortest paths to all others in the network. It would follow such individuals could monitor the information flow in an organization better than most others that have a lesser Closeness value. The ones with the highest value in this measure will often times have the best picture of what is happening in the network as a whole.

Freeman, 1979

TYPE: Entity Level

INPUT: N: square

OUTPUT: \( R \in [0,1] \)

Let \( G = (V,E) \) be the graph representation of the square network.

Fix

\( v \in V \)

let

\[
\text{dist} = \sum_{i \in V} d_G(v,i)
\]

, if every entity is reachable from \( v \).

Then Closeness Centrality of entity

\[
v = (|V|-1)/\text{dist}.
\]

If some entity is not reachable from \( v \) then the Closeness Centrality of \( v \) is \(|V|\).
172Centrality, Eigenvector

Eigenvector Centrality reflects one's connections to other well-connected people. A person connected to many isolated people in an organization will have a much lower score in this measure than those that are connected to people that have many connections themselves. This would be true even if such a WHO might have a high amount of actual connections (i.e. high degree centrality).

It follows that a person well-connected to well-connected people can spread information much more quickly than one who only has connections to lesser important people in a network. People with higher scores of Eigenvector Centrality could be critical when rapid communication is needed.

Bonacich P, 1972

TYPE: Entity Level

INPUT: N: square, symmetric

OUTPUT: \( R \in [0,1] \)

Calculates the eigenvector of the largest positive eigenvalue of the adjacency matrix representation of a square network. A Jacobi method is used to compute the eigenvalues and vectors.
173Centrality, In Degree

Degree Centrality measures how many other people are connected to a particular WHO we are interested in studying. For example, it can tell us how many people someone in an organization talks to based on their degree centrality value? Degree Centrality is one of the key measures used by those interested in networks.

How you measure degree centrality depends on whether the network is symmetric (i.e. if A is connected to B is B connected to A?) and whether you want an answer that is normalized (i.e. to lie between 0 and 1 so that you can compare the degree centrality across networks of different size).

Wasserman and Faust, 1994

TYPE: Entity Level

INPUT: N

OUTPUT: $R \in [0,1]$  

Consider the matrix representation $X$ of a network with m rows and n columns. Each column $j$ is assigned an in-degree centrality based on the sum of entries in its column.

The In-Degree Centrality for column $j$

$$\text{column } j = \frac{1}{m} \sum_{i=1}^{m} X(i, j)$$

This measure is also called Column Degree Centrality.
174Centrality, Information

Calculates the Stephenson and Zelen information centrality measure for each entity.

Information centrality is a network metric that accounts for indirect as well as shortest (geodesic) paths among entities. Information centrality is similar to betweenness, except that betweenness considers only shortest paths geodesics, whereas information centrality also considers more circuitous paths weighted by the inverse of the path length (the number of links along the path). Entities high in information centrality are more likely to get more information and to get information faster.

Wasserman and Faust, 1994 (pg. 195)

TYPE: Entity Level

INPUT: N: square

OUTPUT: Entity Level:

\[ R \in [0,1] \]

Calculates the measure described on pg 195-6 of Wasserman and Faust. Isolates (entities with no edges) are first removed from the network, and the measure computed on the resulting sub-graph. The isolates are given centrality value 0.
175Centrality, Inverse Closeness

The average closeness of an entity to the other entities in a network. Inverse Closeness is the sum of the inverse distances between an entity and all other entities. This is defined for directed networks.

Wasserman and Faust, 1994 (pg 195)

TYPE: Node Level

INPUT: N: square, binary

OUTPUT: $R \in [0,1]$

Let $G=(V,E)$ be the graph representation of the square network.

Fix $v \in V$ let

$$\text{dist} = \sum_{i \in V} \frac{1}{d_G(v,i)}$$, where $\frac{1}{d_G(i,i)} = 0$ and $\frac{1}{d_G(v,i)} = 0$

if $i$ is not reachable from $v$.

Then, Inverse Closeness Centrality of entity $v = \text{dist}/(|V|-1)$. 
176Centrality, Out Degree

Degree Centrality measures how many other people are connected to a particular WHO we are interested in studying. For example, it can tell us how many people someone in an organization talks to based on their degree centrality value? Degree Centrality is one of the key measures used by those interested in networks.

How you measure degree centrality depends on whether the network is symmetric (i.e. if A is connected to B is B connected to A) and whether you want an answer that is normalized (i.e. to lie between 0 and 1 so that you can compare the degree centrality across networks of different size).

Wasserman and Faust, 1994

TYPE: Entity Level

INPUT: N: square

OUTPUT: \( ^R \subseteq [0,1] \) (If N is binary)

Consider the matrix representation X of a network with m rows and n columns. Each row i is assigned an out-degree centrality based on the sum of entries in its row.

The Out-Degree Centrality

\[
\text{row } i = \frac{1}{n} \sum_{j=1}^{n} X(i, j)
\]

This measure is also called Row Degree Centrality.
177 Centrality, Total Degree

Degree Centrality tells us the relative number of direct connections a WHO might have in a network; the higher the score the more likely a WHO might be likely to receive and potentially pass on critical information that flows through the organization.

Total Degree Centrality is one of the key measures of social network analysis and Dynamic Network Analysis.

Wasserman and Faust, 1994 (pg 199)

TYPE: Entity Level

INPUT: N:square

OUTPUT: \( R \in [0,1] \)

Consider the matrix representation \( X \) of a square network with \( n \) entities. Each entity is assigned a value based on the sum of its row and columns.

The Total Degree Centrality for entity \( i \) is given by:

\[
 entity \ i = \frac{1}{2(n-1)} \sum_{i=1}^{n} \sum_{\substack{j=1 \atop i \neq j}}^{n} X(i, j)
\]

Note that the diagonal values are ignored.

Clique Count

Computes the number of distinct cliques to which each entity in a square, undirected network belongs.

Counts the number of sub-groups where the members are completely connected to each other. It reflects sub-structures in the network that contribute to a cohesive whole.

Wasserman and Faust, 1994 (pg 254)

TYPE: Node Level

INPUT: N:square, symmetric

OUTPUT: \( G \) (not scaled)

A clique of an undirected, square network is defined in Wasserman and Faust as a maximal complete subgraph of three or more nodes. The clique detection algorithm employed is the Bron-Kerbosch maximal clique algorithm, which is Algorithm 457 of the Collected Algorithms from CACM.
178 Clustering Coefficient, Watts-Strogatz

Measures the degree of clustering in a network by averaging the clustering coefficient of each entity. The clustering coefficient of an entity is the density of its ego network which is the sub graph induced by its immediate neighbors.

Clustering Coefficient (graph level)

Definition

The average of the proportion of links between each employee and his or her direct neighbors divided by the number of links that could possibly exist between them.

Interpretation

The clustering coefficient gives a sense of the local characteristics of the network—how information spreads by means of employee groups. A higher clustering coefficient supports local information diffusion as well as a decentralized infrastructure because employees are likely to share information and know what is happening in their work group.

Watts and Strogatz, 1998

TYPE: Graph Level, Entity Level
INPUT: N: square, binary
OUTPUT:

Graph Level: \( S_R \in [0,1] \)

Entity Level: \( S_R \in [0,1] \)

let \( G=(V,E) \) be the graph representation of a square network.
Define for each node \( v \in V \) its Clustering Coefficient \( cc_v \):
let \( G_v \) = ego network of entity \( v \)
Then Clustering Coefficient for

\[ cc_v = \text{density}(G_v) \]

Then Clustering Coefficient for the graph

\[ S_R = \frac{\sum_{v \in V} cc_v}{|V|} \]
Cognitive Demand

Cognitive Demand measures the total amount of effort expended by each agent to do its tasks. Individuals who are high in cognitive demand value are emergent leaders. Removal of these individuals tends to be quite disruptive to networks.

Note: The minimum input requirement is the AA network. All other networks are optional.

Carley, 2002

TYPE: Agent Level

INPUT: AA:binary; [AT:binary]; [AR:binary]; [RT:binary]; [AK:binary]; [KT:binary]; [TT:binary]

OUTPUT: Agent Level:

\[ R \in [0,1] \]

The Cognitive Demand for an agent \( i \) is an average of terms, each of which measures an aspect of its cognitive demand. Each term is normalized to be in \([0,1]\). The number of terms depends on the input networks. The computation of each term for agent \( i \) is detailed below:

let \( x_1 = \) # of agents with which \( i \) interacts

\[ = \text{sum}(\text{AA}(i,:)) / (|A|-1) \]

let \( x_2 = \) # of tasks to which \( i \) is assigned

\[ = \text{sum}(\text{AT}(i,:)) / |T| \]

let \( x_3 = \) sum of the # of agents assigned to the same tasks as \( i \)

\[ = \text{sum}(\text{ATA}(i,:)-\text{ATA}(i,i)) / (|T|(|A|-1)), \text{ where } \text{ATA} = AT*AT' \]

let \( x_4 = \) # of resources \( i \) manages

\[ = \text{sum}(\text{AR}(i,:)) / |R| \]

let \( x_5 = \) # of knowledge \( i \) manages

\[ = \text{sum}(\text{AK}(i,:)) / |K| \]

let \( x_6 = \) sum of # resources \( i \) needs for all its tasks

\[ = \text{sum}(\text{ATR}(i,:)) / (|T|*|R|), \text{ where } \text{ATR} = AT*RT' \]

let \( x_7 = \) sum of # knowledge \( i \) needs for all its tasks
= \text{sum}(\text{ATK}(i,:)) / (|T|*|K|), \text{ where } \text{ATK} = \text{AT}*\text{KT}'

let \(x_8\) = sum of resource negotiation needs i has for its tasks

= \text{HammingDistance}(\text{AR}(i,:), \text{[AT*RT']}(i,:)) / |R|

let \(x_9\) = sum of knowledge negotiation needs i has for its tasks

= \text{HammingDistance}(\text{AK}(i,:), \text{[AT*KT']}(i,:)) / |K|

let \(x_{10}\) = sum of agents that i depends on or that depend on i

let \(w\) = \# number of agents assigned to each task

= \text{colsum}(\text{AT})

let \(s\) = \# agents that dependent on each task

= (T+T')*w

let \(v\) = \# tasks that agents are dependent on

= \text{AT}*s

Then, \(x_{10} = v(i) / (|A|*|T|*(|T|-1)).\)

Then Cognitive Demand for agent i is the average of the above terms.
180 Cognitive Distinctiveness
180.1 AKA: Cognitive Distinctiveness, Relative or Distinctiveness Correlation

Measures how distinct are two agents based on the number of knowledge bits they hold oppositely.

Carley, 2002

TYPE: Dyad Level

INPUT: AK: binary

OUTPUT: $R \in [0,1]$

For each pair of agents $(i,j)$ compute the number of knowledge bits they have exactly opposite. Then normalize this sum by the total number of knowledge bits. In effect, this is the exclusive-OR of their knowledge vectors.

$$CD_{i,j} = \frac{\sum_{k=1}^{|K|} (AK_{i,k} \sim AK_{j,k}) + (\sim AK_{i,k} \sim AK_{j,k})}{|K|}$$

$CD_{i,i} = 0$

Note that the CD output matrix is symmetric.

Relative Cognitive Distinctiveness normalizes each element of CD as follows:

$$RCD_{i,j} = \frac{CD_{i,j}}{\sum_{j=1}^{|K|} CD_{i,j}}$$

Thus, the elements of the ith row are normalized by the ith row sum.
181 Cognitive Expertise
181.1 AKA: Cognitive Expertise, Relative or Expertise Correlation

Measures the complementarity of two agents based on their knowledge.

Carley, 2002

TYPE: Dyad Level

INPUT: AK: binary

OUTPUT: $\mathcal{R} \in [0,1]$

For each pair of agents $(i,j)$ compute the number of knowledge bits that $j$ knows that $i$ does not know. Then normalize this sum by the total number of knowledge bits that agent $i$ does not know.

$$CE_{i,j} = \frac{\sum_{k=1}^{\left| K \right|} (\sim AK_{i,k} + AK_{j,k})}{\left| K \right| - \sum_{k=1}^{\left| K \right|} AK_{i,k}}$$

$CE_{i,i} = 0$

Note that the CD output matrix is NOT-symmetric.

Relative Cognitive Expertise normalizes each element of CE as follows:

$$RCE_{i,j} = \frac{CE_{i,j}}{\sum_{j=1}^{\left| K \right|} CE_{i,j}}$$

Thus, the elements of the $ith$ row are normalized by the $ith$ row sum.
182 Cognitive Resemblance
182.1 AKA: Cognitive Resemblance, Relative or Resemblance Correlation

Measures the degree of resemblance between agents based on the number of knowledge bits they both have or both do not have.

Carley, 2002

TYPE: Dyad Level

INPUT: AK: binary

OUTPUT: \( R \in [0,1] \)

For each pair of agents \((i,j)\) compute the number of knowledge bits they have in common - whether known or unknown. Then normalize this sum by the total number of knowledge bits.

\[
CR_{i,j} = \frac{\sum_{k=1}^{[K]} (AK_{i,k} \ast AK_{j,k}) + (\sim AK_{i,k} \ast \sim AK_{j,k})}{|K|}
\]

\( CR_{i,i} = 1 \)

Note that the CR output matrix is symmetric.

Relative Cognitive Resemblance normalizes each element of CR as follows:

\[
RCR_{i,j} = \frac{CR_{i,j}}{\sum_{j=1}^{[K]} CR_{i,j}}
\]

Thus, the elements of the ith row are normalized by the ith row sum.
Cognitive Similarity

183.1 Cognitive Similarity, Relative or Similarity Correlation

Measures the degree of similarity between agents based on the number of knowledge bits they both have.
Carley, 2002

TYPE: Dyad Level
INPUT: AK: binary
OUTPUT: $R \in [0,1]$

For each pair of agents (i,j) compute the number of knowledge bits they have in common. Then normalize this sum by the total knowledge between them.

$$CS_{i,j} = \frac{\sum_{k=1}^{[K]} (AK_{i,k} \ast AK_{j,k})}{\sum_{k=1}^{[K]} (AK_{i,k} + AK_{j,k})}$$

$$CS_{i,i} = 1$$

183.1.1.1 Note that the CS output matrix is symmetric.
Relative Cognitive Similarity normalizes each element of CS as follows:

$$RCS_{i,j} = \frac{CS_{i,j}}{\sum_{j=1}^{[K]} CS_{i,j}}$$

Thus, the elements of the ith row are normalized by the ith row sum.
Communication

Measures the degree of similarity between agents based on the number of knowledge bits they both have.
Carley, 2003
TYPE: Agent Level
INPUT: AA:binary; AT:binary; AR:binary; RT:binary, TT:binary
OUTPUT: 0 ≤ R ≤ 1
Communication uses the concepts from Communication Congruence: Handoff, Co-Assignment, and Negotiation.

let H, C, and N be defined as in Communication Congruence.

let M(i,j) = [AA + (H+H') + C + (N+N')](i,j) > 0, and M(i,i) = 0

Note that the transpose of H and N is used to make the communication reciprocal.

let d = sum(M(i,:))

let d = d / (|A|-1), normalizing d to be in [0,1]

Then Communication for agent i is d.

Component Measures

Component Count, Strong:
Component Count, Weak:
Component Memebers, Weak:
 Component Count, Strong

The number of strongly connected components in a network.

Wasserman and Faust, 1994 (pg 109)

TYPE: Graph Level

INPUT: N:square, binary

OUTPUT: $Z \in [0, |V|]$

Given a square, symmetric network $G=(V,E)$, the Strong Component Count is the number of strongly connected components in $G$. This is computed directly on $G$, whether or not $G$ is directed.

 Component Count, Weak

The number of weakly connected components in a network.

Wasserman and Faust, 1994 (pg 109)

TYPE: Graph Level

INPUT: N:square, binary, symmetric

OUTPUT: $Z \in [0, |V|]$

Given a square, symmetric network $G=(V,E)$, the Weak Component Count is the number of connected components in $G$. Such components are called weak because the graph $G$ is undirected.
Component Members, Weak

Assigns each entity an integer which corresponds to the weak component in the network to which it belongs.

Wasserman and Faust, 1994

TYPE: Node Level

INPUT: N: square, binary, symmetric

OUTPUT: $Z \in [0, |V|]$

Given a square, symmetric network $G=(V,E)$, the Weak Component Member for an entity is the weak component to which the entity belongs. The components are numbered from 1 to the number of weak components (Weak Component Count).

Congruence Measures

Agent Knowledge Needs/Waste:
Communication:
Organization Agent Knowledge/Resource Needs:
Organization Agent Knowledge/Resource Waste:
Organization Task Knowledge/Resource Needs:
Organization Task Knowledge/Resource Waste:
Social Technical:
Strict Knowledge:
Task Knowledge Needs/Waste:
Congruence, Agent Knowledge Needs / Congruence, Agent Resource Needs

The number of skills that an agent lacks to complete its assigned tasks expressed as a percentage of the total skills required for the assigned tasks.

Lee, 2004

TYPE: Agent Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT: $R \in [0,1]$ 

Agent Knowledge Needs compares the knowledge needs of the agent to do its assigned tasks, with the actual knowledge of the agent.

Let $N = AT \times KT' = \text{knowledge needed by agents to do assigned tasks.}$

*for Resource replace KT with RT*

We need to sum the knowledge needed but not available.

Then, Agent Knowledge Needs for

$$\text{agent } i = \frac{\sum_{j=1}^{|[K]|} N_{i,j} \times (\sim AK_{i,j})}{\sum_{j=1}^{|[R]|} N_{i,j}}$$

*Agent Resource Needs is analogous, replacing AK with AR, and KT with RT.*
**Agent Knowledge Waste / Agent Resource Waste**

The number of skills that an agent has that are not needed by any of its tasks expressed as a percentage of the total skills of the agent.

Lee, 2004

**TYPE:** Agent Level

**INPUT:** AK/AR: binary; KT/RT: binary; AT: binary

**OUTPUT:** $\overline{R} \in [0,1]

Agent Knowledge Waste compares the knowledge of the agent with the knowledge it actually needs to do its tasks. Any unused knowledge is considered wasted.

Let $N = AT \times KT' = \text{knowledge needed by an agent to do its assigned tasks.}$

*For Resource replace KT with RT*

We need to sum the knowledge the agent has but which is not needed.

Then, Agent Knowledge Waste for

$$\text{agent } i = \frac{\sum_{j=1}^{[K]} AK_{i,j} \times (N_{i,j} = 0)}{\sum_{j=1}^{[R]} AK_{i,j}}$$

*The equation for Agent Resource Waste replaces AK with AR, and KT with RT.*
Congruence, Communication

Measures to what extent the agents communicate when and only when it is needful to complete tasks. Hence, higher congruence occurs when agents don't communicate if the tasks don't require it, and do when the tasks require it.

Communication needs to be reciprocal.

Carley, 2002

TYPE: Graph Level

INPUT: AA: binary, AT: binary, [AR/RT]: binary, [AK/KT]: binary, TT: binary

OUTPUT: $\mathcal{R} \in [0,1]$  

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the measure first concatenates them into [AK AR], [KT RT] and uses them.

Communication Congruence = 1 if agents communicate when and only when it is needful to complete their tasks. There are three task related reasons when agents $i$ and $j$ need to communicate:

(a) Handoff: if $i$ is assigned to a task $s$ and $j$ is assigned to a task $t$ and $s$ directly precedes task $t$.

(b) Co-Assignment: if $i$ is assigned to a task $s$ and $j$ is also assigned to $s$.

(c) Negotiation: if $i$ is assigned to a task $s$ and $j$ is not, and there is a resource $r$ to which agents assigned to $s$ have no access but $j$ does.

The three cases are computed as follows:

(a) let $H = AT^*TT^*AT'$

(b) let $C = AT^*AT'$

(c) let $N = AT^*Z^*AR'$, where $Z(t,r) = [AT^*AR - RT'](t,r)<0$

Note that $C$ is always symmetric, but not necessarily $H$ and $N$.

Let $Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0$.

Communication Congruence requires reciprocal communication, explaining the transposes of $H$ and $N$ to make them symmetric.

Let $d =$ hamming distance between $Q$ and $AA$, which measures the degree to which communication differs from that which is needed to do tasks.

The maximum value for $d$ is $d_{\text{max}} = |A|^*|A|-1$

Then Communication Congruence = $1 - (d /d_{\text{max}})$, which is in $[0,1]$. 

406
**Congruence, Organization Agent Knowledge Needs / Organization Agent Resource Needs**

Across all agents, the skills that agents lack to do their assigned tasks expressed as a percentage of the total skills needed by all agents.

Lee, 2004

**TYPE:** Graph Level

**INPUT:** AK/AR:binary; KT/RT:binary; AT:binary

**OUTPUT:** $\mathcal{R} \in [0,1]$

As in Agent Needs, let $N = AT \cdot KT'$

*for Resource replace KT with RT*

Then

$$\text{Organization Agent Needs} = \frac{\sum_{i=1}^{|A|} \sum_{j=1}^{|K|} N_{i,j} \cdot (\sim AK_{i,j})}{\text{sum}(N)}$$

*Organization Agent Resource Needs is analogous, replacing AK with AR, and KT with RT.*
Congruence, Organization Agent Knowledge Waste / Organization Agent Resource Waste

Across all agents, the skills that agents have that are not required to do their assigned tasks.

Lee, 2004

TYPE: Graph Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT: $R_R \in [0,1]$

As in Agent Waste, let $N = AT^*KT'$

for Resource replace KT with RT

Then

\[
\text{Organization Agent Needs} = \frac{\sum_{i=1}^{\mid A \mid} \sum_{j=1}^{\mid K \mid} AK_{i,j} \times (N_{i,j} = 0)}{\text{sum}(AK)}
\]

The equation for Organization Agent Resource Needs replaces AK with AR, and KT with RT.
Congruence, Organization Task Knowledge Needs / Organization Task Resource Needs

Across all tasks, the skills that tasks lack expressed as a percentage of the total skills needed by all tasks.

Lee, 2004

TYPE: Graph Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT: $S^R \in [0,1]$

As in Task Needs, let $S = AT^*AK$

for Resource replace AK with AR

Then

$$\text{Organization Task Needs} = \frac{\sum_{i=1}^{[T]} \sum_{j=1}^{[K]} KT_{i,j}^t * (S_{i,j} = 0)}{\text{sum}(KT)}$$

The equation for Organization Task Resource Needs replaces AK with AR, and KT with RT.
Congruence

Organization Task Knowledge Waste / Organization Task Resource Waste

Across all tasks, the skills supplied to tasks via agents that are not required by them, expressed as a percentage of the total skills needed by all tasks.

Lee, 2004

TYPE: Graph Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT: Graph Level:

\[ R \in [0,1] \]

As in Task Waste, let \( S = AT^*AK \)

_for Resource replace AK with AR_

Then

\[
\text{Organization Task Waste} = \frac{\sum_{i=1}^{T} \sum_{j=1}^{K} S_{i,j} \ast (\sim KT_{i,j})}{\text{sum}(S)}
\]

The equation for Organization Task Resource Waste replaces AK with AR, and KT with RT.
**Congruence, Social Technical**

Social technical congruence represents the proportion of coordination requirements that were satisfied through some type of actual coordination activity carried out through some means of communication.

Cataldo et al, 2006

**TYPE:** Task Level

**INPUT:** AT, TT, AA

**OUTPUT:** Real Number in [0,1]

\[ R \in [0,1] \]

A representation of the coordination requirements among the different workers is obtained by multiplying AT, TT and transpose of AT matrices. This product results in a people by people matrix where a cell \( ij \) indicates the extent to which person \( i \) works on tasks that share dependencies with the tasks worked on by person \( j \). In other words, the resulting matrix represents the Coordination Requirements or the extent to which each pair of people needs to coordinate their work. Formally, the Coordination Requirements (CR) matrix is determined by the following product:

Let, \( CR = AT \times TT \times transpose(AT) \)

Given a particular CR matrix constructed from relating product dependencies to work dependencies, we can compare it to an Actual Coordination (CA) matrix that represents the interactions workers engaged in through different means of coordination.

\[ Diff(CR, CA) = card\{ diff_{ij} | crij > 0 & caij > 0 \} \]

\[ |CR| = card\{ crij > 0 \} \]

We have,

\[ Congruence(CR, CA) = Diff(CR, CA) / |CR| \]
Congruence, Strict Knowledge/Strict Resource

Measures the similarity between what knowledge is assigned to tasks via agents, and what knowledge is required to do tasks. Perfect congruence occurs when agents have knowledge when and only when (strictly) it is needful to complete tasks.

Carley, 2002

TYPE: Graph Level

INPUT:

Knowledge: AK:binary; AT:binary; KT:binary

Resource: AR:binary; AT:binary; RT:binary

OUTPUT: $\mathcal{K} \in [0,1]$

Knowledge Congruence = 1 if agents have knowledge when and only when it is needful to complete their tasks. Thus, we compute the knowledge assigned to tasks via agents, and compare it with the knowledge needed for tasks.

let $KAT = \text{dich}(AK' \cdot AT)$

_for Resource KAT becomes RAT and replace AK with AR_

let

$$d = \sum_{i=1}^{K} \sum_{j=1}^{T} KAT(i, j) \cdot KT(i, j)$$

_for Resource replace KT with RT_

let $<d = d' / (|K| \cdot |T|)$, which normalizes d to be in [0,1]

_for Resource replace |K| with |R|

Then Knowledge Congruence = 1 - d
Congruence, Task Knowledge Needs / Congruence, Task Resource Needs

The number of skills not supplied to a task, and required to do the task, expressed as a percentage of the total skills required for the task.

Carley, 2002

TYPE: Task Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT:

\[ \mathcal{R} \in [0,1] \]

Task Knowledge Needs compares the knowledge requirements of each task with the knowledge available to the task via agents assigned to it. It is similar to Knowledge Congruence, but quantifies only the under supply of knowledge to tasks.

Let \( S = AT^*AK \) = knowledge supplied to tasks via assigned agents

We need to sum the knowledge required but not supplied.

Thus,

\[
\text{Task Knowledge Needs for task } i = \frac{\sum_{j=1}^{[K]} KT^t_{i,j} \cdot (S_{i,j} = 0)}{\sum_{j=1}^{[K]} KT^t_{i,j}}
\]

The equation for Agent Resource Needs replaces AK with AR, and KT with RT.
200Congruence, Task Knowledge Waste / Congruence, Task Resource Waste

The number of skills supplied to a task via agents that are not required by it expressed as a percentage of the total skills required for the task.

Carley, 2002

TYPE: Task Level

INPUT: AK/AR:binary; KT/RT:binary; AT:binary

OUTPUT: Task Level:

$\mathcal{R} \in [0,1]$

Task Knowledge Waste compares the knowledge requirements of each task with the knowledge available to the task via agents assigned to it. It is similar to Knowledge Congruence, but quantifies only the over supply of knowledge to tasks.

Let $S = AT^*AK =$ knowledge supplied to tasks via assigned agents

We need to sum the knowledge supplied but not required.

Thus,

$$\text{Task Knowledge Waste for task } i = \frac{\sum_{j=1}^{\lvert K \rvert} S_{i,j} \ast (\sim KT_{i,j}^t)}{\sum_{j=1}^{\lvert K \rvert} S_{i,j}}$$

The equation for Agent Resource Waste replaces AK with AR, and KT with RT.
201 Connectedness, Krackhardt

Measures the degree to which a square network’s underlying (undirected) network is connected.

Krackhardt, 1994

TYPE: Graph Level

INPUT: N: square, symmetric

OUTPUT: $\mathcal{R} \in [0,1]

The Connectedness of a square, symmetric network is the Density of its Reachability Network.

202 Constraint, Burt

The degree to which each entity in a square network is constrained from acting because of its existing links to other entities.

Burt, 1992

TYPE: Node Level

INPUT: N: square

OUTPUT: $\mathcal{R} \in [0,1]

This is the Constraint measure described by Equ. 2.4 on pg. 55 of Burt, 1992. Note that the matrix $Z$ is the adjacency matrix representation of the network $N$. 
203Density

The ratio of the number of edges versus the maximum possible edges for a network.

Density compares existing links to all possible links in the employee communication network. It reflects the social level of organizational cohesion. This measure must be interpreted in relation to the size of the group and the type of work performed.

Wasserman and Faust, 1994 (pg 101)

TYPE: Graph Level

INPUT: N

OUTPUT: \( \mathcal{R} \in [0,1] \)

Let \( M \) be the adjacency matrix for the network of dimension \( m \times n \).

If the network is unimodal, then \( m=n \) and \( M \) has a zero diagonal, and therefore

\[
\text{Density} = \frac{\text{sum}(M)}{(m^*(m-1))}.
\]

For rectangular networks, \( \text{Density} = \frac{\text{sum}(M)}{(m*n)} \).

204Diameter

The maximum shortest path length between any two nodes in a unimodal network \( G=(V,E) \). If there exist \( i,j \) in \( V \) such that \( j \) is not reachable from \( i \), then the diameter is returned as \( |V| \).

Wasserman and Faust, 1994 (pg 111)

TYPE: Graph Level

INPUT: N:square, binary

OUTPUT: \( Z \in [0, |V|] \)

The diameter of \( G=(V,E) \) is defined as:

\[
\max \left\{ d_G(i,j) \mid i, j \in V \right\}
\]

That is, the maximum shortest directed path between any two vertices in \( G \). If there exists \( i \) and \( j \) such that \( j \) is not reachable from \( i \), then \( |V| \) is returned.
205 Diversity, Knowledge/Resource

The distribution of difference in idea sharing. This is the Herfindahl-Hirshman index applied to column sums of AK.

Characterizes the network in terms of how the items in a knowledge or resource network (who knows what) are non-uniformly distributed across employees

Borgatti, 2003

TYPE: Graph Level

INPUT:

Knowledge: AK:binary

Resource: AR:binary

OUTPUT: $\mathcal{R} \in [0,1]$

This is the Herfindahl-Hirshman index (economics: sum of the squares of each firm's market share) applied to the normalized column sums of AK. This measures the degree to which knowledge is equally known.

let

$$W_k = \sum_{i=1}^{[A]} AK(i,k), \text{ for } 1 \leq k \leq \vert K \vert$$

let

$$W = \sum_{k=1}^{\vert K \vert} W_k$$

Then

$$\text{Knowledge Diversity} = 1 - \sum_{k=1}^{\vert K \vert} \left( \frac{W_k}{W} \right)^2$$

Resource Diversity is analogous, replacing AK with AR.
206 Edge Count, Lateral

Fixing a root entity \( x \), a lateral edge \((i,j)\) is one in which the distance from \( x \) to \( i \) is the same as the distance from \( x \) to \( j \).

Carley, 2002

TYPE: Graph Level

INPUT: \( N: \text{square} \)

OUTPUT: \( R \in [0,1] \)

Let \( G=(V,E) \) be the graph representation of a network. And fix an entity \( x \) \{element of\} \( V \) to be the root entity.

Let

\[
S = \{ (i,j) \in E \mid d_G(x,i) = d_G(x,j) \}
\]

Then Lateral Edge Count = \( |S| / |E| \)

207 Edge Count, Pooled

A pooled edge in a network \( N=(V,E) \) is an edge \((i,j)\) \{element of\} \( E \) such that there exists at least one other edge \((i,k)\) \{element of\} \( E \), and \( k \neq j \).

Carley, 2002

TYPE: Graph Level

INPUT: \( N \)

OUTPUT: \( R \in [0,1] \)

Let \( M \) be the adjacency matrix representation of a unimodal network.

Let \( S = \{ (i,j) \mid M(i,j)=1 \land \sum(M(:,j))>1 \} \)

In other words: edge \((i,j)\) is a pooled edge iff the in-degree of entity \( j > 1 \).

Then Pooled Edge Count = \( |S| / |E| \)
208 Edge Count, Reciprocal

The percentage of edges in a network that are reciprocated (also called Reciprocity). An edge \((i,j)\) in the network is reciprocated if edge \((j,i)\) is also in the network. Self-loops are ignored.

Carley, 2002

TYPE: Graph Level

INPUT: N: square, binary

OUTPUT: \(\mathcal{R} \in [0,1]\)

Let \(G=(V,E)\) be the graph representation of a network.

Let \(S=\text{card}\{ (i,j) \in E | i<, (j,i) \in E \}\)

Then Reciprocal Edge Count = \(\frac{|S|}{|E|}\)

209 Edge Count, Sequential

The percentage of edges in a network that are neither Reciprocal Edges nor Pooled Edges. Note that an edge can be both a Pooled and a Reciprocal edge. Self-loops are ignored.

Carley, 2002

TYPE: Graph Level

INPUT: N: square, binary

OUTPUT: \(\mathcal{S} \in [0,1]\)

Let \(G=(V,E)\) be the graph representation of a network, and let \(X = \text{set of Pooled edges of } G\), and let \(Y = \text{set of Reciprocal edges of } G\).

Then Sequential Edge Count = \(\frac{|E-X-Y|}{|E|}\)
210 **Edge Count, Skip**

The fraction of edges in a unimodal network that skip levels. An edge \((i,j)\) is a skip edge if there is a path from entity \(i\) to entity \(j\) even after the edge \((i,j)\) is removed.

Carley, 2002

**TYPE:** Entity Level

**INPUT:** \(N\): square, binary

**OUTPUT:** \(S_R \in [0,1]\)

A skip edge in a network \(G=(V,E)\) is an edge \((i,j) \in E\) such that \(j\) is reachable from \(i\) in the graph \(G'=(V,E\setminus (i,j))\), that is, the graph \(G\) with edge \((i,j)\) removed. Skip Count is simply the number of such edges in \(G\) normalized to be in \([0,1]\) by dividing by \(|E|\).

211 **Effective Network Size**

The effective size of an entities’ communication Network based on redundancy of ties.

Burt, 1992

**TYPE:** Entity Level

**INPUT:** \(N\): square, binary

**OUTPUT:** \(S_R \in [0,1]\)

This is the Effective Size of Network measure described by Equ. 2.2 on pg. 52 of Burt, 1992. Note that the Communication Network is used for the matrix \(Z\).
212Efficiency, Global

Measures the closeness of the entities in the network.

Latora and Marchiori, 2001

TYPE: Graph Level

INPUT: N:square, binary, symmetric

OUTPUT: $\mathcal{R} \in [0,1]$

Global Efficiency is the normalized sum of the inverse geodesic distances between all entity pairs. Let $G$ be a square network on $n$ entities.

Then,

$$\text{Global Efficiency} = \frac{1}{n(n-1)} \sum_{i \neq j} \frac{1}{d_G(i, j)}$$
Efficiency, Krackhardt

The degree to which each component in a network contains the minimum edges possible to keep it connected.

Krackhardt, 1994

TYPE: Graph Level

INPUT: N: square, binary, symmetric

OUTPUT: $R \in [0,1]$

Let $G=(V,E)$ be the graph representation of a square, undirected network.

let

\[ n = \text{number of components in } G \]

let

\[ c_i = \text{number of nodes in component } i \]

let

\[ \text{penalty} = |E| - |V| + C \]

let

\[ \text{maxPenalty} = C - |V| + \sum_{i} c_i (c_i - 1) / 2 \]

Then Efficiency = 1 - penalty/maxPenalty
214Efficiency, Local

Measures the closeness of the entities in each ego network in the network.

Latora and Marchiori, 2001

TYPE: Graph Level

INPUT: N: square, binary, symmetric

OUTPUT: \( \mathcal{R} \in [0,1] \)

Local Efficiency is the normalized sum of the inverse closeness of the ego networks (here, the ego network for entity i does not include entity i).

Let \( G = (V,E) \) be any square, symmetric network with \( |V| = N \) entities.

let

\[ V_i = \text{set of nodes adjacent to } i = \{ j | (i,j) \in E \} \]

let

\[ E_i = \text{edges between nodes adjacent to } i = \{ (j,k) | (j,k) \in E, i,j \in V_i \} \]

define

\[ G_i = (V_i, E_i) \]

Then,

\[ \text{Local Efficiency} = \frac{1}{N} \sum_{i=1}^{N} \text{GlobalEfficiency}(G_i) \]
**215 Entity Level**

The Entity Level for a entity \( v \) in a square network is the worst case shortest path from \( v \) to every entity \( v \) can reach.

Carley, 2002

**TYPE:** Entity Level

**INPUT:** \( N: \text{square} \)

**OUTPUT:** \( Z \in [0, |V| - 1] \)

Let \( G=(V,E) \) be the graph representation of a square network and fix an entity \( v \).

Entity Level \( \text{for } v = \max \{ d_G(v, j) \mid j \in V; j \text{ reachable from } v \text{ in } G \text{ if } v \text{ cannot reach any entities}, \text{ then its level is } 0 \).\)

**216 Exclusivity Complete**

Detects entities that have unique connections to other entities.

Ashworth, 2003

**TYPE:** Entity Level

**INPUT:** \( N: \text{square, binary} \)

**OUTPUT:** \( s_i^R \in [0,1] \)

This is a variation of the Exclusivity measure that weights the edges of an entity as follows: if no other entity has a connection to the entity, then its weight is one, otherwise it is zero.

Thus, the Complete Exclusivity value for node \( i \) is:

\[
\sum_{j=1}^{[K]} A_K(i, j) \ast [\text{sum}(A_K(:, j) == 0)]
\]

The value is then normalized by dividing by \( |K| \).
Resource Exclusivity measures the extent that a WHO has connections that are unique in a network especially to network resources. It can reveal to the network analyst critical vulnerabilities (or strengths) depending on what the analyst is looking for. An example of this measure would be if a key resource that supports an entire organization is only accessible through one person. That person would have a high resource exclusivity value.

Ashworth, 2003

TYPE: Entity Level

INPUT:

Knowledge: AK:binary

Exclusivity run on the AK matrix

Resource: AR:binary

Exclusivity run on the AR matrix

Task: AT:binary

Exclusivity run on the AT matrix

OUTPUT: $R \in [0,1]$

The Knowledge Exclusivity Index (KEI) for agent i is defined as follows:

Resource Exclusivity Index (REI) or Task Exclusivity Index (TEI)

$$\sum_{j=1}^{[K]} AK(i, j) * \exp(1 - \sum(AK(:, j)))$$

for Resource replace AK with AR

for Tasks replace AK with AT

The Resource Exclusivity Index (REI) for agent i is defined exactly as for Knowledge Based Exclusivity, but with the matrix AK replace by AR.
The Task Exclusivity Index (TEI) for agent i is defined exactly as for Knowledge Based Exclusivity, but with the matrix $A_K$ replaced by $A_T$.

**218 Fragmentation**

The proportion of entities in a network that are disconnected.

Borgatti, 2003

TYPE: Graph Level

INPUT: $N$: square, binary, symmetric

OUTPUT: $\mathcal{F} \in [0,1]$

Consider a square, symmetric network $G=(V,E)$.

Let

$$n = |V|$$

Let

$$s_k \text{ be the number of nodes in the } k^{th} \text{ component of } G, \ 1 \leq k \leq n$$

Then,

$$\text{Fragmentation} = 1 - \frac{\sum_{k=1}^{n} s_k (s_k - 1)}{n(n-1)}$$

**219 Hierarchy, Krackhardt**

The degree to which a square network $N$ exhibits a pure hierarchical structure.

Krackhardt, 1994

TYPE: Graph Level

INPUT: $N$: square

OUTPUT: $\mathcal{H} \in [0,1]$
Let $N$ be a square network. The Hierarchy of $N$ is the Reciprocity of the Reachability Network for $N$. 
220 Interdependence and Radials

The percentage of edges in a network N that are Pooled and Reciprocal.

Carley, 2002

TYPE: Graph Level

INPUT: N: square

OUTPUT: \( R \in [0,1] \)

Let \( G=(V,E) \) be the graph representation of a square network.

Let \( a = \) Pooled Edge Count and \( b = \) Reciprocal Edge Count of the network.

Then Interdependence = \( (a+b)/|E| \)

220.1 Interlockers and Radials

Interlockers and radial entities in a square network have a high and low Triad Count, respectively.

Carley, 2002

TYPE: Entity Level

INPUT: N: square, binary

OUTPUT: Binary

Let \( N=(V,E) \) be a square network.

Let

\[ t_i = \text{Triad Count for node } i, \quad 1 \leq i \leq |V| \]

Let

\[ u = \text{the mean of } \{ t_i \} \]

Let

\[ d = \text{the variance of } \{ t_i \} \]
Then,

if \( t_k \geq (u + d) \), then agent \( k \) is an interlocker.

If \( t_k \leq (u - d) \), then agent \( k \) is a radial.
**Load, Knowledge or Resource**

Average number of knowledge or resource per agent.

Carley, 2002

**TYPE:** Graph Level

**INPUT:** AK:binary

**OUTPUT:**

\[ \mathcal{R} \in [0, \frac{K}{|A|}] \]

Knowledge Load = \( \text{sum}(AK)/(|A|) \)

*Resource Load is defined analogously, replacing AK with AR.*
222Negotiation, Knowledge or Resource

The extent to which personnel need to negotiate with each other because they lack the knowledge to do the tasks to which they are assigned.

Carley, 2002

TYPE: Graph Level

INPUT:

Knowledge: AT:binary; AK:binary; KT:binary

Resource: AT:binary; AR:binary; RT:binary

OUTPUT: 9R ∈ [0,1]

Compute the percentage of tasks that lack at least one knowledge (or Resource):

let

Need = (AT’*AK) - KT’

for Resource replace AK with AR and KT with RT

let

S = { i | 1 ≤ i ≤ |T|, ∃ j : Need(i,j) < 0 } 

Then Knowledge (or Resource) Negotiation = |S| / |T|
Network Centralization, Betweenness

Network centralization based on the betweenness score for each entity in a square network. This measure is defined for symmetric and non-symmetric networks.

Freeman, 1979

TYPE: Graph Level

INPUT: N:square

OUTPUT: \( R \in [0,1] \)

Let \( G=(V,E) \) represent the square network, and let \( n = |V| \)

let

\[ d_i = \text{Betweenness Centrality of node } i \]

let

\[ \overline{d} = \max\{ d_i | 1 \leq i \leq n \} \]

Then

\[ \text{Network Betweenness Cent.} = \left( \sum_{1 \leq i \leq n} \overline{d} - d_i \right) / (n - 1) \]
Network Centralization, Closeness

Network centralization based on the closeness centrality of each entity in a square network. This is not defined only for unconnected or directed networks.

Freeman, 1979

TYPE: Graph Level

INPUT: N:square, symmetric, connected

OUTPUT: \( R \in [0,1] \) (if \( N \) connected)

Let \( G=(V,E) \) represent the square network, and let \( n = |V| \)

let

\[ d_i = \text{Closeness Centrality of node } i \]

let

\[ \overline{d} = \max \{ d_i | 1 \leq i \leq n \} \]

Then

\[
\text{Network Closeness Cent.} = \left( \sum_{1 \leq i \leq n} \overline{d} - d_i \right) / \left( (n-2)(n-1)/(2n-3) \right)
\]
225 Network Centralization, Column Degree

A centralization based on the out degree of the column vertices in a network $N$.

**TYPE:** Graph Level

**INPUT:** $N$

**OUTPUT:** $\mathcal{R} \in [0,1]$

Let $N$ be a network with $n$ column entities.

Let

$$d_j = \text{degree of column node } j, \ 1 \leq j \leq n$$

let

$$\bar{d} = \max\{d_j | 1 \leq j \leq n\}$$

Then

$$\text{Column Degree Network Centralization} = \left( \frac{\sum_{1 \leq j \leq n} \bar{d} - d_j}{n} \right)$$
Network Centralization, In Degree

A centralization of a square network based on the In-Degree Centrality of each entity.

TYPE: Graph Level

INPUT: N:square

OUTPUT: $\mathcal{K} \in [0,1]

Let $N$ be a unimodal network with $n$ entities.

Let

$$d_i = \text{In Degree Centrality of node } i$$

Let

$$\bar{d} = \max\{d_i | 1 \leq i \leq n\}$$

Then

$$\text{In Degree Network Centralization} = \left( \sum_{1 \leq i \leq n} \bar{d} - d_i \right) / D$$

where $D = (n-2)$ if $N$ is undirected, and $(n-1)$ otherwise.
Network Centralization, In Degree

A centralization of a square network based on the In-Degree Centrality of each entity.

TYPE: Graph Level

INPUT: \( N: \text{square} \)

OUTPUT: \( R \in [0,1] \)

Let \( N \) be a unimodal network with \( n \) entities.

Let

\[
d_i = \text{In Degree Centrality of node } i
\]

Let

\[
\bar{d} = \max\{d_i | 1 \leq i \leq n\}
\]

Then

\[
\text{In Degree Network Centralization} = \frac{\left( \sum_{1 \leq i \leq n} \bar{d} - d_i \right)}{D}
\]

where \( D = (n-2) \) if \( N \) is undirected, and \( (n-1) \) otherwise.
Network Centralization, Row Degree

A centralization based on the out degree of the row vertices in a network $N$.

**TYPE:** Graph Level

**INPUT:** $N$

**OUTPUT:** $\mathcal{K} \in [0,1]$

Let $N$ be a network with $n$ row nodes.

Let

$$d_j = \text{degree of row node } j, \ 1 \leq j \leq n$$

Let

$$\bar{d} = \max\{d_j | 1 \leq j \leq n\}$$

Then

$$\text{Row Degree Network Centralization} = \left( \sum_{1 \leq j \leq n} \bar{d} - d_j \right) / (n)$$
Network Centralization, Total Degree

A centralization of a square network based on total degree centrality of each entity.

Freeman, 1979

TYPE: Graph Level

INPUT: N: square, symmetric

OUTPUT: $R \in [0,1]$

Let N be a unimodal network with n entities.

let

\[ d_i = \text{Total Degree Centrality of entity } i \]

let

\[ \bar{d} = \max\{d_i | 1 \leq i \leq n\} \]

Then

Total Degree Network Centralization = \( \left( \sum_{1 \leq i \leq n} d_i - \bar{d} \right) / (n - 2) \)
Network Levels

An entity level metric is one that is defined for, and gives a value for, each entity in a network. If there are $x$ entities in a network, then the metric is calculated $x$ times, once each for each entity. Examples are Degree Centrality, Betweenness, and Cognitive Demand.

A network level metric is one that is defined for, and gives a value for, the network as a whole. The metric is calculated once for the network. Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness.

Given an entity level metric, e.g., degree centrality, then the minimum, maximum, average, and standard deviation of that metric for that network level metrics. Examples are average degree centrality, maximum betweenness, and the standard deviation in cognitive demand.

**TYPE:** Graph Level

**INPUT:** $N$: square, binary

**OUTPUT:** $Z \in [0, |V| - 1]$

Let $G=(V,E)$ be the graph representation of a square network and fix an entity $v$.

Then

the Levels of $G = \max \{ d_G(i, j) \mid i, j \in V; j \text{ reachable from } i \text{ in } G \}$
**231 Omega, Knowledge or Resource**

The degree to which an organization reuses knowledge or resource.

Carley, Dekker, and Krackhardt 2000

**TYPE:** Graph Level

**INPUT:**

Knowledge: AT:binary; KT:binary; TT:binary

Resource: AR:binary; RT:binary; TT:binary

**OUTPUT:** \( \Omega \in [0,1] \)

Let \( TAT = TA*TA' \)

Let \( N = ((T'@TAT)*KT')@KT' \)

*for resource replace KT with RT*

Then Knowledge Based Omega = \( \frac{\text{sum}(N)}{\text{sum}(KT)} \)

*for resource replace KT with RT*
Performance as Accuracy

Performance as Accuracy measures how accurately one can perform an assigned task based on one’s access to existing knowledge and resources in the network. Think of how this might be important to a person in a business organization?

Given a complicated task, this measure reveals who is best equipped to perform such a task. Performance as Accuracy is yet another key measure in the arsenal of the dynamic network analyst.

Carley, 2002

TYPE: Graph Level

INPUT:

AT: binary; [AK/KT]: binary; [AR/RT]: binary

OUTPUT: $R \in [0,1]$

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the measure first concatenates them into [AK AR], [KT RT] and uses them.

Accuracy is computed based on the binary classification problem. It is computed in one of two ways:

1) Knowledge based: Let $b$ be a binary string of length $|K|$, let $N=KT'$, and let $S=AK$. Fix a task $t$.

let

$$\text{answer} = ( \sum_{1 \leq k \leq |K|} N_{t,k} b_k / \sum_{1 \leq k \leq |K|} N_{t,k} > .5 )$$

which is the correct classification of $b$ with respect to task $t$.

Now, let $I=\{ i \mid AT(i,t)=1 \}$.

let

$$\text{answer}(i) = ( \sum_{1 \leq k \leq |K|} N_{t,k} S_{i,k} b_k / \sum_{1 \leq k \leq |K|} N_{t,k} S_{i,k} > .5 ), i \in I$$

This is agent $i$’s classification of $b$ with respect to $t$. 

441
The group of agents classify $b$ using majority voting.

That is,

\[
\text{group\_answer} = \left( \frac{1}{|I|} \sum_{i \in I} \text{answer}(i) > .5 \right).
\]

Then, if \( \text{group\_answer} = \text{answer} \), then the group was accurate, otherwise not.

This is repeated multiple times for each task, and across all tasks. The percentage correct is Performance as Accuracy.

(2) Resource based: let $N=RT'$ and $S=AR$ in the analysis of case (1).
**233 Personnel Cost**

Total number of people reporting to an agent, plus its total knowledge, resources, and tasks.

Carley, 2003

**TYPE:** Agent Level

**INPUT:** AA:binary; AK:binary; AR:binary; AT:binary

**OUTPUT:** \( S_R \in [0,1] \)

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the graph (this computes the number of agents reporting to each agent), plus the out-degree centrality of any AK, AR, and AT graphs.

This sum is scaled so that each entity gets a score in [0,1].

**234 Potential Workload — Knowledge or Resource**

Maximum knowledge or resource an agent could use to do tasks if it were assigned to all tasks.

Carley, 2002

**TYPE:** Entity Level

**INPUT:**

Knowledge: AK:binary; KT:binary

Resource: AR:binary; RT:binary

**OUTPUT:** \( S_R \in [0,1] \)

Potential Knowledge Workload for agent \( i = \text{sum}((AK*KT)(i,:))/\text{sum}(KT) \)

_for Resource replace AK with AR and KT with RT_
234.1 Redundancy, Access

Average number of redundant agents per resource. An agent is redundant if there is already an agent that has access to the resource.

Carley, 2002

TYPE: Graph Level

INPUT: AR:binary

OUTPUT: $\mathcal{R} \in [0, (|A| - 1) \times |R|]$ 

This is the Column Redundancy of matrix AR.

235 Redundancy, Assignment

Average number of redundant agents assigned to tasks. An agent is redundant if there is already an agent assigned to the task.

Carley, 2002

TYPE: Graph Level

INPUT: AT

OUTPUT: $\mathcal{R} \in [0, (|A| - 1) \times T]$ 

This is the Column Redundancy of matrix AT.
**236 Redundancy, Column**

The mean number of column node edges in excess of one.  
**TYPE:** Graph Level  
**INPUT:** N of dimension m x n  
**OUTPUT:** \( \mathcal{R} \in [0, (m - 1) \cdot n] \)  
Let \( M \) be the matrix representation for a network \( N \) of dimension \( m \times n \).

Let

\[
d_j = \max\{0, \text{sum}(M(:, j)) - 1\}
\]

for

\[
1 \leq j \leq n
\]

this is the number of column entries in excess of one for column \( j \).

Then

\[
\text{Column Redundancy} = \left( \sum_{j=1}^{n} d_j \right) / n
\]

**237 Redundancy, Knowledge**

Average number of redundant agents per knowledge. An agent is redundant if there is already an agent that has the knowledge.

The number of individual employees with the same knowledge.

Carley, 2002  
**TYPE:** Graph Level  
**INPUT:** AK: Binary  
**OUTPUT:** \( \mathcal{R} \in [0, (|A| - 1) \cdot |K|] \)  
This is the Column Redundancy of matrix AK.
238Redundancy, Resource

Average number of redundant resources assigned to tasks. A resource is redundant if there is already a resource assigned to the task.

The number of individual employees with access to the same resource.

Carley, 2002

TYPE: Graph Level

INPUT: RT:binary

OUTPUT: $\mathcal{R} \in [0, (|R| - 1) \times T]$

This is the Column Redundancy of matrix RT.

239Redundancy, Row

The mean number of row entity edges in excess of one.

TYPE: Graph Level

INPUT: N of dimension m x n

OUTPUT: $\mathcal{R} \in [0, (n - 1) \times m]$ for N dimension m x n

Let M be the matrix representation for a network N of dimension m x n.

let

$$d_i = \max\{0, \sum M(i,j) - 1\}$$

for

$$1 \leq i \leq m$$

this is the number of column entries in excess of one for row i.

Then

$$\text{Row Redundancy} = \left(\frac{\sum_{j=1}^{m} d_j}{m}\right)$$
Shared Situation Awareness

The similarity of actor pairs based on social interaction, physical distance, and socio-demographic data.

Graham, 2005

TYPE: Agent Level | Dyad Level

INPUT:
- AA: interaction/communication
- AA: physical proximity
- AA: socio demographic similarity

OUTPUT:
- Agent Level: $\mathcal{R}$, not scaled
- Dyad Level: $\mathcal{R}$, not scaled

SSA consists of weighted terms of interaction between actions.

Let

$\alpha, \beta, \gamma, \delta, \mu$ be Real number (these are weights).

Let $A =$ Agent x Agent interaction/communication matrix
Let $P =$ Agent x Agent physical proximity matrix
Let $S =$ Agent x Agent social demographic similarity matrix
Let $e =$ eigenvector centrality measure computed on $A$
Let $G =$ dyadic geodesics computed on $A$

Then the SSA measure between agents $i$ and $j$ is:

$$SSA(i, j) = \alpha e(i) e(j) + \beta P(i, j) + \frac{\delta S(i, j)}{\gamma G(i, j)} + \mu A(i, j) A(j, i)$$
241 Simmelian Ties

Computes the normalized number of entities to which each node has a Simmelian tie.

Krackhardt, 1998

TYPE: Entity Level

INPUT: N: square, binary, symmetric

OUTPUT: \( R \in [0, 1] \)

Let \( N \) be a square network with \( n \) entities. The Simmelian Tie value for entity \( i \) is computed as follows:

let \( NS = \) network \( N \) symmetrized using the Intersect (Minimum) method.

All cliques of size \( \geq 3 \) are computed on \( NS \) and clique membership is recorded. Let \( C_i \) be the number of entities that are in a clique with entity \( i \).

Then the Simmelian Ties value for entity \( i \) is \( C_i \).

242 Socio Economic Power

A measure of actor power based on access to knowledge, resources, and tasks in the organization.

TYPE: Agent Level

INPUT:

AK: binary

AR: binary

AT: binary

OUTPUT: \( R \in [0, 1] \)

Let \( N = [AK \ AR \ AT] \), that is, the concatenation of the input matrices. Then, Agent Socio Economic Power is the row degree centrality of \( N \).
**243 Span of Control**

The average number of out edges per node with non-zero out degrees.

Carley, 2002

**TYPE:** Graph Level

**INPUT:** N: square, binary

**OUTPUT:** $S \in [0, |V| - 1]$

let $S =$ set of entities in $V$ that have positive out-degree

let

$$K = \sum_{i \in S} \text{outDegree}(i)$$

Then

$$\text{Span of Control} = K / |S|$$

**244 Speed, Average**

The average inverse geodesic distance between all entity pairs. The highest score is achieved for a clique, and the lowest for all isolates.

Average shortest communication path length between pairs of individuals; gauges how quickly a message will move throughout the network.

Carley, 2002

**TYPE:** Graph Level

**INPUT:** N: square, binary

**OUTPUT:** $S \in [0,1]$

Average Speed is the average of the Inverse Closeness Centrality for the network entities.
245 Speed, Minimum

The maximum shortest path length between entity pairs (i,j) where there is a path in the network from i to j. If there are no such pairs, then Minimum Speed is zero.

Carley, 2002

TYPE: Graph Level

INPUT: N:square, binary

OUTPUT: $s_R \in [0,1]$

Minimum Speed = $1 / (\text{Levels for the Network})$

246 Task Completion — Knowledge / Resource / Overall

The percentage of tasks that can be completed by the agents assigned to them, based solely on whether the agents have the requisite knowledge or resources to do the tasks.

Task Completion Overall is a combination of the Task Completion Knowledge and the Task Completion Resource.

Carley, 2002

TYPE: Graph Level

INPUT: AK:binary; AT:binary; KT:binary

OUTPUT: $s_R \in [0,1]$

Find the tasks that cannot be completed because the agents assigned to the tasks lack necessary knowledge.

let

$\text{Need} = [(\text{AT}^* \text{AK}) - \text{KT}^*]$

let

$S = \{ i \mid 1 \leq i \leq |T|, \exists j : \text{Need}(i,j) < 0 \}$
Knowledge Based Task Completion is the percentage of tasks that could be completed \( = (|T|-|S|) / |T| \)

Resource Based Task Completion is analogous, replacing AK with AR and KT with RT.
Transitivity

The percentage of edge pairs \{(i,j), (j,k)\} in the network such that (i,k) is also an edge in the network.

The percentage of pairs in the employee communication network where employee A is linked to B and B is linked to C and C is also linked to A

TYPE: Graph Level

INPUT: N:square, binary

OUTPUT: \( R \in [0,1] \)

Let \( G = (V,E) \) be the graph representation of the square network.

let

\[ I = \{(i,j,k) \in V^3 | i,j,k \text{ distinct}\} \]

let

\[ \text{Potential} = \{(i,j,k) \in I | (i,j) \in E, \text{ and } (j,k) \in E\} \]

let

\[ \text{Complete} = \{(i,j,k) \in \text{Potential} | (i,k) \in E\} \]

Then

\[ \text{Transitivity} = |\text{Complete}| / |\text{Potential}| \]
248 Triad Count

The number of triads centered at each entity in a square network.
TYPE: Agent Level
INPUT: N:square, binary
OUTPUT: \( Z \in [0, (n - 1)(n - 2)] \) for N dimension n.
Let \( G=(V,E) \) represent a square network with n entities.
And let Triad be a matrix of dimension n x n.

\( \text{Triad}(i,i) = 0 \)

\( \text{Triad}(i,j) = \text{card}\{ k \mid k \neq i, k \neq j; AA(i,j) \land AA(i,k) \land AA(k,j) \}, i \neq j \)

Then

the Triad count for agent \( i = \sum(\text{Triad}(i,:)) \)

249 Under Supply Knowledge / Resource

The extent to which the knowledge/Resource needed to do tasks are unavailable in the entire organization.

Carley, 2002

TYPE: Graph Level

INPUT: AK:binary; AT:binary; KT:binary

OUTPUT: \( \mathcal{R} \in [0,1] \)

This is the number of required knowledge not available to tasks based on the current agent task assignments normalized by the number of tasks.

Knowledge Under Supply = \( \sum(\text{dich}( \text{KT} - \text{AK}^*\text{KT} )) / |T| \)

Under Resource Supply is analogous, replacing AK with AR, and KT with RT.
Upper Boundedness, Krackhardt

The degree to which pairs of agents have a common ancestor.

Krackhardt, 1994

TYPE: Graph Level

INPUT: N: square, binary

OUTPUT: $\mathcal{R} \in [0,1]$
Below are procedures to run a Belief Report in ORA.
We set up an Excel spreadsheet with agents and the levels for each of the beliefs. Beliefs are strange as they can be either positive or negative. Two people share a belief only is both have a positive response or both have a negative response.
From Excel, or other program you’re using, save your data in the .csv format.

<table>
<thead>
<tr>
<th>G1</th>
<th>Hamas should government</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
</tr>
<tr>
<td>1</td>
<td>AB</td>
</tr>
<tr>
<td>2</td>
<td>Condoleezza Rice</td>
</tr>
<tr>
<td>3</td>
<td>President George Bush</td>
</tr>
<tr>
<td>4</td>
<td>Former President Carter</td>
</tr>
<tr>
<td>5</td>
<td>Ehud Olmert</td>
</tr>
<tr>
<td>6</td>
<td>Ismail Haniya</td>
</tr>
<tr>
<td>7</td>
<td>Khalid Mish’al</td>
</tr>
<tr>
<td>8</td>
<td>Mahmud Abbas</td>
</tr>
<tr>
<td>9</td>
<td>Bashar Al-Assad</td>
</tr>
<tr>
<td>10</td>
<td>unknown-1</td>
</tr>
<tr>
<td>11</td>
<td>unknown-2</td>
</tr>
</tbody>
</table>

From the main menu select File => Data Import Wizard.
Click the [Select] button to call up the open dialog box. Navigate to the directory where you have saved your .csv file.
Make sure the Create a New Matrix radio button is selected. Leave Choose a source node set to agent. In the Choose a target node set click the down arrow to bring up the drop down menu. Highlight the <new type> option. Then select the Next button at the bottom of the box.

Type in belief into the textbox.
You can enter a new name in Enter a unique graph name or leave it as Agent x belief. When you're done, select the [Finish] button.

A new Network appears in Panel 1 with two Entities and one graph. The values from the Editor reflect the original numbers from the Excel spreadsheet.
Now you're ready to create a beliefs report.

From the main menu select Analysis => Generate Reports.

1. In the Select Report textbox, select Beliefs.

2. In the Select one or more meta matrices: place a checkmark in the Networks you want to run the report on.

3. In the Select the report formats to create: place a checkmark in all the formats you want the final report to appear in. Here we are doing only Text (which will appear in panel 3 in the main interface) and HTML (which will create an HTML document that will open up in your browser).

4. In the Enter a filename section you can either type in a file path or use the [Browse] button to navigate to a directory to save your files.

When you're finished select the [Next-->] button.
Select the Number of ranked nodes and critical attribute (if any). Then select the [Finish] button.

The Belief Report now appears in panel 3. If you selected HTML you will also see the report appear in your browser.
252.1 Beliefs Report

Input data: Meta Matrix
Given one or more belief networks, this analyzes the most strongly held beliefs, the most opinionated individuals and other characteristics of the belief networks.
The beliefs node set must have the id equal to 'belief'. There can be multiple graphs based on this belief node set, for example, Agent x Belief and Organization x Belief.
252.2 Analysis for the belief network: Agent x belief

252.2.1 Most Common Beliefs

Top 10 beliefs that are shared by the most people.

<table>
<thead>
<tr>
<th>Belief</th>
<th>Value</th>
<th>Number of believers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Israel_is_a_state</td>
<td>Negative</td>
<td>2</td>
</tr>
<tr>
<td>There_exists_a_Palestine_two_state_solution</td>
<td>Negative</td>
<td>2</td>
</tr>
<tr>
<td>Hamas_should_PNA_elections</td>
<td>Negative</td>
<td>2</td>
</tr>
<tr>
<td>Hamas_is_a_terrorist_organization</td>
<td>Negative</td>
<td>3</td>
</tr>
<tr>
<td>Oslo_Accords_is_a_peace_solution</td>
<td>Negative</td>
<td>3</td>
</tr>
<tr>
<td>Hamas_should_disarm</td>
<td>Negative</td>
<td>3</td>
</tr>
<tr>
<td>Israel_should_Occupy_Palestine</td>
<td>Negative</td>
<td>3</td>
</tr>
<tr>
<td>AB</td>
<td>Positive</td>
<td>4</td>
</tr>
<tr>
<td>Hamas_is_a_terrorist_organization</td>
<td>Positive</td>
<td>4</td>
</tr>
<tr>
<td>Hamas_should_government</td>
<td>Negative</td>
<td>4</td>
</tr>
</tbody>
</table>

252.2.2 Most Contentious Beliefs

Top 10 beliefs that are most disagreed upon across individuals. This is based on the GINI coefficient of the belief vector.

<table>
<thead>
<tr>
<th>Belief</th>
<th>Gini coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB</td>
<td>0.686667</td>
</tr>
<tr>
<td>Hamas_should_government</td>
<td>0.622222</td>
</tr>
<tr>
<td>Hamas_is_a_terrorist_organization</td>
<td>0.5625</td>
</tr>
<tr>
<td>Israel_should_Occupy_Palestine</td>
<td>0.5625</td>
</tr>
<tr>
<td>Oslo_Accords_is_a_peace_solution</td>
<td>0.456338</td>
</tr>
<tr>
<td>There_exists_a_Palestine_two_state_solution</td>
<td>0.454795</td>
</tr>
<tr>
<td>Hamas_should_PNA_elections</td>
<td>0.454795</td>
</tr>
<tr>
<td>Israel_should_Destruction</td>
<td>0.430818</td>
</tr>
<tr>
<td>Israel_is_a_state</td>
<td>0.37973</td>
</tr>
<tr>
<td>Hamas_should_disarm</td>
<td>0.270992</td>
</tr>
</tbody>
</table>

252.2.3
252.2.4 Most Strongly Held Beliefs

Top 10 beliefs that are the most strongly held. This is the average absolute value of the belief vector.

<table>
<thead>
<tr>
<th>Belief</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hamas_should_government</td>
<td>1.6</td>
</tr>
<tr>
<td>AB</td>
<td>1.5</td>
</tr>
<tr>
<td>Hamas_is_a_terrorist_organization</td>
<td>1.2</td>
</tr>
<tr>
<td>Israel_should_Occupy_Palestine</td>
<td>1.2</td>
</tr>
<tr>
<td>Israel_should_Destruction</td>
<td>0.97</td>
</tr>
<tr>
<td>There_exists_a_Palestine_two_state_solution</td>
<td>0.86</td>
</tr>
<tr>
<td>Hamas_should_PNA_elections</td>
<td>0.86</td>
</tr>
<tr>
<td>Oslo_Accords_is_a_peace_solution</td>
<td>0.84</td>
</tr>
<tr>
<td>Israel_is_a_state</td>
<td>0.78</td>
</tr>
<tr>
<td>Hamas_should_disarm</td>
<td>0.47</td>
</tr>
</tbody>
</table>

252.2.5 Most Likely to Change Beliefs

Top 10 individuals most likely to change beliefs. This is based on the entropy of each individual's belief vector.

<table>
<thead>
<tr>
<th>Belief</th>
<th>Entropy</th>
</tr>
</thead>
<tbody>
<tr>
<td>unknown-2</td>
<td>0</td>
</tr>
<tr>
<td>President George Bush</td>
<td>1</td>
</tr>
<tr>
<td>Condoleezza Rice</td>
<td>1.469</td>
</tr>
<tr>
<td>Ismail Haniya</td>
<td>1.65992</td>
</tr>
<tr>
<td>Bashar Al-Assad</td>
<td>2</td>
</tr>
<tr>
<td>Ehud Olmert</td>
<td>2.16578</td>
</tr>
<tr>
<td>Mahmud Abbas</td>
<td>2.19092</td>
</tr>
<tr>
<td>Khalid Mish?a</td>
<td>2.87598</td>
</tr>
<tr>
<td>Former President Carter</td>
<td>4.14443</td>
</tr>
<tr>
<td>unknown-1</td>
<td>4.2961</td>
</tr>
</tbody>
</table>
### 252.2.6 Most Opinionated Individuals

Top 10 individuals that have the highest absolute sum of beliefs.

<table>
<thead>
<tr>
<th>Agent</th>
<th>Total beliefs</th>
</tr>
</thead>
<tbody>
<tr>
<td>unknown-2</td>
<td>49.8</td>
</tr>
<tr>
<td>President George Bush</td>
<td>9.5</td>
</tr>
<tr>
<td>Bashar Al-Assad</td>
<td>9</td>
</tr>
<tr>
<td>Condoleezza Rice</td>
<td>8.6</td>
</tr>
<tr>
<td>Mahmud Abbas</td>
<td>8.6</td>
</tr>
<tr>
<td>Former President Carter</td>
<td>5.2</td>
</tr>
<tr>
<td>Khalid Mish'a</td>
<td>4.9</td>
</tr>
<tr>
<td>unknown-1</td>
<td>3.2</td>
</tr>
<tr>
<td>Ismail Haniya</td>
<td>2.4</td>
</tr>
<tr>
<td>Ehud Olmert</td>
<td>1.6</td>
</tr>
</tbody>
</table>

### 252.2.7 Most Neutral Individuals

Top 10 individuals that have the lowest absolute sum of beliefs.

<table>
<thead>
<tr>
<th>Agent</th>
<th>Total beliefs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ehud Olmert</td>
<td>1.6</td>
</tr>
<tr>
<td>Ismail Haniya</td>
<td>2.4</td>
</tr>
<tr>
<td>unknown-1</td>
<td>3.2</td>
</tr>
<tr>
<td>Khalid Mish'a</td>
<td>4.9</td>
</tr>
<tr>
<td>Former President Carter</td>
<td>5.2</td>
</tr>
<tr>
<td>Mahmud Abbas</td>
<td>8.6</td>
</tr>
<tr>
<td>Condoleezza Rice</td>
<td>8.6</td>
</tr>
<tr>
<td>Bashar Al-Assad</td>
<td>9</td>
</tr>
<tr>
<td>President George Bush</td>
<td>9.5</td>
</tr>
<tr>
<td>unknown-2</td>
<td>49.8</td>
</tr>
</tbody>
</table>

Produced by ORA developed at CASOS - Carnegie Mellon University
253 Capacity Report

The purpose of this report is to assess individuals' and organizations' capability to perform tasks. Below are procedures for running this report.

253.1 Overall Capability and Needs

List all congruence measures

1. For agents – list min, max, avg and std dev in capability for each capability index.
2. For organizations – list min, max, average and std dev in capability for each capability index
3. For tasks – list min, max, average and standard deviation in requirements for each requirement index

Most Capable
List the top n most capable agents and next to their name list their capabilities (knowledge, resources, tasks).

NOTE: list overall capability first (don't show capabilities for the overall).

List the top n most capable organizations and next to their name list their capabilities (knowledge, resources, tasks).

NOTE: List overall capability first, the overall explicit – then the three explicit. Then list the overall implicit and then the three implicit.

NOTE: don't show capabilities for the overall measures.

253.2 Highest Requirements

List the top n tasks with the most requirements and next to each name list the requirements.

NOTE: list the overall first (don't show requirements for the overall).

Capability
Capabilities are defined in terms of expertise (knowledge) and resources.

NOTE: this formula discounts for the fact that most agents have some capabilities and assumes that there is a general discount to having large numbers of capabilities.

An agent's general capability index in resources is: $ACR = \frac{1}{1 + \exp(-(x-0.5)\times10))}$

Where $x =$ number of resources the agent has divided by the maximum number of resources any agent has (so for AR this is the row sum divided by the max row sum)

An agent's general capability index in expertise is: $ACK = \frac{1}{1 + \exp(-(x-0.5)\times10))}$
Where \( x = \) number of knowledge the agent has divided by the maximum number of knowledge any agent has (so for AK this is the row sum divided by the max row sum)

An agent's capability can be inferred by the agent's experience. This is captured by the agent to task links. This is \( \text{ACT} = 1/(1+\exp(-(x-0.5)*10)) \).

Where \( x = \) number of tasks the agent has divided by the maximum number of tasks any agent has (so for AT this is the row sum divided by the max row sum)

An agent's capability overall in both R, K and T is \( (\text{ACR} + \text{ACK} + \text{ACT})/3 \)

An organization's explicit capability is:

An organization's general capability index in resources is: \( \text{OCR} = 1/(1+\exp(-(x-0.5)*10)) \)

Where \( x = \) number of resources the organization has divided by the maximum number of resources any organization has (so for OR this is the row sum divided by the max row sum)

An organization's explicit capability index in expertise is: \( \text{OCK} = 1/(1+\exp(-(x-0.5)*10)) \)

Where \( x = \) number of knowledge the organization has divided by the maximum number of knowledge any organization has (so for OK this is the row sum divided by the max row sum)

An organization's explicit inferred capability index using tasks is: \( \text{OCK} = 1/(1+\exp(-(x-0.5)*10)) \)

Where \( x = \) number of tasks the organization has divided by the maximum number of tasks any organization has (so for OT this is the row sum divided by the max row sum)

An organization's overall explicit capability is \( (\text{OCR} + \text{OCK} + \text{OCT})/3 \)

An organization's implicit capability considers the expertise and resources of the agent's associated with the organization

So this is for resources the average ACR across the agents associated with the organization.

So this is for knowledge the average ACK across the agents associated with the organization.

So this is for tasks (implicit inferred) the average ACT across the agents associated with the organization.

From a network perspective, an agent is associated with an organization if \( AO_{ij} \neq 0 \).

An organization's overall implicit capability is the sum of the 3 divided by 3.

An organization's overall capability is the average of the explicit and implicit.
253.3 Requirements

Each task has requirements in terms of the knowledge and resources needed for that task.

*Note: in practice it may not be possible to measure the requirements for all tasks, particularly for covert operations, prior to the task being done. So, a subject matter expert's view of the "complexity" of the task might be substituted. Such complexity would play the same role, and have the same properties as the requirements index defined here.*

A task's general requirement index in resources is: \( RR = \text{the number of resources needed for that task/maximum number of resources needed for any task} \) (so for RT this is the col sum divided by the max col sum)

A task's general requirement index in knowledge is: \( RK = \text{the number of knowledge needed for that task/maximum number of knowledge needed for any task} \) (so for KT this is the col sum divided by the max col sum)

A task's overall requirement index is the average of RR and RK.

**Match**

In general agents with more capabilities when assigned to tasks with more requirements will better meet those needs. In general, agents with more capabilities will be able to perform more tasks. In general, tasks with higher requirements need either more agents or agents with more capabilities.

When the exact requirements are done it is possible to do a match function. Here the idea is that the task is done best when there is congruence between what resources/knowledge are needed for a task and what resources/knowledge those agents assigned to the task have.

Several of the congruence measures in ORA apply here. For these definitions see the on-line ORA help.
255 Capacity Report

The purpose of this report is to assess individuals' and organizations' capability to perform tasks. Below are procedures to run a capacity report in ORA.

255.1 Overall Capability and Needs

List all congruence measures

1. For agents – list min, max, average and std dev in capability for each capability index.
2. For organizations – list min, max, average and std dev in capability for each capability index.
3. For tasks – list min, max, average and std dev in requirements for each requirement index.

Most Capable
List the top n most capable agents and next to name list their capabilities (knowledge, resources, tasks). Note; list overall capability first (don't show capabilities for the overall).

List the top n most capable organizations and next to name list their capabilities (knowledge, resources, tasks). Note; list overall capability first, the overall explicit – then the 3 explicit, then the overall implicit and then the 3 implicit. Note, don't show capabilities for the overall measures.

Highest Requirements
List the top n tasks with the most requirements and next to each list the requirements. Note list the overall first (don't show requirements for the overall).

Capability
Capabilities are defined in terms of expertise (knowledge) and resources.

Note this formula discounts for the fact that most agents have some capabilities and assumes that there is a general discount to having large numbers of capabilities.

An agent's general capability index in resources is: \[ ACR = \frac{1}{1 + \exp(-(x-0.5) \times 10)} \]

Where \( x \) = number of resources the agent has divided by the maximum number of resources any agent has (so for AR this is the row sum divided by the max row sum).

An agent's general capability index in expertise is: \[ ACK = \frac{1}{1 + \exp(-(x-0.5) \times 10)} \]

Where \( x \) = number of knowledge the agent has divided by the maximum number of knowledge any agent has (so for AK this is the row sum divided by the max row sum).

An agent's capability can be inferred by the agent's experience. This is captured by the agent to task links. This is \[ ACT = \frac{1}{1 + \exp(-(x-0.5) \times 10))}. \]
Where \( x \) = number of tasks the agent has divided by the maximum number of tasks any agent has (so for AT this is the row sum divided by the max row sum)

An agent's capability overall in both R, K and T is \((ACR + ACK + ACT)/3\)

An organization's explicit capability is:

An organization's general capability index in resources is: \(OCR = \frac{1}{1+\exp(-(x-0.5)*10))}\)

Where \( x \) = number of resources the organization has divided by the maximum number of resources any organization has (so for OR this is the row sum divided by the max row sum)

An organization's explicit capability index in expertise is: \(OCK = \frac{1}{1+\exp(-(x-0.5)*10))}\)

Where \( x \) = number of knowledge the organization has divided by the maximum number of knowledge any organization has (so for OK this is the row sum divided by the max row sum)

An organization's explicit inferred capability index using tasks is: \(OCK = \frac{1}{1+\exp(-(x-0.5)*10))}\)

Where \( x \) = number of tasks the organization has divided by the maximum number of tasks any organization has (so for OT this is the row sum divided by the max row sum)

An organization's overall explicit capability is \((OCR + OCK + OCT)/3\)

An organization's implicit capability considers the expertise and resources of the agent's associated with the organization

So this is for resources the average ACR across the agents associated with the organization.

So this is for knowledge the average ACK across the agents associated with the organization.

So this is for tasks (implicit inferred) the average ACT across the agents associated with the organization.

From a network perspective, an agent is associated with an organization if \(AO_{ij} \neq 0\).

An organization's overall implicit capability is the sum of the 3 divided by 3.

An organization's overall capability is the average of the explicit and implicit.

### 255.2 Requirements

Each task has requirements in terms of the knowledge and resources needed for that task.
Note, in practice it may not be possible to measure the requirements for all tasks, particularly for covert operations, prior to the task being done. So, a subject matter expert's view of the "complexity" of the task might be substituted. Such complexity would play the same role, and have the same properties as the requirements index defined here.

A task's general requirement index in resources is: \( RR = \frac{\text{the number of resources needed for that task}}{\text{maximum number of resources needed for any task}} \) (so for RT this is the col sum divided by the max col sum)

A task's general requirement index in knowledge is: \( RK = \frac{\text{the number of knowledge needed for that task}}{\text{maximum number of knowledge needed for any task}} \) (so for KT this is the col sum divided by the max col sum)

A task's overall requirement index is the average of RR and RK.

**Match**

In general agents with more capabilities when assigned to tasks with more requirements will better meet those needs. In general, agents with more capabilities will be able to perform more tasks. In general, tasks with higher requirements need either more agents or agents with more capabilities.

When the exact requirements are done it is possible to do a match function. Here the idea is that the task is done best when the there is congruence between what resources/knowledge are needed for a task and what resources/knowledge those agents assigned to the task have.

Several of the congruence measures in ORA apply here. For these definitions see the on-line ORA help.
Key Entity Report — Basic

Below is an image of main dialog window used to run a Key Entity Report. Further below are procedures for doing so.

256.1 Main Dialog Box

This is the main interface for this report where you select the Network and the types of transformations to perform for the report.

1. Select a Report contains all the reports available
2. MetaNetworks to Analyze Place a checkmark in the matrices you want to analyze.
3. Show/Hide transform options shows the options for transforming a Network.
4. Transform contains three options
   o General mathematical transformations contains the basic types of transformations available. It uses a checkbox which can be either turned on or off.
   o Remove entities allows you to remove entities from the report. It is a radio button used in conjunction with partition entities.
   o Partition entities allows you to create a division to separate the report.
The Entity Report creates up to six separate reports.

1. **KEY-ENTITY REPORT** shows general information about the report
2. **Who** shows information about agents, such as Emergent Leader, In the Know, and Potential Influential. Gives information about knowledge that agents know, the resources they have access to, and what events the agents were at.
3. **What** shows information for tasks and the tasks related to agents, knowledge, etc. such as High Concentration of Actors, Knowledge, and Resources.
4. **Where** shows information about locations related to agents, resources, and tasks such as Central Locations, Most Active Locations, and Highest Concentration of Actors.
5. **How** shows information about the knowledge related to agents, knowledge, and locations such as Dominant Knowledge, Most Available, Dominant Resources.
6. **Performance Indicators** shows information about Social Density, Communication, and Performance.

### 256.3 Output Options

Reports can present their results in different formats. Each format produces one or more files that are saved to a specified location. When multiple files are created, each filename will be an extension of the one you gave.

Select the report formats to create:

- [ ] Text
- [ ] HTML
- [ ] CSV
- [x] DyNetML

Enter a location (directory and filename) in which to save the report:

C:\Documents and Settings\columbus\My Documents\ORA\reports\key

You have a choice of four formats of report. Text places the reports in individual tabs in Panel 3 of the main interface. HTML creates reports that are opened up in a browser window. CSV are files that can be opened in Excel. And DyNetML creates .xml files, the default for ORA.
When you are finished, select [Finish].
257 Key Entity Report — Other Options

The Key Entities Report allows you to further tweak your report by defining parameters such as isolates, pendants, and binarizing your data. Following are three dialog boxes that explain those further refinements.

257.1 General Transformation

Occasionally your data needs work before creating the report. The General Transformation allows for refining it. See the dialog box below:

- Remove Isolates: Remove any isolates* before running the report.
- Remove Pendants: Remove any pendants* before running the report.
- Symmetrize by method: Even out the matrix by using one of the methods in the dropdown menu.

- Maximum: Acts like the binary OR function. If either one of a pair of nodes has a link then this function creates an equal link in the opposite direction.
- Minimum: Acts like the binary AND function. Both nodes need to have a link one another in order for a link to be valid. Else there is no link between the two nodes.
- Average:
• Remove links: Allows you to remove links from the report based on one of the options in the dropdown menu.

<table>
<thead>
<tr>
<th>lessThan</th>
</tr>
</thead>
<tbody>
<tr>
<td>lessThanEquals</td>
</tr>
<tr>
<td>equals</td>
</tr>
<tr>
<td>notEquals</td>
</tr>
<tr>
<td>greaterThanEquals</td>
</tr>
<tr>
<td>greaterThan</td>
</tr>
</tbody>
</table>

• Binarize: Binarizing* your numeric data will change all link weights to a value of either [1] or [0].
• Conform Meta-Network by method:
• Create union matrices:

When you are finished, select [Next >].
257.2 Remove Entities Options

You can remove any of the nodes and stop them from affecting a report. By either using the tabs to find the entity in its set or using the search box to single it out. Then place a checkmark in the box to remove it from view. The options are fairly self explanatory. You can create multiple filters with this method.

The Filter Commands give you the choice of matching all or some of the filters you've created. And the [Reset Filters] button clears all the filters you've made. The filters can be refined by using the Search box to cal up particular nodes and marking them with a checkmark to remove them from the use. This can be done as many times as necessary before proceeding. You can also go through the tabs individually and choose to Select/Deselect whichever nodes you want.

The [Select All] and [Clear All] buttons work on only the currently visible items.
Any node that you place a checkmark in will be excluded from the filter.
When you are finished, select [Next >].
257.3 Partition Options

From this screen choose an Entity from the top box. Place a checkmark in the appropriate checkbox. Next in the Select an attribute dropdown menu chose the attribute to base the report on. Finally chose and attribute value to use for the partition.

If you want to create a new MetaNetwork place a checkmark in the bottom box add created partition meta matrices to the main interface.

When you are finished, select [Next >].

257.4 Summary

With the Key Entities Report you can refine your report to focus on only the segment of your Network you prefer.
Mental Model Reports

What follows are descriptions of the various mental model reports in ORA.
Single condensed files - per chunk, where a chunk is N days prior to or posterior to an event, excluding the day of the event
Number of concepts - Number of words (frequency count per email) Carley and Kaufer, 1993
Number of isolated concepts - Number of words that were coded as knowledge items, but did not get linked into statements Carley and Kaufer, 1993
Number of statements - Number of links (frequency count per email) Carley and Kaufer, 1993
Density - Density of semantic network Carley and Kaufer, 1993
Set-Theoretic and qualitative (word-level) comparison of maps from before and after event
Concept Analysis - Concepts are classified according to whether they have high and low values for the measures: total degree centrality, betweenness centrality, and consensus.

Allusions - high degree, low betweenness, low consensus Carley and Kaufer, 1993
Buzzwords - low degree, high betweenness, low consensus Carley and Kaufer, 1993
Emblems - low degree, high betweenness, high consensus Carley and Kaufer, 1993
Factoids - low degree, low betweenness, high consensus Carley and Kaufer, 1993
Ordinary Words - low degree, low betweenness, low consensus Carley and Kaufer, 1993
Placeholders - high degree, high betweenness, low consensus Carley and Kaufer, 1993
Stereotypes - high degree, high betweenness, high consensus Carley and Kaufer, 1993
Symbols - high degree, high betweenness, high consensus Carley and Kaufer, 1993

258.1 Mental Model Reports Bibliography

What follows are procedures for using ORA’s contextual menus. Right-clicking on any Meta-Network, NodeSet, or Network brings up a contextual menu with the functions available with each.

The first four are self-explanatory. Transform… opens up the Meta-Network Transform… dialog box.

The first three are self-explanatory. Add Attribute … opens up the attribute function in order to add attributes to a Node Set.
The first two are self-explanatory.

- **Set Diagonal…**: Used on a square network to set cells 1,1 through x,x to the same value. In binary view the choices are 1: True (+1) 2: True (-1) 3: False (0). In Numeric view you can put any value into the diagonal.
- **Fold Network…**: This function creates a new network using matrix algebra. Below are four variations of a four x four network and the results when each is folded.

<table>
<thead>
<tr>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge_1</td>
<td>1.0</td>
</tr>
<tr>
<td>Knowledge_2</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge_1</td>
<td>1.0</td>
</tr>
<tr>
<td>Knowledge_2</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge_1</td>
<td>1.0</td>
</tr>
<tr>
<td>Knowledge_2</td>
<td>1.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge_1</td>
<td>1.0</td>
</tr>
<tr>
<td>Knowledge_2</td>
<td>0.0</td>
</tr>
</tbody>
</table>

- **Save Network…**: Any Network can be saved individually to a file in one of the following formats: CSV*, DL, DyNetML*, or UNCINET (.##h). Also check File Formats for more information
- **Binarize Network**: Turns all non-zero numbers to [1] and leaving all [0] untouched.
- **Remove Links…**: Removes links in accordance to the selection in the dropdown menu (as seen in the images below).

- **Symmetrize…**:
Contextual Menus - Multi Files

There's also a separate contextual menu when you've got two or more Meta-Networks selected.

Open up multiple Meta-Networks in the Main Interface. Load two or more files into Panel 1. We'll demonstrate this on two Meta-Networks containing Bob, Carol, Ted, & Alice.

The agents are identical but the tasks in each are different, except for driving which appears in both and has slightly different values. Inbetween the time of cookingIn and eatingOut Alice's feelings for Ted have grown.

cookingIn and eatingOut

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>shopping</td>
</tr>
<tr>
<td>carol</td>
<td>chief_cook</td>
</tr>
<tr>
<td>ted</td>
<td>waiter(ess)</td>
</tr>
<tr>
<td>alice</td>
<td>bottle_wa...</td>
</tr>
<tr>
<td></td>
<td>busboy(girl)</td>
</tr>
<tr>
<td></td>
<td>sous_chef</td>
</tr>
<tr>
<td></td>
<td>driver</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>shopping</th>
<th>chief_cook</th>
<th>waiter(ess)</th>
<th>bottle_wa...</th>
<th>busboy(girl)</th>
<th>sous_chef</th>
<th>driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>carol</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>1.0</td>
</tr>
<tr>
<td>ted</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>alice</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entity ID</th>
<th>Entity ID</th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>driver</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>agenda</td>
<td>1.0</td>
<td>1.0</td>
<td>0.0</td>
<td>3.0</td>
</tr>
<tr>
<td>ted</td>
<td>tipper</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
<tr>
<td>alice</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>driver</th>
<th>agenda</th>
<th>tipper</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>carol</td>
<td>2.0</td>
<td>0.0</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>0.0</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Meta-Network Manager:
- bcta_cookingIn
- bcta_eatingOut

480
Highlight both of them by holding down the [Control] while clicking on each file. Then Right-click on one of the files. This brings up the contextual menu.

The Add New MetaNetwork & Remove Selected Meta-Network are self-explanatory. The Union Meta-Network will create a new Meta-Network using one of five actions: sum, binary, average, minimum, or maximum.

- **sum**: In any identical network all values from all networks are added together. (i.e. bob’s score of 4.0 in both meta-networks are added together for a total of 8.0).

```
+---+---+---+---+
| bob | carol | ted | alice |
+---+---+---+---+
| 0.0 | 8.0  | 0.0 | 0.0   |
| 8.0 | 0.0  | 4.0 | 0.0   |
| 2.0 | 3.0  | 0.0 | 4.0   |
| 0.0 | 0.0  | 8.0 | 0.0   |
```

- **binary**: Then in the binary option it doesn't matter what numbers appeared in either meta-network as it uses only 1 or 0 as a result. If any cell has a non-zero it will contain a 1 as a result.
average: This option takes the sum of all identical cell values and divides them by the number of cells used. In cookingIn Ted x Alice contained a 2 while in eatingOut the value for Te x Alice was a 1. This was averaged out to 1.5.

minimum: This function finds the smallest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x Alice both cells use the smaller value of "1" even though they are from different meta-networks.

maximum: This function finds the largest value in any identical cells and uses that in the final result. (i.e. for ted x carol and ted x Alice both cells use the larger value of "2" and "3" respectively, each taken from a different meta-network.

Intersect Meta-Network works similar to the Union function and has the same five options. But in creating the new Meta-Network only nodes that appear in all Meta-Networks are carried over to the new Meta-Network.

For example: All four agents appear in both Meta-Networks and are brought over into the new Meta-Network. But though there were six tasks in the cookingIn and three tasks in eatingOut there is only one task (driver) in the new Meta-Network created from the intersect function. Only nodes found in all Meta-Networks are brought over.
And even though bob has a value for driver in cookingIn only carol has a value for driver in both Meta-Networks.

<table>
<thead>
<tr>
<th></th>
<th>bob</th>
<th>carol</th>
<th>ted</th>
<th>alice</th>
<th>driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>bob</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>0.0</td>
<td>bob</td>
</tr>
<tr>
<td>carol</td>
<td>4.0</td>
<td>0.0</td>
<td>2.0</td>
<td>0.0</td>
<td>carol</td>
</tr>
<tr>
<td>ted</td>
<td>1.0</td>
<td>2.0</td>
<td>0.0</td>
<td>1.0</td>
<td>ted</td>
</tr>
<tr>
<td>alice</td>
<td>0.0</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>alice</td>
</tr>
</tbody>
</table>

Conform Meta-Network alters the selected Meta-Networks and makes them equal. union adds nodes that are found in one Meta-Network but not the other. intersect removes nodes that are not common to both.
Creating a Network from an Excel Spreadsheet

If you don't have a Network, you can create one from scratch. Below is step-by-step instruction on how to do this.

We will create a square, agent-by-agent Network. We say it is square because all row headings correspond directly to column headings. This is important as it relates to specific measures ORA can run on a graph. If the graph is not square, some measures will not work.

Open a blank Microsoft Excel work book. In column A we will enter the name of all the nodes that make up our social network or organization.

**263.1.1 NOTE:** When creating your spreadsheet, do not add any additional titles, notes, or other headings, which will interfere with the "square" properties of the Network.

Next, create column headings using the correlating names as they appear in row headings. Again, this will ensure that our Network will be square.

Next we will create links between each agent. We do this by entering a 1 if a direct connection or relationship exists and a 0 if it does not. Please note that headings that cross-reference themselves are considered redundant and thus are left blank or 0.

In the example below, Redundant cells are filled in with red strips to illustrate the self-loops. This redundancy should continue as a smooth diagonal line from the top left corner of your Network to the bottom right.
263.1.2 NOTE: If you don't end up with a diagonal line then your graph is not square.

Using 1s and 0s to establish link, complete your spreadsheet.

In the Network example, we have assigned links randomly. Within your organization or network, however, you can describe any direct connections or relationships you are interested in analyzing. For instance, you may determine that a direct connection exists if agents within your network consult with each other at least once a month; literally, it can be anything you decide.

Below is our completed Network (The red fill illustrates cells that do not require input due to their redundancy*).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>bob</td>
<td>carol</td>
<td>ted</td>
<td>alice</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>bob</td>
<td></td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>carol</td>
<td>1</td>
<td></td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>ted</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>alice</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Now that we have essentially built a Network from scratch using Excel, the next step is to save it in a compatible file format ORA can interpret. For Excel spreadsheets this will be the CSV* file format.

263.1.3 From the drop down menu: File => Save As

Make sure you save this file as a CSV (comma delimited)

You have now created a Network from scratch which can be loaded into ORA.

Now return to ORA and load up your new Network. Below is our new Network rendered in the ORA Visualizer. Notice the arrows only point from one node to another if there is a 1 in the column for a particular node. i.e. There is a "1" in the bob column for ted but a "0" in the ted column for bob. So an arrow points from ted to bob but NOT from bob to ted.
264 Hovering

Hovering the pointer over various parts of the panels will reveal information about the Meta-Network.
Hovering over the parts in Panel 1 will reveal different information about the Meta-Networks, Meta-Nodes, and Networks.
265Info Tab - Network

When a Network is selected there are also two tabs, Info and Editor. The Info tab contains a textbox, Network ID in which you can change the name of any network, The Source and Target Node sets, and whether this network is directed or not, the Link Count, and the Density. The two buttons underneath allow the choice of Visualize this Network which will send the entire Meta-Network to the Visualizer or Visualize Only this Network which display only the currently selected Network.

The Editor tab has two views: Binary and Numeric. Binary view is used when you only need to establish a connection between two nodes with no weights. It's a simple Yes or No arrangement.
The Numeric view allows you to treat links between various nodes with more or less importance. Notice that all the row nodes have a check marked connection to the column containing [yu] in the binary mode. This denotes they know one another. But in the numeric mode this value is a 0.5 which is used to denote previous acknowledgement but is an adversary.
Info Tab - NodeSet

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to display information regarding the Meta-Networks, NodeSets, and Networks. But this is the area where you can rename the Node Class ID and the Node Class Type. Place the cursor in the box, make sure the entire name is highlighted, and type in your new name. This area also gives you the Node Count of the selected Node Set as well as the Attribute Names contained within the NodeSet.

The Editor tab contains most of the editing functions.

1. The Search box for finding particular node(s) in a set.
2. The <set filter> for displaying only a particular sub-set of node(s).
3. The Checkboxes to designate which nodes to Delete or Merge.
4. The Nodes buttons: Create, Delete, Merge.
5. The Attributes buttons: Create and Delete.
267 Running an Intelligence Report
267.1 Who are the critical actors?

An Intelligence Report identifies key actors (individuals and groups) who are positioned in the network in ways that make them critical to its operation.

To run an Intelligence Report:

- Return to the ORA interface.
- Go to Analysis in the menu bar and click Generate Reports which brings up the Generate Reports dialog box.
- At the top of the window is a pull-down menu titled Select Report. Pull down the menu by clicking the small inverted arrow icon to its right, and select Intelligence.
- In the box titled Select one or more meta matrices: select the box for the Tanzania Embassy bombing meta matrix.
- At the bottom of the popup window is a file chooser titled Enter a file name (any extension will be ignored) for the results file: Select the [Browse] button to the right and navigate to the location you want. Type in a filename (for example, Intel Output) and select Open.

Below is a screen capture showing the popup windows with the correct options chosen:

- Select the [Next] button at the bottom of the dialog box. Select the [Finish] button.
An HTML file will pop up in your browser displaying the Intelligence Report. The same text is also displayed in Panel 3 in ORA.
Below is a screen capture of the ORA interface with the Intelligence Report displayed in Panel 3:
Below is the HTML file for the Intelligence Report on the Tanzania Embassy bombing data:

**267.2 Intelligence Report**

Input data: TanzaniaEmbassyEnhance_2-07  
Start time: Fri Feb 23 10:30:55 2007

**267.3 KEY ACTORS**
**267.4 Emergent Leader (cognitive demand)**

Measures the total amount of cognitive effort expended by each agent to do its tasks.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.378917</td>
<td>fazul_mohammed</td>
</tr>
<tr>
<td>2</td>
<td>0.341104</td>
<td>khalfan_mohamed</td>
</tr>
<tr>
<td>3</td>
<td>0.299063</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>4</td>
<td>0.280313</td>
<td>a13</td>
</tr>
<tr>
<td>5</td>
<td>0.269833</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>6</td>
<td>0.243792</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>7</td>
<td>0.192542</td>
<td>a10</td>
</tr>
<tr>
<td>8</td>
<td>0.183771</td>
<td>a4</td>
</tr>
<tr>
<td>9</td>
<td>0.180042</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>10</td>
<td>0.176083</td>
<td>a16</td>
</tr>
</tbody>
</table>

**267.5 In-the-Know (total degree centrality)**

The Total Degree Centrality of a node is the normalized sum of its row and column degrees.

Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.4</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>2</td>
<td>0.266667</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>3</td>
<td>0.266667</td>
<td>bin_laden</td>
</tr>
<tr>
<td>4</td>
<td>0.2</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
</tbody>
</table>

492
267.6 Number of Cliques (clique count)

The number of distinct cliques to which each node belongs.
Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>bin_laden</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>ali_mohamed</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>khalid_al-fawwaz</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>a16</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>khalfan_mohamed</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>a4</td>
</tr>
</tbody>
</table>

267.7 Most Knowledge (row degree centrality)

The Row Degree Centrality of a node is its normalized out-degree.
Input graph(s): Agent x Knowledge

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.75</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>2</td>
<td>0.75</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>3</td>
<td>0.75</td>
<td>fazul_mohammed</td>
</tr>
</tbody>
</table>
4 0.5  khalfan_mohamed
5 0.5  wadih_el-hage
6 0.5  ali_mohamed
7 0.5  a10
8 0.5  jamal_al-fadl
9 0.5  a13
10 0.25 bin_laden

267.8 Most Resources (row degree centrality)

The Row Degree Centrality of a node is its normalized out-degree.
Input graph(s): Agent x Resource

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.75</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>2</td>
<td>0.5</td>
<td>fazul_mohammed</td>
</tr>
<tr>
<td>3</td>
<td>0.5</td>
<td>ahmed_ghailani</td>
</tr>
<tr>
<td>4</td>
<td>0.25</td>
<td>khalfan_mohamed</td>
</tr>
<tr>
<td>5</td>
<td>0.25</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>6</td>
<td>0.25</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>7</td>
<td>0.25</td>
<td>bin_laden</td>
</tr>
<tr>
<td>8</td>
<td>0.25</td>
<td>a10</td>
</tr>
<tr>
<td>9</td>
<td>0.25</td>
<td>a16</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>mohamed_owhali</td>
</tr>
</tbody>
</table>

267.9 Leader of Strong Clique (eigenvector centrality)

Calculates the principal eigenvector of the network. A node is central to the extent that its neighbors are central.
Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.167408</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>2</td>
<td>0.147407</td>
<td>bin_laden</td>
</tr>
</tbody>
</table>
The Betweenness Centrality of node v in a network is defined as: across all node pairs that have a shortest path containing v, the percentage that pass through v.

Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.233333</td>
<td>wadih_el-hage</td>
</tr>
<tr>
<td>2</td>
<td>0.197619</td>
<td>mohamed_owhali</td>
</tr>
<tr>
<td>3</td>
<td>0.192857</td>
<td>bin_laden</td>
</tr>
<tr>
<td>4</td>
<td>0.0690476</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>5</td>
<td>0.0452381</td>
<td>mohammed_odeh</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>khalfan_mohamed</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>a4</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>fazul_mohammed</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>ali_mohamed</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>ahmed_ghailani</td>
</tr>
</tbody>
</table>

267.11 Connects Groups (high betweenness and low degree)

The ratio of betweenness to degree centrality; higher scores mean that a node is a potential boundary spanner.

Input graph(s): Agent x Agent

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
</table>

495
1 0.26046  mohamed_owhali
2 0.254184 bin_laden
3 0.205021 wadih_el-hage
4 0.158996 mohammed_odeh
5 0.121339 abdullah_ahmed_abdullah
6 0  khalfan_mohamed
7 0  a4
8 0  fazul_mohammed
9 0  ali_mohamed
10 0  ahmed_gailani

267.12 Unique Task Assignment (task exclusivity)

Detscts agents who exclusively perform tasks.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
<th>Speciality</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.205078</td>
<td>fazul_mohammed</td>
<td>t3</td>
</tr>
<tr>
<td>2</td>
<td>0.0136876</td>
<td>mohamed_owhali</td>
<td>t1</td>
</tr>
<tr>
<td>3</td>
<td>0.0136876</td>
<td>a13</td>
<td>t1</td>
</tr>
<tr>
<td>4</td>
<td>0.011305</td>
<td>abdullah_ahmed_abdullah</td>
<td>t1</td>
</tr>
<tr>
<td>5</td>
<td>0.00995741</td>
<td>ali_mohamed</td>
<td>t1</td>
</tr>
<tr>
<td>6</td>
<td>0.00507781</td>
<td>khalfan_mohamed</td>
<td>t5</td>
</tr>
<tr>
<td>7</td>
<td>0.00366313</td>
<td>a4</td>
<td>t5</td>
</tr>
<tr>
<td>8</td>
<td>0.00141468</td>
<td>mohammed_odeh</td>
<td>t4</td>
</tr>
<tr>
<td>9</td>
<td>0.00141468</td>
<td>a16</td>
<td>t4</td>
</tr>
<tr>
<td>10</td>
<td>0.00134759</td>
<td>ahmed_gailani</td>
<td>t4</td>
</tr>
</tbody>
</table>

267.13 Special Expertise (knowledge exclusivity)

Detscts agents who have singular knowledge.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
<th>Speciality</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.0919699</td>
<td>bin_laden</td>
<td>k4</td>
</tr>
<tr>
<td>Rank</td>
<td>Value</td>
<td>Nodes</td>
<td>Specialty</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>---------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>1</td>
<td>0.108996</td>
<td>abdullah_ahmed_abdullah</td>
<td>r4</td>
</tr>
<tr>
<td>2</td>
<td>0.0965488</td>
<td>ahmed_ghailani</td>
<td>r4</td>
</tr>
<tr>
<td>3</td>
<td>0.0919699</td>
<td>bin_laden</td>
<td>r2</td>
</tr>
<tr>
<td>4</td>
<td>0.0919699</td>
<td>a10</td>
<td>r2</td>
</tr>
<tr>
<td>5</td>
<td>0.0170257</td>
<td>fazul_mohammed</td>
<td>r3</td>
</tr>
<tr>
<td>6</td>
<td>0.0124468</td>
<td>wadih_el-hage</td>
<td>r3</td>
</tr>
<tr>
<td>7</td>
<td>0.0124468</td>
<td>a16</td>
<td>r3</td>
</tr>
<tr>
<td>8</td>
<td>0.00457891</td>
<td>khalfan_mohamed</td>
<td>r1</td>
</tr>
<tr>
<td>9</td>
<td>0.00457891</td>
<td>mohammed_odeh</td>
<td>r1</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>mohamed_owhali</td>
<td></td>
</tr>
</tbody>
</table>

### 267.14 Special Capability (resource exclusivity)

Detections row nodes who have singular ties to column nodes.
Input graph(s): Agent x Resource

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
<th>Specialty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.108996</td>
<td>abdullah_ahmed_abdullah</td>
<td>r4</td>
</tr>
<tr>
<td>2</td>
<td>0.0965488</td>
<td>ahmed_ghailani</td>
<td>r4</td>
</tr>
<tr>
<td>3</td>
<td>0.0919699</td>
<td>bin_laden</td>
<td>r2</td>
</tr>
<tr>
<td>4</td>
<td>0.0919699</td>
<td>a10</td>
<td>r2</td>
</tr>
<tr>
<td>5</td>
<td>0.0170257</td>
<td>fazul_mohammed</td>
<td>r3</td>
</tr>
<tr>
<td>6</td>
<td>0.0124468</td>
<td>wadih_el-hage</td>
<td>r3</td>
</tr>
<tr>
<td>7</td>
<td>0.0124468</td>
<td>a16</td>
<td>r3</td>
</tr>
<tr>
<td>8</td>
<td>0.00457891</td>
<td>khalfan_mohamed</td>
<td>r1</td>
</tr>
<tr>
<td>9</td>
<td>0.00457891</td>
<td>mohammed_odeh</td>
<td>r1</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>mohamed_owhali</td>
<td></td>
</tr>
</tbody>
</table>

### 267.15 Workload (actual based on knowledge and resource)

The knowledge and resources an agent uses to perform the tasks to which it is assigned.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.692308</td>
<td>fazul_mohammed</td>
</tr>
</tbody>
</table>
267.16 Key Knowledge

Dominant Knowledge (total degree centrality)
The Total Degree Centrality of a node is the normalized sum of its row and column degrees.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.571429</td>
<td>k2</td>
</tr>
<tr>
<td>2</td>
<td>0.428571</td>
<td>k1</td>
</tr>
<tr>
<td>3</td>
<td>0.333333</td>
<td>k3</td>
</tr>
<tr>
<td>4</td>
<td>0.0952381</td>
<td>k4</td>
</tr>
</tbody>
</table>

267.17 Key Resources

Dominant Resource (total degree centrality)
The Total Degree Centrality of a node is the normalized sum of its row and column degrees.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.333333</td>
<td>r3</td>
</tr>
<tr>
<td>2</td>
<td>0.285714</td>
<td>r1</td>
</tr>
<tr>
<td>3</td>
<td>0.190476</td>
<td>r4</td>
</tr>
<tr>
<td>4</td>
<td>0.142857</td>
<td>r2</td>
</tr>
</tbody>
</table>

267.18 Key Locations
Dominant Location (total degree centrality)
The Total Degree Centrality of a node is the normalized sum of its row and column degrees.

<table>
<thead>
<tr>
<th>Rank</th>
<th>Value</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.125</td>
<td>u_s</td>
</tr>
<tr>
<td>2</td>
<td>0.847222</td>
<td>afghanistan</td>
</tr>
<tr>
<td>3</td>
<td>0.833333</td>
<td>pakistan</td>
</tr>
<tr>
<td>4</td>
<td>0.722222</td>
<td>washington</td>
</tr>
<tr>
<td>5</td>
<td>0.708333</td>
<td>indonesia</td>
</tr>
<tr>
<td>6</td>
<td>0.701389</td>
<td>europe</td>
</tr>
<tr>
<td>7</td>
<td>0.673611</td>
<td>airport</td>
</tr>
<tr>
<td>8</td>
<td>0.604167</td>
<td>america</td>
</tr>
<tr>
<td>9</td>
<td>0.527778</td>
<td>turkey</td>
</tr>
<tr>
<td>10</td>
<td>0.506944</td>
<td>somalia</td>
</tr>
</tbody>
</table>
PERFORMANCE INDICATORS

<table>
<thead>
<tr>
<th>Entity class</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>16</td>
</tr>
<tr>
<td>event</td>
<td>3</td>
</tr>
<tr>
<td>knowledge</td>
<td>4</td>
</tr>
<tr>
<td>location</td>
<td>54</td>
</tr>
<tr>
<td>resource</td>
<td>4</td>
</tr>
<tr>
<td>task</td>
<td>5</td>
</tr>
</tbody>
</table>

**Overall Complexity** = 0.22707503

Density of the Meta-Matrix: **Social Density** = 0.11666667

Density of the Agent x Agent network: **Social Fragmentation** = 0.45

Fragmentation of the Agent x Agent network: **Communication Congruence** = 0.416667

Measures to what extent the agents communicate when and only when it is needful to complete tasks. Perfect congruence requires a symmetric Agent x Agent network: **Knowledge Congruence** = 0.55

Measures the similarity between what knowledge are assigned to tasks via agents, and what knowledge are required to do tasks. Perfect congruence occurs when agents have access to knowledge when and only when it is needful to complete tasks: **Performance As Accuracy** = 0.36

Measures how accurately agents can perform their assigned tasks based on their access to knowledge and resources: **Avg Communication Speed** = 0.438406

The average speed with which any two nodes can interact. This is based on the inverse of the shortest path lengths between node pairs.

Produced by ORA developed at CASOS - Carnegie Mellon University

From this Intelligence Report, it appears that Fazul Mohammed, Khalfan Mohamed, Mohamed Owhali, Mohammed Odeh, Abdullah Ahmed Abdullah, and Wadih El-Hage are among the most important people in the terrorist network. This means they may have a great deal of knowledge, influence over many other agents in the network, special expertise or capability, or access to important resources and locations.

For example, Wadih El-Hage is important because he is the most in-the-know, commands important cliques within the network, and has the most potential influence in the network.
III. What do we know about an actor of interest?

There are three ways to get additional information about an actor of interest:

1. Visualize information about a selected actor

For example, we can view information about Wadih El-Hage.

- Return to the meta matrix visualization pop-up window.
- Single-click on the red circle for the actor of interest. A window will pop up displaying information on the actor.

Below is a screen capture of the information resulting from clicking on the red circle for Wadih El-Hage:
267.21 2. Visualize an actor's sphere of influence

A sphere of influence is the set of actors, groups, knowledge, resources, events, and locations that influence and are influenced by a particular actor of interest. For example, we can examine the sphere of influence of Ahmed Ghailani.

To visualize an actor's sphere of influence:

- Return to the meta matrix visualization pop-up window.
- Make sure the whole meta matrix is visualized. If it isn't, go to Actions in the menu bar and select Show All Entities.
- Go to Tools in the menu bar and select Sphere of Influence. A window titled Sphere of Influence (Ego Network) will pop up.
- In the Search field halfway down the popup window, type the beginning of the actor's name. From the options that appear in the chart below, click the box next to the name of your actor of interest. That actor's sphere of influence will be displayed in the visualization window.

Below is a visualization of the sphere of influence of Ahmed Ghailani:

![Visualization of Ahmed Ghailani's sphere of influence]

To return to the original full meta matrix visualization, go to Actions in the menu bar and select Show All Entities.
267.22 3. Run a Sphere of Influence Report

A Sphere of Influence Report for an individual identifies the set of actors, groups, knowledge, resources, events, and locations that influence and are influenced by that actor.

For example, we can examine the sphere of influence of Ahmed Ghailani.

To run a Sphere of Influence Report:

- Return to the ORA interface.
- Go to Analysis in the menu bar and click Generate Reports. A window titled Generate Reports pops up.
- At the top of the window is a pull-down menu titled Select Report. Pull down the menu by clicking the small inverted arrow icon to its right, and select Sphere of Influence.
- In the box titled Select one or more meta matrices: click the box for the Tanzania Embassy bombing meta matrix.
- At the bottom of the popup window is a file chooser titled Enter a file name (any extension will be ignored) for the results file: Click the Browse button to the right and navigate to the location you want. Type in a filename (for example, SOI Output) and click Open.
- Click the Next button at the very bottom of the popup window.
- From the pull-down menu titled Select an Entity: choose Ahmed Ghailani.
- Click the Finish button.

It may take a few minutes for ORA to run the Sphere of Influence Report. When ORA is finished, a small window will pop up tell you the analysis was successfully completed. Click OK.

An HTML file displaying the Sphere of Influence Report will pop up in your browser window.

Below is the HTML file for Ahmed Ghailani's sphere of influence:
267.23 SPHERE-OF-INFLUENCE REPORT

Input data: TanzaniaEmbassyEnhance_2-07
Start time: Fri Feb 23 11:10:54 2007

267.24 Sphere of Influence Analysis for agent ahmed_ghailani

The radius of the network is 1

267.25 Size Statistics

Contains the size of each node type within the ego network, expressed as an absolute value and as a percentage of the nodes in the original input network.

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Size</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent</td>
<td>1</td>
<td>+6%</td>
</tr>
<tr>
<td>manual_location</td>
<td>6</td>
<td>+11%</td>
</tr>
</tbody>
</table>
267.26 Attributes

These are the attributes of the ego node.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>first_name</td>
<td>ahmed</td>
</tr>
<tr>
<td>hostility_level</td>
<td>2</td>
</tr>
<tr>
<td>kinship</td>
<td>mother</td>
</tr>
<tr>
<td>last_name</td>
<td>ghailani</td>
</tr>
<tr>
<td>nationality</td>
<td>tanzanian</td>
</tr>
<tr>
<td>nationality_relation</td>
<td>hostile</td>
</tr>
<tr>
<td>nyi</td>
<td>president</td>
</tr>
<tr>
<td>source_date</td>
<td>2006-05-10</td>
</tr>
<tr>
<td>source_name</td>
<td>xmldata/pacrim_ilchul.xml</td>
</tr>
<tr>
<td>title</td>
<td>ahmed_khalfan_ghailani</td>
</tr>
</tbody>
</table>

267.27 Exclusive Connections

Find nodes that have connections exclusively to the ego node. These are also called pendant nodes of the ego.

There are no pendants attached to this node.

267.28 Most Similar Node

Computes the node that is most similar to the ego node with respect to Cognitive Similarity. This is computed two ways: first, using just the ego network, and second, using the original input network.

<table>
<thead>
<tr>
<th>Network</th>
<th>Node Type</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Network</td>
<td>agent</td>
<td>abdullah_ahmed_abdullah</td>
</tr>
<tr>
<td>Ego Network</td>
<td>agent</td>
<td>ahmed_ghailani</td>
</tr>
</tbody>
</table>

267.29 Top Measures
Computes a collection of standard network analysis measures and reports those for which the ego node is among the top 10 nodes.

<table>
<thead>
<tr>
<th>Measure Name</th>
<th>Measure Input</th>
<th>Rank</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centrality, Row Degree</td>
<td>Agent x Resource</td>
<td>3</td>
<td>0.5</td>
</tr>
<tr>
<td>Centrality, Betweenness</td>
<td>Agent x Agent</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Boundary Spanner, Potential</td>
<td>Agent x Agent</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Exclusivity, Task</td>
<td>Agent x Task</td>
<td>10</td>
<td>0.00134759</td>
</tr>
<tr>
<td>Exclusivity</td>
<td>Agent x Resource</td>
<td>2</td>
<td>0.0965488</td>
</tr>
<tr>
<td>Actual Workload</td>
<td>Agent x Knowledge</td>
<td>10</td>
<td>0.0769231</td>
</tr>
</tbody>
</table>

**267.30 Measure Value Range**

Computes a collection of network analysis routines for all the nodes in the network and reports whether the ego node has a Low, Medium, or High value with respect to the other nodes. Low means less than one standard deviation from the mean; high means more than one standard deviation from the mean; Medium is neither low nor high.

<table>
<thead>
<tr>
<th>Measure Name</th>
<th>Measure Input</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognitive Demand</td>
<td>Agent x Agent</td>
<td>Medium</td>
</tr>
<tr>
<td>Centrality, Total Degree</td>
<td>Agent x Agent</td>
<td>Medium</td>
</tr>
<tr>
<td>Clique Count</td>
<td>Agent x Agent</td>
<td>Medium</td>
</tr>
<tr>
<td>Centrality, Eigenvector</td>
<td>Agent x Agent</td>
<td>Low</td>
</tr>
<tr>
<td>Centrality, Betweenness</td>
<td>Agent x Agent</td>
<td>Medium</td>
</tr>
<tr>
<td>Boundary Spanner, Potential</td>
<td>Agent x Agent</td>
<td>Medium</td>
</tr>
<tr>
<td>Exclusivity, Task</td>
<td>Agent x Task</td>
<td>Medium</td>
</tr>
<tr>
<td>Exclusivity, Knowledge</td>
<td>Agent x Knowledge</td>
<td>Medium</td>
</tr>
<tr>
<td>Exclusivity</td>
<td>Agent x Resource</td>
<td>High</td>
</tr>
<tr>
<td>Actual Workload</td>
<td>Agent x Knowledge</td>
<td>Medium</td>
</tr>
</tbody>
</table>
**Resource Analysis Section**

Computes the resources that ahmed_ghailani can directly leverage and that can be mobilized. Direct resource are those directly connected to it, and indirect resources are those directly connected to a neighbor.

Resources that can be leveraged

Resources that can be mobilized

ahmed_ghailani does not have any resources to mobilize.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Value</th>
<th>Percent of total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct resources</td>
<td>2</td>
<td>+50%</td>
</tr>
<tr>
<td>Indirect resources</td>
<td>0</td>
<td>0%</td>
</tr>
<tr>
<td>Possibly constrained resources</td>
<td>0</td>
<td>0%</td>
</tr>
</tbody>
</table>

Possibly constrained resources are both directly and indirectly linked to the ego entity.

Contacts with the most resources (directly linked entities with the most resources):

<table>
<thead>
<tr>
<th>Name</th>
<th>Number of resources</th>
</tr>
</thead>
</table>

Contacts with the unique resources (directly linked entities with exclusive resources):

<table>
<thead>
<tr>
<th>Name</th>
<th>Unique resources</th>
</tr>
</thead>
</table>

Produced by ORA developed at CASOS - Carnegie Mellon University
IV. What are the connections between two actors of interest?

Sometimes, rather than influencing an actor directly, you may want to examine whether that actor has a connection with someone who is more interesting to you. For this, the Path Finder feature is most useful.

For example, we can look at how Ahmed Ghailani and Wadih El-Hage are connected. To use the Path Finder feature:

- Return to the meta matrix visualization pop-up window.
- Make sure the whole meta matrix is visualized. If it is not, go to Actions in the menu bar and select Show All Entities.
- Go to Tools in the menu bar and select Path Finder. A window titled Path Finder will pop up.
- In the bottom half of this pop-up window, there are two tabs titled Entity 1 and Entity 2. Entity 1 is the from entity, and Entity 2 is the to entity. In other words, Path Finder searches for communication and information that is passed from Entity 1 to Entity 2.
- In the Entity 1 tab, type the name of your first actor of interest into the Search field. From the chart of agents below the Search field, check the box for the name of that agent. (For example, Ahmed Ghailani).
- Click on the Entity 2 tab and type in the name of your second actor of interest into the Search field. From the chart of agents below the Search field, check the box for the name of that agent. (For example, Wadih El-Hage).
- The visualization of the connections between Entity 1 and Entity 2 will appear in the visualization window.
Below is a screen capture showing the connection between Ahmed Ghailani and Wadih El-Hage:

267.33 V. What is the immediate impact of a particular agent on the network?
VI. What happens to the network when certain entities are removed?

We can examine the impact of removing a particular entity from the network by using Near Term Analysis (NTA). NTA removes a given entity and estimates the changes in the remaining network.

This provides a what if?... analysis of the network. We can simulate strategic interventions or eliminations of certain agents, and examine how the network should react and change. For example, we can look at how the Tanzania Embassy bombing network changes if Ahmed Ghailani and/or Wadih El-Hage are eliminated.

To run a Near Term Analysis:
1. Start the Near Term Analysis window

   - Return to the ORA interface.
   - Make sure the meta matrix is highlighted in Panel 1. If it is not highlighted, single-click on it.
   - Go to Analysis in the menu bar and select Near-Term Analysis. A window titled Near Term Analysis will pop up.

NTA has two modes, Novice and Advanced, displayed as tabs in the Near Term Analysis pop-up window. Novice mode provides an automatic analysis set-up, but does not allow users to set up their own hypotheses.

   - Click on the Advanced mode tab to switch to Advanced mode.

Below is a screen capture showing the Advanced mode tab in the Near Term Analysis pop-up window:
• In the field titled Settings, find the number boxes on the far right. Change the number of replications (the top number box) to 2, and the number of simulated time-points (the bottom number box) to 52. The timeline in the Simulated time line field will expand to include 52 time-steps.

2. Open the simulation scenario wizard

• In the middle of the pop-up window, find and click the Add new simulation instances button. A small window titled Near Term Analysis - Simulation scenario create wizard will pop up.

Below is a screen capture showing this wizard window:

![Near Term Analysis - Simulation scenario create wizard](image)

• In this wizard window, make sure the first option in the Options field is selected. Click the Next button. The wizard window will display options for creating a custom scenario.
Below is a screen capture showing this custom scenario field in the wizard window:

3. Remove Wadih El-Hage

- Click the box for Wadih El-Hage in the table of agents in the wizard window. Change the Timing box to 10 in the same row.
- To add this event set-up to the Near Term Analysis, click the Add events button located next to the Search field (above the list of agents).

The timeline at the top of the wizard window will mark the isolation of Wadih El-Hage at time 10.
Below is a screen capture of this timeline:

![Near Term Analysis - Simulation scenario create wizard](image)

- Click the Add a simulation button at the bottom of the wizard window. The wizard window will close automatically. In the NTA window, the new simulation case will appear in the Cases to simulate field.

4. Remove Ahmed Ghailani

- Follow Step 3, but replace Wadih El-Hage with Ahmed Ghailani.

Your two simulation cases appear in the Near Term Analysis window in the Cases to simulate field, along with the Baseline case. The Baseline case is simply the network with no entities removed.

You can view your different simulation cases by clicking on them in the Cases to simulate field, and the simulation time-line will change accordingly.

5. Run the Near Term Analysis

- Click the Execution button at the bottom of the Near Term Analysis window.
- A small window will pop up to warn you that the execution may take a long time. Click OK. Another small window will pop up to show you how the simulations are progressing in the Near Term Analysis.

6. View the results of the Near Term Analysis

- When the analysis is complete, a new window titled Near Term Analysis Results will pop up.

513
Below is a screen capture of the results pop-up window:

These two performance lines correspond to deviations from the baseline of knowledge diffusion over time. Examining this performance change over time reveals how much an agent's elimination impacts the performance of the organization.

- To draw a bar chart, click the Draw bar chart button in the results window. The resulting bar chart displays a performance comparison for each time-point.
Below is a screen capture of the bar chart:

The results of the Near Term Analysis are also available in HTML format.

7. Save the results of the Near Term Analysis in HTML format

- Go to File in the menu bar and select Save the html report. A file chooser window will pop up. Navigate to the location you want and type a filename for your HTML report.
- A window titled Image Size Input will pop up. Type in the width of the image and click OK.
- Another window titled Project Saved will pop up displaying the location of your saved analysis results. Click OK.

8. Save the organizational structures resulting from your simulations in ORA

- Return to the ORA interface.
- To save the Agent-to-Agent communication network at time-step 40 in the simulation, go to File and select Save the Agent-to-Agent communication matrices during evolution.
- A small window titled Save the probability of interaction matrix will pop up. Click the Yes button.
- Another small window titled Save timing will pop up. Enter 40 and click OK.
- A final window titled Saved will pop up. Click OK.
You can view saved simulations in Panel 1 of the ORA interface.
Below is a screen capture of Panel 1 after simulations have been saved:
Create a New Meta-Network

There are times you need to run measures on or visualize only part of an existing Meta-Network. This section will show you the easy way to create sub-sets of an existing Meta-Network. First duplicate the Meta-Network. Highlight the Meta-Network then from the main menu select Edit => Copy Meta-Network. Then form the main menu select Edit => Paste Meta-Networks. It would be a good idea to rename this new Meta-Network immediately so as to not get it confused with the original.

Next, expand the Meta-Network you want by clicking the [+] if it isn't expanded already. Highlight the Node Set with the nodes you want to remove.

In panel 2 select the Editor tab which brings up the matrix with nodes on the vertical and attributes on the horizontal. Below each attribute is a <set filter>. Below left is the stargate_summit meta-network along with the ally attribute. I wish to make a new meta-network of the good guys only. In the dropdown menu under ally I select no. These are the nodes I want to remove.

Place a checkmark in the box of each node. Below the matrix under Nodes are three buttons. Click the [Delete] button. The new Node Set now contains only the nodes that had yes in the attribute ally.
With this same procedure I created a Meta-Network of only the bag guys.

**Creating or Deleting Nodes**

**Creating a new Node**

What follows are procedures for creating a new node in your dataset. Highlight a NodeSet where the node is to be added. Click [Create].

You will be prompted to input the number of new nodes you want to create in the NodeSet. Input the number of nodes to add and select [OK] and the new node(s) will appear at the bottom of the Node Set.

The new node can then be renamed by clicking inside the cell.

**268.1 Delete an existing node**

To delete a node from a NodeSet place a checkmark in the box(es) to the left of the node(s) and select [Delete].

Select [OK] and all nodes with checkmarks will be deleted from the NodeSet.
268.2 Merge two nodes

The Merge button combines the links and attributes of the selected nodes and creates a merged or combined node. The nodes that were merged are removed, and replaced with the combined node. Used primarily when data needs to be consolidated.

Example: You have two nodes, Bob and Robert. They are actually the same node and you want to combine their information into one node.

269 Performing a View Network Over-Time Analysis
270 Performing a Measures Over Time Analysis

[Note: This help document requires that you are already familiar with the Measures Over Time tool and its attendant areas. If not, see Measures Over Time for an overview prior to running the analysis below.]

To begin your Measures Over Time Analysis, you must first load time captures of a Meta-Network in the form of separate Meta-Networks indicative of the time period in question.

Be sure to make sure you have all the Meta-Networks "selected."

From the main menu bar: Visualization >> View Networks Over Time

In this example we set the Aggregation Level to "By Year" in Area 1. and chose "Complexity, Omega Knowledge, Task Completion and Connectedness, Agent x Agent" in "Area 2.

In Area 3, the Measures Over Time tool plotted 4 points from the three Meta-Networks we had loaded, TanzaniaEmbassyEnhanced_02-07_1996,
TanzaniaEmbassyEnhanced_02-07_1997 and TanzaniaEmbassyEnhanced_02-07_1998 and showed us the resulting graph in Area 3.

Please note: you can use the tabs to choose to visualize the same data using the Fast Fourier Transform or change Detection tools, which are additionally available in this panel.

270.1 See Also...

Fast Fourier Transform (In development)

Change Detection (In development)
The purpose of this lesson is to perform both a View Network Over Time and View Measures Over Time Analysis.

To do so requires multiple network datasets representative of your network over different times.

The goal is to analyze how a network changes across multiple times. The period is determined by the intervals of collected network data and presented as multiple Meta-Matrices, which are loaded into ORA in sequential order. The steps below provide detailed instruction on how type of analysis.

To perform a View Network Over-Time Analysis, you must load Meta-Matrices that relate to different time captures of your network data, which need to be in the form of multiple Meta-Matrices.

In the following example, we will use network time captures of the 1998 Embassy Bombing in Tanzania Meta-Matrix data set and compare the same data set as we knew it in 1997 and 1996 and 1998. We will then compare all the Meta-Matrices in the Network Over-Time Viewer to gain a visual representation of how this network changed between 1996 and 1998.

*NOTE: For our purposes, we have changed data in this example and have renamed the Meta-matrix for three different years. This will denote different network variables that have changed over time.*

You will see in the left windowpane under input dataset three Meta-Matrices, 1998, 1997, and 1996, have been loaded.
From the main menu, select File => Open Meta Matrix

Choose [Select Files]
You will see all of our example data sets, which will load simultaneously into ORA, buy highlighting and selected all the files.
Highlight all files you analyze in Over-Time Viewer. Press [Enter].

The import data window will appear (below). This will confirm the files you wish to analyze.

The import data window will appear (below). This will confirm the files you wish to analyze.

Select [Finish].
All three Meta-Matrices should display in Panel 1.

270.2 Performing the Over-Time Analysis

Now that we have time captures of our network data represented and loaded into ORA in the form of three Meta-Matrices relating to 1996, 1997 and 1998, we can perform the Over-Time Analysis.

270.2.1.1 From the Menu Bar => Data Visualization => View Network Over-Time

The ORA Visualizer will render all of the loaded Meta-Matrices. Please take special note of the Time Viewer pop-up Window. This window displays a slider, which will allow you to quickly change from the first Meta-Matrix time capture of 1996, to 1997 and 1998 respectively.
By moving the slider from one Meta-Matrix to the next, you will gain a visual perspective on how the network has changed over Time.

The series of screen shots below display how the visualized data changes from one slider to position to the next. These renders then allow you a picture of how the network changes Over-Time.

**NOTE :** Depending on the complexity of the network and the extent to which relationships (ties) have changed, the visualization of those changes may be subtle.

The screen shots below, however, will emphasize the extent to which the role of the WTC Event node has changed from 1996 to 1998 in relation to the network of which it is part of namely the Tanzania data set. Below these screen captures, are a series of detail screen captures focusing on the WTC Event node.

**270.3 Example Slider Position 1**
270.4 Example Slider Position 2

270.5 Example Slider Position 3
Detail of WTC Event Node when visualized in the Over-Time Viewer as part of the 1996, 1997 and 1998 Tanzania Data Sets.

270.6 WTC Event Node: Detail 1 - 1996

1999 Tanzania Data Set: WTC Event Entity
270.7 WTC Event Node: Detail 2 - 1997

270.7.1.1 Notice how the relationships of this node to the rest of the network has changed from 1996 to 1997.

270.7.1.2 Notice that the connections (links) have changed from 1996 to 1997.
As you can see, as we progress through the data sets pertaining to 1996, 1997 and 1998, the event node WTC lost direct ties to other parts of the network. In the 1996 data set, WTC had 3 ties to other nodes in the Tanzania Embassy network; In 1997, only 2; Finally, in 1998, the WTC event node had only 1 link to Tanzania Network. This may indicate that the WTC node may have lost importance from one year to the next.

270.8 Summary of Lesson

At this point, you should be able to complete the following tasks to perform an Over-Time Network Analysis.

- Load multiple Time Data Captures in the form of Meta-Matrices, which are representative of your network (Meta-Matrix) over time.
- Use the Over-Time slider window tool to move from one time capture to the next.
- Gain a visual perspective of how your overall network has changed from one time capture to the next.
Performing the View Measures Over-Time Analysis

ORA provides an alternative method to analyzing your network data (in the form of MetaNetworks captured over time) than the only in the Visualizer. By running a View Measures Over Time analysis you can visualize how your network changes in relation to any given measure in the form of charts, which take you from one time point to the next. Below is a series of screen captures and instruction on how to access the View Measures Over Time feature:

From the main menu bar select Data Visualization => View Measures Over Time

271.1 Performing the View Measures Over-Time Analysis

ORA provides an alternative method to analyzing your network data (in the form of MetaNetworks captured over time) than the only in the Visualizer. By running a View Measures Over Time analysis you can visualize how your network changes in relation to any given measure in the form of charts, which take you from one time point to the next. Below is a series of screen captures and instruction on how to access the View Measures Over Time feature:

271.1.1 From the main menu bar: Data Visualization => View Measures Over Time

Select View Measures Over Time.

Select [OK]
The View Measure Over Time Window will appear. You will see that this window is primarily organized into three sections.
Area 1: is a slider where you can control various inputs that affect the aggregation level of your Meta Matrices.
Area 2: is a tabbed index allowing you to select the graph level you desire and the individual node sets you are interested in analyzing.
Area 3: displays the actual chart based on the measures you selected in the tabbed index and the position of the aggregation slider.

271.2 Interpreting The Results After Performing View Measures Over-Time Analysis

In the example above, we have loaded all three of our network time captures into the View Measures Over Time Analysis tool. The result of our analysis, as we have indicated before, will be displayed as a chart in the bottom section of the ORA interface in Panel 3. But, what does this tell us? To find out, we will examine the Graph Level measure Knowledge Waste. From the tabbed measures window:

271.2.1.1 Graph tab > Congruence, Organization Measure, Knowledge Waste.
The result is displayed below.

We can see the chart displays an axis scale correlating to our networks over time. The graph level measure of Knowledge Waste was selected using the View Measures Over Time tool and the result is displayed in the chart area of the window.

We can see that the graph level measure of Knowledge Waste held a value slightly above 40 in the first Meta Matrix, 1996, displayed with 1 on the Time axis. We can deduce from the chart that in 1997 something affected our measure of Knowledge Waste to increase the value to nearly 60. This corresponds to the time scale axis of 2, which represents 1997, our second year of network data. In the final year, 1998, our measure of Knowledge Waste declined to the value in 1996. This should be visually evident with its relative line graph position.

It is clear that the value for the Knowledge Waste Measure increased from the first Meta Matrix (1996) to the second (1997) and then retreated back to its original (1996) level. It would be up to you to determine what may have affected that measure for it to undergo this progression and regression.

**Summary of Lesson**

At this point, you should be able to complete the following tasks to perform a View Measures Over-Time Analysis:

- Load multiple data files into ORA (in the form of Meta-Matrices) representative of your network across certain periods.
- Select an aggregation level and choose a graph level or node level set to analyze.
- Analyze the data output in the charting tool located in the bottom section of the View Measures Over Time window.
See how your network may have changed from one time capture to the next for any given graph level or entity node measure. Use this visual comprehension to draw conclusions about how your network changed across multiple times.

272 Renaming
272.1 Renaming Meta-Networks, Meta-Nodes, and Networks

ORA allows you to rename the Meta-Network, Meta-Node, and Networks. This helps make the information clearer for you. Below I renamed one of the Meta-Nodes to those guys and also renamed the type to who?. You can see how it's reflected throughout the entirety of panel 1. So you can rename any Meta-Node in a Meta-Network for better readability.

273 Running An Over-Time Analysis
273.1 Overview: Over-Time Viewer

To run the Over-Time Viewer, you must first load MetaNetworks that relate to different time captures of network data. In the example below, you will see in the left window pane under input dataset three MetaNetworks, 2000, 2001, and 2002, have been loaded. Once you have loaded your MetaNetworks, select the Over-Time Viewer from the main interface tool bar under Data Visualization. The black ellipse in the screen shot below illustrates how to access the Over-Time Viewer from ORA's main interface.
From the drop-down menu: Data Visualization => Over Time Viewer

After you select Over-Time Viewer from the drop-down menu, the following information pop-up window will appear:

Click [OK]
The Over-Time Viewer will merge your loaded MetaNetworks. In this case 2000, 20001, and 2002 will merge. The Progress... pop-up window (below) details the status as ORA runs measures on the merged MetaNetworks:

![Progress Window]

When it is finished running, the View Measures Over Time window appears next (screen shot below). Here you can run specific measures against the node sets within your merged MetaNetworks. In the example below, we see that we have opted to run the measure Chart_Measures against the node set Centrality-Total Degree. Multiple sets of nodes can be selected against a measure by using "ctrl-click."
The results are displayed in the chart at the bottom of the View Measures Over Time window (shown above).

Based on this analysis, we can conclude the overall Centrality-Total Degree measure of our network sample had increased slightly from 2000 to 2001, then decreased noticeably in 2002.
Bibliography

- Newman MEJ, Moore C., Watts DJ, Mean-field solution of the small-world network model, PHYS REV LETT 84 (14): 3201-3204 APR 3 2000
- Watts DJ, Networks, dynamics, and the small-world phenomenon, AM J SOCIOLO 105 (2): 493-527 SEP 1999
275.1 Mixture of Topological Forms


275.2 Circle / Wheel


275.3 Matrix


275.4 Hierarchy

275.5 Core-Periphery


275.6 Random


275.7 Small-World


275.8 Bow-Tie


275.9 Cellular


275.10 Scale-Free


275.11 Complex Networks (Statistical Mechanics)


275.12 Network Processes


278 Glossary

A

Adjacency Matrix – A Matrix that is a square actor-by-actor (i=j) matrix where the presence of pair wise edges are recorded as elements. The main diagonal, or self-tie of an adjacency matrix is often ignored in network analysis.

Aggregation – Combining statistics from different entities to higher entities.

Algorithm – A finite list of well-defined instructions for accomplishing some task that, given an initial state, will terminate in a defined end-state.

Attribute – Indicates the presence, absence, or strength of a particular connection between entities in a Matrix.

B

Betweenness – Degree an individual lies between other individuals in the network; the extent to which an entity is directly connected only to those other entities that are not directly connected to each other; an intermediary; liaisons; bridges. Therefore, it's the number of entities who an entity is connected to indirectly through their direct links.

Betweenness Centrality – High in betweenness but not degree centrality. This entity connects disconnected groups, like a Go-between.

Bimodal Network – A network most commonly arising as a mixture of two different unimodal networks*.

Binarize – Divides your data into two sets; zero or one.

Bipartite Graph – Also called a bigraph. It's a set of entities decomposed into two disjoint sets such that no two entities within the same set are adjacent.

C

Caesar III – An application for the design of information processing and decision making organizations. An application for the design of decision making organizations at the operational and tactical levels; it takes into consideration cultural differences in coalitions and of adversaries. This tool is under development by George Mason University.

Categorical – An Attribute Type used primarily used for grouping nodes.

Centrality – The nearness of an entity to all other entities in a network. It displays the ability to access information through edges connecting other entities. The closeness is the inverse of the sum of the shortest distances between each entity and every other entity in the network.

Centralization – Indicates the distribution of connections in the employee communication network as the degree to which communication and/or information flow is centralized around a single agent or small group.

Characteristic Path Length – The median of the average shortest distances (number of links) connecting each employee to all other employees.

Interpretation
Characteristic path length gives a insight into how information spreads. It reflects the communication performance of the entire network and is important for diffusing information and routing information to the right people. A small average path length results in fewer “hops” where individuals or groups don’t get information.

**Classic SNA density** – The number of edges divided by the number of possible edges not including self-reference. For a square matrix, this algorithm* first converts the diagonal to 0, thereby ignoring self-reference (an entity connecting to itself) and then calculates the density. When there are N entities, the denominator is (N*(N-1)). To consider the self-referential information use general density.

**Clique** – A sub-structure that is defined as a set of entities where every entity is connected to every other entity.

**Clique Count** – The number of distinct cliques to which each entity belongs.

**Closeness** – Entity that is closest to all other Entities and has rapid access to all information.

**Clustering coefficient** – Used to determine whether or not a graph is a small-world network.

**Cognitive Demand** – Measures the total amount of effort expended by each agent to do its tasks.

**Column Degree** – see Out Degree*.

**Complexity** – Complexity reflects cohesiveness in the organization by comparing existing links to all possible links in all four networks (employee, task, knowledge and resource).

**Complementarity** – The idea that people seek others with characteristics that are different from and complement their own, aka the idea that opposites attract.

**Concor Grouping** – Concor recursively splits partitions and the user selects n splits. (n splits -> \(2^n\) groups). At each split it divides the entities based on maximum correlation in outgoing connections. Helps find groups with similar roles in networks, even if dispersed.

**Congruence** – The match between a particular organizational design and the organization’s ability to carry out a task.

**Construct** – A reduced form of Construct is found in ORA in the Near Term Impact Report.

**Continuous** – A Attribute Type primarily used for values that are numerical so that statistical analysis can be be performed (Average, Minimum, Maximum, and Standard Deviation).

**Count** – The total of any part of a MetaNetwork row, column, entity, edge, isolate, etc.

**CSV** – File structure meaning Comma Separated Value. Common output structure used in database programs for formatting data.

**D**

**Degree** – The total number of edges to other entities in the network.

**Degree Centrality** – Entity with the most connections. (i.e. In the know). Identifying the sources for intel helps in reducing information flow.

**Density** –
- **Binary Network**: The proportion of all possible edges actually present in the Matrix.
- **Value Network**: The sum of the edges divided by the number of possible edges. (i.e. the ratio of the total edge strength that is actually present to the total number of possible edges).

**Dyad** – Two entities and the connection between them.

**Dyadic Analysis** – Statistical analysis where the data is in the form of ordered pairs or dyads. The dyads in such an analysis may or may not be for a network.

**Dynamic Network Analysis** – Dynamic Network Analysis (DNA) is an emergent scientific field that brings together traditional Social Network Analysis* (SNA), Link Analysis* (LA) and multi-agent systems (MAS).

**DyNetML** – DynetML is an xml based interchange language for relational data including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal data interchange format to enable exchange of rich social network data and improve compatibility of analysis and visualization tools.

**E**

**Edge** – See Link.

**Entity** – A *who, what, where, how, why, or thing* that is being studied such as people, agents, organizations, beliefs, expertise, resource, tasks, events, or locations. Node the representation of a single entity (a who, what, where, how why item).

**Entity Class** – A set of entities of one type.

**Entity Level Metric** – is one that is defined for, and gives a value for, each entity in a network. If there are x entities in a network, then the metric is calculated x times, once each for each entity. Examples are Degree Centrality*, Betweenness*, and Cognitive Demand*.

**Entity Set** – See Meta-Node.

**Eigenvector Centrality** – Entity most connected to other highly connected entities. Assists in identifying those who can mobilize others.

**F**

**FOG** – (F)uzzy (O)verlapping (G)roups. Gives a better understanding of individuals spanning groups. Fuzzy groups are a more natural and compelling way of thinking of human social groups.

**G**

**General density** – The number of edges divided by the number of possible edges including self-reference. For a square matrix, this algorithm* includes self-reference (an entity connecting to itself) when it calculates the density. When there are N entities, the denominator is (N*N). To ignore self-referential information use classic SNA* density.

**Geodesic Distance** – A generalization of the notion of a straight line to curved spaces. In presence of a metric, geodesics are defined to be (locally) the shortest path between points on the space.
**Gini coefficient** – The measure of inequality of a distribution of income. Uses a ratio with values between 0 and 1: the numerator is the area between the Lorenz curve of the distribution and the uniform (perfect) distribution line; the denominator is the area under the uniform distribution line.

**Graph Level Metric** – A metric defined for, and gives a value for, the network as a whole. The metric is calculated once for the network. Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness.

**GraphML** – GraphML is a comprehensive and easy-to-use file format for graphs. It consists of a language core to describe the structural properties of a graph and a flexible extension mechanism to add application-specific data.

**Group** – A collection of things (entities, nodes, ties, networks). A group might at times be represented as a meta-node. Nodes may be classified in to groups on the basis of a shared attribute, type, id-range, label, user selection, etc. For example, if you have a set of people and know their gender, then their might be two groups - men and women. In addition the nodes representing those people could be displayed as a meta-node for men and a meta-node for women. Nodes may be classified in to groups on the basis of a grouping algorithm. For example, if you have a network showing connections among members of an organization and you run a grouping algorithm it will return clusters of nodes that fit together on some mathematical criteria. This cluster is a group and can be represented as a meta-node.

**H**

**Hamming Distance** – Number minimum number of substitutions required to change one string into another string of equal length. (i.e. "toned" and "roses" is 3.)

**Heuristics** – Problem-solving by trial and error: a method of solving a problem for which no formula exists, based on informal methods or experience, and employing a form of trial and error iteration.

**Homophily** – (i.e., love of the same) is the tendency of individuals to associate and bond with similar others.

- Status homophily means that individuals with similar social status characteristics are more likely to associate with each other than by chance.
- Value homophily refers to a tendency to associate with others who think in similar ways, regardless of differences in status.

**HTML** – HyperText MakeUp Language.

**I**

**In-Degree** – The sum of the connections leading to an entity from other entities. Sometimes refered to row degree.

**Influence network** – A network of hypotheses regarding task performance, event happening and related efforts.

**Isolate** – any entity which has no connections to any other entity

L
**Latent Semantic Analysis** – Latent semantic analysis (LSA) is a technique in natural language processing, in particular in vectorial semantics, of analyzing relationships between a set of documents and the terms they contain by producing a set of concepts related to the documents and terms.

**Lattice Network** – A graph in which the edges are placed at the integer coordinate points of the n-dimensional Euclidean space and each entity connects to entities which are exactly one unit away from it.

**Link** – The representation of the tie, connection, relation, edge between two nodes.

**Link Analysis** – A scientific area focused on the study of patterns emerging from dyadic observations. The relationships are typically a form of co-presence between two entities. Also multiple dyads that may or may not form a network.

**Link Class** – A set of Links of one type. A set of links of one type can be represented as a meta-link.

**M**

**Main Diagonal** – in a square matrix this is the conjunction of the rows and cells for the same entity.

**Math Terms**

These mathematical terms and symbols are used: Let S be any set:

- \( \text{card}(S) = |S| \) = the cardinality of S (the cardinality of the entity-sets is represented as \(|A|, |K|, |R|, |T|\))
- \( \mathbb{R} \) denotes a real number
- \( \mathbb{Z} \) denotes an integer

**Matrix Algebra** – The part of algebra that deals with the theory of matrices.

**Measure** – A measure is a function that maps one or more networks to \( \mathbb{R}^n \). Measures are often scalar (n=1) or vector valued with \( n=|V| \) or \( n=|U| \).

**Meta-Link** – The representation of a Group of Links.

**Meta-Network** – See Meta-Network

**Meta-Network** – The representation of a Group of Networks.

**Meta-Node** – A representation of a Group of nodes.

**Monte Carlo** – A random optimization of your organization

**MRQAP** - This describes a report in ORA. See Reports for more information. For multivariate cases, if your dependent variable is continous or count data (like in a negative binomial case), you should use MRQAP. If your dependent variable is binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent to using a linear probability model). You do need to interpret your results accordingly.

**Multi-Agent System** – A loosely coupled network of problem-solver entities that work together to find answers to problems that are beyond the individual capabilities or knowledge of each entity.

**Multi-entity** – More than one type of entity (people, events, locations, etc.).

**Multi-plex** – Network where the links are from two or more relation classes.

**Multimode Network** – Where the entities are in two or more entity classes.
N

Neighbors – Entities that share an immediate edge to the entity selected.

Network – The representation of a set of nodes (including meta-nodes) of one type and the links (including meta-links) of one type between them.

A network N is a triple consisting of two sets of entities, called U and V, and a set of edges E∈UxV. Thus, we write N=(U,V,E). An element e = (i,j) in E indicates a relationship or tie between entities i∈U and j∈V. A network where U=V and therefore E⊂VxV is called unimodal*; otherwise the network is bimodal*. We write G=(V,E) for unimodal* networks. For our purposes, unimodal networks will not contain self loops, which means that (i,i)∉E for i∈V.

Network Class – A set of Networks on one type. This can also be represented as a Meta-Network.

Network data format – usually comes in the form of NodeSet 1 listed vertically in column A starting in row 2 and NodeSet 2 listed horizontally in row 1 starting with column B. All the intersecting cells are the links between each of the nodes.

Newman Grouping – Finds unusually dense clusters, even in large networks.

Node – A representation of a real-world entity (a who, what, where, how, why item.

Node Class – A set of nodes of one type. Note a set of nodes of one type can be represented as a meta-node.

Normalized Sum – Otherwise known as the Average.

Notation:
The following matrix notation is used throughout the document for an arbitrary matrix X:

- X(i,j) = the entry in the i\textsuperscript{th} row and j\textsuperscript{th} column of X
- X(i,:) = i\textsuperscript{th} row vector of X
- X(:,j) = j\textsuperscript{th} column vector of X
- sum(X) = sum of the elements in X (also, X can be a row or column vector of a matrix)
- dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff X(i,j) > 0
- X' = the transpose of X
- ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0
- X@X = element-wise multiplication of two matrices (e.g. Z=X@Y => Z(i,j) = X(i,j)*Y(i,j))

O

ODBC – (O)pen (D)ata (B)ase (C)onnectivity is an access method developed by the SQL Access group in 1992 whose goal was to make it possible to access any data from any application, regardless of which database management system (DBMS) is handling the data.

Ontology – "The Specifics of a Concept". The group of entities, resources, knowledge, and tasks that exist in the same domain and are connected to one another. It's a simplified way of viewing the information.

Organization – A collection of networks.
Out-Degree – The sum of the connections leading out from an entity to other entities. This is a measure of how influential the entity may be. Sometimes referred to as column degree.

Pajek – A visual tool for analyzing large networks (networks having thousands of vertices).
Path – A set of nodes and links that form a single unbroken chain, such that no node or link is repeated. i.e. A > B > C > D > E
Pendant – Any entity which is only connected by one edge. They appear to dangle off the main group.
Percolation Theory – The behavior of connected clusters in a random network.
Pythia – Program used to create Influence Nets. Pythia is a timed influence net application. This tool can downloaded at the following URL: http://sysarch.gmu.edu/main/software/.
QAP Correlation – Calculates measures of nominal, ordinal, and interval association between the relations in two matrices, and uses quadratic assignment procedures to develop standard errors to test for the significance of association. QAP is designed as a bivariate test (only two variables). Generally, QAP is perfectly fine for almost any bivariate network problem.
Random Graph – One tries to prove the existence of graphs with certain properties by assigning random edges to various entities. The existence of a property on a random graph can be translated to the existence of the property on almost all graphs using the famous Szemerédi regularity lemma*.
Reciprocity – The percentage of entities in a graph that are bi-directional.
Redundancy – Number of entities that access to the same resources, are assigned the same task, or know the same knowledge. Redundancy occurs only when more than one agent fits the condition.
Relation – The way in which entities in one class relate to entities in another class.
Robustness – Two different definitions:

- Networks – Concerned with the reliability (Kim & MÄ©lard, 2004) and continued functioning of a network following an intervention. The robustness of a network is particularly relevant in communication-type and flow-oriented networks. The purpose for understanding robustness of a network has more of a management of the network connotation.
- Measures – This meaning has more of a statistical connotation. Studying the robustness of a measure of a network can also be referred to as conducting a sensitivity analysis on the measure. In keeping with the terminology of the most-recently published research in this area, in lieu of using the term sensitivity, we too will use the robustness term, although the terms can be used interchangeably. A measure is robust if a slight perturbation in its input produces a slight change in its output.
Row Degree – see In Degree*.

S

Scale-Free Network – Some entities act as highly connected hubs (high degree), although most entities are of low degree. Scale-free networks' structure and dynamics are independent of the system's size N, the number of entities the system has. A network that is scale-free will have the same properties no matter what the number of its entities is.

Self-Loop – An entity with a connection to itself.

Simmelian Ties – Two entities are Simmelian Tied to one another if they are reciprocally and strongly tied to each other and strongly tied to at least one third party in common.

Simulated Annealing – A method of finding optimal values numerically. It's a search method as opposed to a gradient based algorithm. It chooses a new point, and (for optimization) all uphill points are accepted while some downhill points are accepted depending on a probabilistic criteria.

The term Simulated Annealing draws its inspiration from metallurgy, where atoms within a metal are heated thereby dislodging them from a metal's internal structure transforming the metal into another atomic state. In this way, your organization is heated changing its components in the attempt to arrive at an optimized state.

Slow Measures – As the name implies these measures generally take longer to run.

Small-World Network – Small-World Networks will have sub-networks that are characterized by the presence of connections between almost any two entities within them.

Social Network Analysis – The term Social Network Analysis (or SNA) is used to refer to the analysis of any network such that all the entities are of one type (e.g., all people, or all roles, or all organizations), or at most two types (e.g., people and the groups they belong to).

Sphere of Influence – One entity's direct relationship with one of it's neighbors as a function of specified path length.

Standard Deviation – The square root of the variance where variance is the average of the squared differences between data points.

.stl file format – This file format is native to the stereolithography CAD software created by 3D Systems. STL files describe only the surface geometry of a three dimensional object without any representation of color, texture or other common CAD model attributes and can use both ASCII and binary representations

Szemerédi’s Regularity Lemma – A fundamental structural result in extremal graph theory due to Szemerédi (1978). The regularity lemma essentially says that every graph can be well-approximated by the union of a constant number of random-like bipartite graphs, called regular pairs.

T

Table data format – Table data usually contains a column with referencing IDs and headers denoting column names.

Tie – see Link

Topology – The study of the arrangement or mapping of the elements (links, nodes, etc.) of a network, especially the physical (real) and logical (virtual) interconnections between nodes.
**Total Degree Centrality** – The normalized sum of an entity's row and column degrees.

**Trail** – A set of nodes and links that form a single unbroken chain that can revisit nodes but not links. i.e. $A > B > C > A > D$

**Transpose** – In linear algebra, the transpose of a matrix $A$ is another matrix $A^T$ (also written $A^\text{tr}$, $A^\dagger$, or $A'$) created by any one of the following equivalent actions:

- write the rows of $A$ as the columns of $A^T$
- write the columns of $A$ as the rows of $A^T$
- reflect $A$ by its main diagonal (which starts from the top left) to obtain $A^T$

See The Transpose Wikipedia Entry for formulas, examples and more information.

**Unimodal networks** – These are also called square networks because their adjacency matrix* is square; the diagonal is zero diagonal because there are no self-loops*.

**Walk** – A set of nodes and links that form a single unbroken chain that can revisit both nodes and links. i.e. $A > B > C > B > D$. 